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Preface

Welcome to the Oracle Insurance Insbridge Enterprise Rating RateManager User Guide for the Tools
Menu. This guide describes the features and functionality of the Oracle Insurance Insbridge Enterprise
Rating RateManager (RateManager) Tools Menu. RateManager is a component within the Oracle
Insurance Insbridge Enterprise Rating (Insbridge) System that enables users to manage the product
definition and modification process, including rating and underwriting logic.

The Tools Menu is where the majority of RateManager administrator functions are performed. References
to the RateManager User Guide, which covers the Modules Menu, will be made periodically.

AUDIENCE

This guide is intended for RateManager system administrators who are tasked with managing system
features. Users should be familiar with their company’s practices and terminology. Advanced users may
benefit from having knowledge of their company’s current working rate manual.

RELATED DOCUMENTS

For more information, refer to the following Oracle resources:
e The Oracle Insurance Insbridge Enterprise Rating Framework Administrator User Guide.
e The Oracle Insurance Insbridge Enterprise Rating SoftRater Server User Guide.

e You can view these and other Insbridge guides on-line at this address:

http://www.oracle.com/technetwork/documentation/insurance-097481.html

CONVENTIONS

The following text conventions are used in this document:

Convention  Description

bold Boldface type indicates graphical user interface elements associated with an
action.
ltalic Italic type indicates book titles, emphasis, or placeholder variables for which you

supply particular values.

Monospace type indicates commands within a paragraph, URLs, code in

Monospace
P examples, text that appears on the screen, or text that you enter.



http://www.oracle.com/technetwork/documentation/insurance-097481.html
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NAVIGATING RATEMANAGER

Navigate through Oracle Insurance Insbridge Enterprise Rating RateManager (RateManager) using the
RateManager top and side menus as well as right click menus, which will be pointed out as they occur.
Browser tool bars may not be displayed, may not navigate correctly, or may try to close your
RateManager instance.

If you have to visit another web site, open another window. It is a good practice to save your work before
you visit another web site or leave your desk.

NOTE: Insbridge requires Microsoft Internet Explorer 11. Other browsers are not compatible at this time.

BASIC SAFETY PRECAUTIONS

It is recommended that you secure your computer when you step away. This prevents any unintentional
deletions or entries and protects the integrity of your work.

INACTIVITY/TIMEOUT

RateManager, a web-based application, logs you out without saving your work if you are inactive for a
length of time. Your system administrator establishes the specified time. The default setting is 5 hours. If
timeout does occur, log back onto the system and continue to work.

SYSTEM REQUIREMENTS

For minimum operating system and hardware requirements, please see the Hardware Software
requirements guide.

Guide History

New editions incorporate any updates issued since the previous edition.

Edition PusliEsien Prod.uct Publication Date Comment
Number Version
~1% Edition P01-775-01 R 4.0 May 2010 New Release Update

2" Edition  P01-775-02 R 4.0.1 August 2010 Updated Release

3" Edition P01-775-03 R 4.1 December 2010 Update Release

4" Editon  P01-775-04 R 4.5 May 2011 Update Release

5" Edition ~ P01-775-05 R 4.5.1 September 2011  Update Release

6" Edition  P01-775-06 R 4.6 May 2012 Update Release

7" Edition ~ P01-775-07 R 4.6.1 November 2012  Update Release

8" Editon = P01-775-08 R 4.7 September 2013  Update Release
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9" Edition P01-775-09 R4.7.1 November 2013 Update Release
10" Edition  P01-775-10 R 4.8 July 2014 Update Release
11" Edition  P01-775-11 R 4.9 December 2014 Update Release
12" Edition  P01-775-12 R 5.0 August 2015 Update Release
13" Editon P01-775-13 R5.1 December 2015  Update Release
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Chapter 1
SYSTEM OVERVIEW

Prior to accessing RateManager, you should have received:

o RateManager URL — RateManager can be accessed by going to http://<yourserver>/RM,
where <yourserver> is the name of the server where RateManager is installed.

e Username — usernames are required.

e Password — passwords are required.

e Subscriber — subscriber information may not be required.

A subscriber may be a single company, a group within the company, or a single person. If more than one
subscriber has been set up by the system administrator, you will have to select the subscriber where you
want to work. If only a one subscriber has been setup, you will not have to select a subscriber.

If you do not know any of this information, please contact your system administrator.

ORACLE" newance sbiidps Ralellanage

T et

If multiple subscribers have been setup, you must A single subscriber has username and password
select the subscriber where you want to work. fields. Subscriber information is not required.

Figure 1 Login Screen

Logging In

Access to RateManager is gained through a login screen. To login, enter your username and password
and click LOGIN. Depending on your company setup, you may need to select your subscriber. If a
company subscriber is required, a menu will be displayed. Select the subscriber you need, and continue
to log in.

A successful login places you on your Home Tab.

A failed login displays an error message. Please correct any errors and try again. If you cannot log in,
please contact your system administrator.

12



Chapter 1 — System Overview

Help Logging In

If you have forgotten your password, username or need assistance with logging into the system, please
contact your system administrator.

Rights
RateManager uses rights to allow users access to various areas. The type of rights you have determines

what you can view, edit, add or delete. There are three types of rights:

e No Access —you cannot enter this area. The fields are grayed out or not displayed.

e Read Only — you can view the information but you cannot make any changes. Save, edit or other
features may be listed on the toolbars or right click menus, but you will not be able to effect any
changes.

e Full Access — you can view, edit, add or delete information where applicable.

The system administrator sets group rights. If there is an area you cannot access or edit, and you think
you need access, please contact your System Administrator.

Logging Out

The Logout option logs you out and closes RateManager.

OIRACLE" Insurance Insbridge RateManager
File Modules  Tools Help

Feload
%m Logaouk

Figure 2 Logging Out

To log out, click File=>Logout. If you have any elements open that show a change, you will be asked if
you want to save. After saving your work, you will be logged out.

13



Chapter 1 — System Overview

RATEMANAGER TABS AND MENUS

RateManager allows for multiple tabs to be utlized. The tabbed authoring interface allows for multiple
activities to be open across separate tabs without losing any functionality. Each tab functions
independently. You can view the Program Explorer, then edit a program version, and then create a new
algorithm without being forced to close the prior tab.

The RateManager tabs follows a familiar model, a fixed top bar menu with four options. Each option
contains a menu of system features. Each feature opens either a new tab or a popup window.

ORACLE Insurance Insbridge RateManager

File Modules  Tools Help
Reload

%; Logout

07

The File menu:

e Reload - reloads the page. Use this option when you want to refresh the screen.

e Logout —logs you out of the system.

ORACLE" Insurance Insbridge RateManager

File  Modules  Tools Help

HunJ Program Explorer
@ Testing
a7 Impact Analysis L7
lﬁ} Releases
gl Library

The Module menu:

e Program Explorer — the program explorer serves as a central location for creating and managing
programs and accessing program elements.

e Testing — the testing module is where you can test your rating program during development
without loading packages.

e Impact Analysis — the area for batching and data analysis.

e Releases — allows groups of rating packages to be automatically deployed and loaded to IBFA
through a release. If you do not have release rights, this option is not displayed. Please see the
RateManager Modules User Guide Volume 2 for more information.

14



Chapter 1 — System Overview

e Library —the library is a central repository within RateManager where export programs, template
programs, public XML files, custom XML, Oracle Insurance Product Configuration files, and table
data export files are stored and managed.

ORACLE" Insurance Insbridge RateManager

File  Modules Tools Help

Change Password

Home Cgﬂ >etup g
E@l  Manage Products B
a1 Audit E
IE. Security k
[ Databaze 3
&

Preferences

The Tools menu:

e Setup — expands for access to the Naming Standards option, System Level Constants, Message
Templates, Reporting Data Model information, and Table Job Management.

e Manage Products — administrators can manage products (lines of business). This is an
advanced system feature and may not be available to all users.

e Audit — contains the audit logs of system users. This is an advanced system feature and may not
be available to all users.

e Security — is where users, user groups and sessions are managed. This is an advanced system
feature and may not be available to all users.

e Database — this area is for administrators to create backups and deploy updates. This is an
advanced system feature and may not be available to all users.

e Change Password — allows users to change their password.

e Preferences — brings up the window where you can select the snaps you want to display on your
Home Tab. For advanced system users, system setup information is displayed.

This guide focuses on the features and functionality in the Tools menu.

15



Chapter 1 — System Overview

OIRACLE’ Insurance Insbridge RateManager

File Modules  Tools Help

Home

-@ RatefManager Help

RateManager Yersion

The Help Menu

e RateManager Help — clicking this option brings up online help.

e RateManager Version — clicking this option brings up system information.

Tab Navigation

Multiple tabs can be open at any time. You can move from tab to tab by clicking the tab you want. You
also can click the tab display icon = in the upper right hand of the screen to see a list of all the open

tabs. You can

ORACLE Insurance Insbridge RateManager

File  Modules  Tools

navigate to any tab in the list by selecting it.

Help

ne [ Program Explorer 1| M AA Auto 1-Ve~ x [ R 81 Base Rate [11

4§ Program Sequendng ..

Version: 05.01.00 Subscriber: alamere User: Company Administrator

[ Auto > alamere > FLA > FLA_Auto_1 - Version 1

Home

{3 New - | 35 Sequendng

@ Output Mapping E Create Package E TestProgram | |, | Notes Gﬁ Refresh

& Program Explorer

Program Detail Folders
@ Globals
Field variables
F Table variables
@g_ Calculated Variables
(@ Result variables
[fell alanrithme

Search:

[T FLA_Auto 1 -Version (1) Auto/alamere/FLA/FLA_Auto_1 - Version (1)

: 1) Search Current Folder + | Wy Only Activated Revisions ~ Cate[F7) BI_Base_Rate [1] :: Auto > FLA_Auto_1 > Version 1

Folder Detail

LE Program Sequencing :: Auto » FLA_Auto_1 > Version 1

5 o
A El Name Revision Element Type  Data Type  Catedo(d) OutputMapping :: Auto > FLA_Auto_1 > Version 1
2 .
@ [E3l B1_Base_Rate 1 Table (4) Integer vehicle et e i = PR AT S Y ]
[E2 BI_Limit_Factor 1 Table (1) Decimal vehicle

L L= a2

NOTE: If you have a popup window open, you have to close the popup before you can click on another

tab.

[® The close tab icon closes the tab you are currently on. If you have any elements open that show a
change, you will be asked if you want to save.

Keyboard Shortcuts

In a few areas, you cannot use your mouse right click features to cut and paste however, you can use
your keyboard controls. Highlight the text you wish to cut or copy. Use the Control Key plus the letter key

to either “C” copy or “X” cut. Position your cursor where you want your text to be placed. Use the Control
Key plus the letter key “V” to paste.

e Control + X cuts text.

Control + C copies text.
Control + V pastes text.
To go to the beginning of an entry, use the home key on your keyboard.
To go to the end of an entry, use the end key on your keyboard.
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Home Tab

Once you have logged in, you are on the Home Tab. The Home tab has a control panel that contains
links to all the major components of the Module menu and the Setup options from the Tools menu and a
help link. The Home tab is always the first tab and cannot be closed.

r
‘2 Oracle Insurance Insbridge RateManager 05.01 (10.100.10) - Internet Explorer

ORACLE" Insurance Insbridge RateManager
File  Modules  Todls  Help
Home [
[2) Control Panel
-
Program Testing Impact
Explorer Analysis
Lo |
N =
Releases Haming System
Standards Level
Constants
Message Table Job Library
Templates Management
Help

Figure 3 Home Tab

Access to the pages you are authorized to view or work on is gained by selecting the area you want from
Tools in the menu bar.

For more on the Home Tab, please see RateManager Modules User Guide available on the OTN
http://www.oracle.com/technetwork/documentation/insurance-097481.html.
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Chapter 2

SETUP

Setup contains options that can be used throughout RateManager. Options are:

Naming Standards — The Naming Standards feature is where you can define a naming standard
that can be applied throughout the system, or to a specific product, or to specific elements.

System Level Constants — The System Level Constants feature allows for user defined
constants that are available system wide to be managed.

Message Templates — The Message Templates feature is where elements for user defined
messages are managed.

Reporting Data Model — The Reports feature allows for access to the IBRM data in a relational
data structure and format that can be used for reporting.

Table Job — The Table Job opens the management screen for the table job exports created in
Program Explorer. Table job exports allow you to select one or more table variables and create a
job that exports the variables in to a Microsoft Excel workbook.

Permissions Required

Every user can view the content in Naming Standards, System Level Constants, Message Templates and
Reporting Data Model.

To create, edit, or delete Naming Standards, System Level Constants, and Message Templates
you must have any Domain Admin permission. Domain Admin permissions include Product
Management and Project Management. If you do not have either of these permissions, you will
not be able to create, edit or delete in Naming Standards, System Level Constants, and Message
Templates.

Domain Admin permissions are also required to update reporting views in Reporting Data Model.
To view, create, edit, delete or start table export jobs, you must have Table Job Admin

permissions. Users without permissions can run a single table export but cannot create or
manage table export jobs. All users can view and download exported tables from the Library tab.

ok, S :

:zﬁ‘-’ Setup » |F Maming Standards i
'ﬂ Change Password : £  System Level Constants
| Preferences LE] Message Templates

Reporting Data Model

&
| Table Job

Figure 4 Tools >Setup Menu Options
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NAMING STANDARDS

Naming standards allows you to enforce a uniform naming structure to system elements and programs.
The naming structure can be the same across all elements or it can be varied across one or more
elements. Naming standards allow for prefixes or suffixes to be attached and for case enforcement to be
applied to any newly created element or any existing elements that are being edited.

- a : ﬁ1
N Maming Standards
[ New | 22 Edt | B3 Copy | 3€ Detete | ) Refresh | (5 Where Used | 53 Find ...
Name Description Scope Type | Enforce Date Last Modifed
System Default Default Rate Manager Naming selections System Prefix  Disabled  Jun 30 2015, 09:24 PM
Records: - Total Records:
@ Prev.25 || & Mext25 @ Close |

Figure 5 Naming Standards for Users with Permissions

Naming Standards Functions

Nen New: New starts the process of creating a new naming standard. See Creating a
New Naming Standard for more information.

b Edit Edit: Opens the Edit Naming Standard screen for the currently selected naming

- standard.

=2 Copy Copy: Copies the selected naming standard.

3 Delete Delete: Removes the selected naming standard from the list.

i) Refresh Refresh: Refreshes the list of naming standard.
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Ll Where Used

Where Used: Shows a Where Used report indicating where the selected naming
standard is used.

—_'i Find ...

Find: Searches all naming standards for the value entered in the search field and
returns with a list of matching results.

Naming Standard Fields

Naming standards are listed in alphabetical order with the total number naming standards displayed on
the bottom of the screen.

o Name — A user created identifier assigned to each naming standard. Each name must be unique.
Names cannot be edited.

o Description — A user defined description of the naming standard.

e Scope — Lists whether the naming standard is system or custom.

- System — A system naming standard is the default naming standard. The default naming
standard uses a prefix type that cannot be edited or deleted. Only the enforce option can be

changed.

- Custom — Custom naming standards are user created with all fields open for editing.
Custom naming standards can be deleted if they are not being used.

e Type — The type of naming standard; suffix, prefix or case. Naming standards can be one type.

- Suffix — A 1-5 digit tag attached to the end of the element.

- Prefix — A 1-5 digit tag attached to the front of the element.

- Case — A validation that the element name follows a specific case pattern.

o Enforce — Indicates if the naming standard is enabled or disabled.

o Date Last Modified — The date the last modification was made to the naming standard.

Manage Naming Standards Functionality

The Naming Standards screen allows you to:

e Create a New Naming Standard

o Edit a Naming Standard

e Copy a Naming Standard

e Search for a Naming Standard

e View Where a Naming Standard is Used
e Delete a Naming Standard
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Creating a New Naming Standard

Naming Standards can be accessed either from Tools-> Settings->Naming Standards or from the Naming
Standards icon on the Home page. Naming Standards can be created at any time. The upper part of the
New Naming Standard screen holds the descriptors for the entire Naming Standard.

Naming Standard Descriptors

Name — A user created identifier assigned to each naming standard. Names can be up to 25 alpha
numeric characters and allowed special characters. Names must be unique. Names cannot be edited
once the Naming Standard has been saved. If you have made a mistake with the name, you must create
a new naming standard. The incorrect naming standard can be deleted if it is not in use.

Description — A user defined description of the naming standard. Descriptions can be up to 75 alpha
numeric characters and allowed special characters. Descriptions can be edited at any time.

NOTE: Please see the RateManager User Guide Volume 1 for a listing of disallowed special characters.

Type — The type of naming standard; suffix, prefix or case. Naming standards can be one type but can be
edited at any time. There are three types of naming standards:

o Suffix — A 1-5 digit tag attached to the end of the element. For example, ElementName_END
e Prefix — A 1-5 digit tag attached to the front of the element. For example, AND_ElementName.

o Case — A validation that the element name follows a specific case pattern. Case is set per
element within the naming standard definition.

Enforce — Indicates if the naming standard is to be strictly enforced when new elements are created or
when existing elements are edited. Enforcement can be enabled or disabled at any time by editing the
Naming Standard and changing the enforce option. There are two options for enforce:

e Enabled — A naming standard that is enabled means that the element name is validated against
the type and defined details for the naming standard prior to being saved. If the naming standard
is met, the entry is saved. If the entry does not follow the naming standard, then an error
message is displayed.

o Disabled — A disabled naming standard means that the naming standard is not validated. The
suggested naming standard is presented when creating new elements but if the entry does not
follow the naming standard, it will be accepted.

NOTE: Element naming restrictions will still be observed. For example, even if the naming standard is
met, if an element contains a restricted character, an error message will be displayed. For more
on naming restrictions, please see Restrictions in the RateManager User Guide.

Date Last Modified — The date the naming standard was last modified. This is an information only field.
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Naming Standard Definitions

The lower portion of the New Naming Standards screen contains the naming standard definition details.
There are three columns of information.

Name — The name of the element where the naming standard is to be applied. This is an information only
field.

Enter (Type) — This field holds the values to be used by either the suffix or the prefix. For Case types, no
entry is needed.

o Suffix — A 1-5 digit tag attached to the end of the element. Entries can be alpha numeric
characters and allowed special characters. For example, ElementName_END

o Prefix — A 1-5 digit tag attached to the front of the element. Entries can be alpha numeric
characters and allowed special characters. For example, AND_ElementName.

o Blank — If a field is left blank, no validation is done for suffix or prefix types. Validation is done for
case types.

The Enter (Type) field can be edited at any time. Validation for new or edited elements is against the
current value in the field. For example, you created element TABLE_ABC using a haming standard that
had a suffix value of ABC. Then you updated the naming standard to have a required suffix value of XYZ.
If you edit the element you created with the naming standard of ABC, when you go to save, you will have
to update the suffix to XYZ in order to save.

You can enter values for one or more fields. If you only want a prefix attached to Program names only,
you can create a naming standard where only the program Name prefix is validated. You can pick and
choose the elements where you want a haming standard to apply.

Case: A validation that the element name follows a specific case pattern. Case is set per element within
the naming standard definition. There are four case settings:

- All Upper — Only upper case letters are allowed.

- All Lower — Only lower case letters are allowed.

- Camel — Only camel case letters are allowed. For example, ElementName or tableVariable.
- No Check — Case is not validated. Any case can be used.

You can enter case validation against any suffix or prefix. If Case is the type, you can select the elements
where you want case to be validated.

You can create multiple Naming Standards and apply a different Naming Standard in each product or use
the same Naming Standard system wide for the entire domain type.
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Creating a Naming Standard

a MNew Maming Standard -- Webpage Dialog

Name: |
Description: |
Type: |Case only [ |
Enforce: |Enabled [ |

Date Last Modified: ==

Name A Case

Table Variable | | |ND Chack il
Calculated Variable | | |ND Check ll
Algarithm | | [ Check L]
Rule | | 1o Check v |
Global Table Varizble | | 1o Check |
Global Algorithm | | [Ma Check L]
Global Calculated Variable | | 1o Check |
Global Rule | | 1o Check |
Linkad Table Varizble | | [No Check | v
Global Linked Table Variable | | 1o Check |
Program Mame | | [ Check L]
Program Version Mame | | |ND Cheack il
Folder | | 1o Check |
Category | | [Ma Check L]
Field Varizble | | 1o Check |
Result Variable | | 1o Check |
Qutput Group | | |ND Chack il
Rating Workshest | | 1o Check |
Constant | | [ Check L]
Message Template | | |ND Cheack il
Global Filter Rule | | 1o Check |
Filter Rule | | [Ma Check L]
% Save ) Close

Figure 6 New Naming Standard

1. From the Naming Standards screen, click New to open the New Naming Standards screen.

2. Enter the Name. The Name cannot be edited after saving. Make sure the name is what you want.
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3. Enter a Description.

4. Select the Type.

5. Select the Enforce option.

6. Enter the details.

7. Click Save to save your entry.

8. Reload the system to apply the updated settings.

Edit a Naming Standard

Naming Standards can be edited at any time. Only the Name field cannot be edited. All other fields are
open for editing. Validation happens against the current Naming Standard.

1. From the Naming Standards screen, select the Naming Standard you want to edit and click Edit
to open the Edit Naming Standards screen.

2. Make your updates.
3. Click Save to save your entry.

4. Reload the system to apply the updated settings.

Copy a Naming Standard

Any Naming Standard can be copied. The copy is an exact copy of the selected Naming Standard,
including enforcement.

B =

Copy Naming Standard

Old Hame: |5‘r"5t5m Defzult |

Mew Name: |CC‘P‘|-" of System Default |

Copy | @ Close

M

Figure 7 Copying Naming Standard
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From the Naming Standards screen, select the Naming Standard you want to copy and click
Copy to open the Copy Naming Standards screen.

Enter in a New Name.

Click Copy. The copied Naming Standard is listed on the Naming Standards screen. The copy
can be edited or applied. If the copy is not displayed, click Refresh to refresh the screen.

Search for a Naming Standard

The search option searches the name field. You can search for the exact name or for the beginning
characters of a Naming Standard. Results returned contain the entire search criteria. For example, if you
search for ABC, all names that start with ABC are returned along with the Naming Standard called ABC.
Searches are not case sensitive.

-

2| Search by Name [ﬁj

Search for: | |

a®  OK 3 cancel |

L

Figure 8 Searching for a Naming Standard

4.

5.

From the Naming Standards screen, click Find to open the Search by Name screen.
Enter the name or first few characters of the Naming Standard you want to search for.
Click Ok.

Results are displayed in the Naming Standards screen.

To clear search results, click Refresh. This returns the Naming Screen.

Double click to view or edit search results. If you open a Naming Standard and click Close, you are
returned to the search results. If you open a Naming Standard and click Save, you are returned to the
Naming Standards screen. The search results are removed.
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View Where a Naming Standard is Used

View Where used is helpful when you want to see where a Naming Standard is applied.

Where Used Report for [suffix_true_All Upper] X '

. Level Name ID :
L |

LOB suffo_true_All Upper 107

o Ok

Figure 9 Where User Report for Naming Standards

1. From the Naming Standards screen, select the Naming Standard that you want to see where it is
being used.

2. Click Where Used. Results are displayed in a Where Used Report.

3. Click Ok to close.

Delete a Naming Standard

Naming standards that are not in use can be deleted. If a Naming Standard is being used, you must clear
it from being used. Make sure this is the action you want to take. This action cannot be undone.

Confirm Delete %] '

!
® Naming Standard [test_special] Usage:

|
Mot being used.

Are you sure you want to delete [test_spedial]?

o Yes @ No

Figure 10 Deleting a Naming Standard

1. From the Naming Standards screen, select the Naming Standard you want to delete and click
Delete.

2. A confirmation screen is displayed. Click Yes to delete the Naming Standard. Click No to return to
the previous screen.

3. Deleting removes the Naming Standard immediately.
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NAMING STANDARDS HIERARCHY

Naming standards can be applied system wide at the domain type level or at the product level. Naming
standards applied at the product level take priority over the system level naming standard.

Domain Type =2 & RatzManager
Domail_'us =5 Property ! I
Projeds S5 ameresnce | NAMIng Standards at Domain Type
Products 2 @ Auto
Folders =17 Curren H
Brograms " 2] reram 2 lNammg Standards at Products Level
Product Level Elements 3 Globals
Project Level Elements & -[l.niversals ______________ v

Figure 11 Naming Standard Hierarchy

o If a product has a naming standard assigned to it, that naming standard is used even if there is a
system level naming standard.

e If a product does not have a naming standard assigned, then the system level naming standard is
used.

e There is a system default naming standard that cannot be edited or deleted. The system default
Enforce option is disabled by default.

e The default setting is for no naming standard to be used.

o Naming standards cannot be applied to PC domain type content.

Naming Standards Rights

Any Domain Admin permission is required to create, edit, or delete a naming standard. Domain Admin
permissions also allow you to assign a haming standard at the products level. To set naming standards at
the system level, you must have administrator permissions. Permissions are set at the group level. If you
do not have permission, please contact your system administrator.

Updates to naming standards are logged as audit items if auditing has been enabled for the user group.
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Applying Naming Standards System Wide

To apply system wide naming standards, you must have administrator permissions. If you do not have the
Administrator option on the Preferences screen, you do not have permissions to apply naming standards
system wide. This applies to every program and program element in the system.

To make a naming standard required it must be enabled. If a naming standard is disabled, the pattern will
be presented but it will not be mandatory to follow. Prior to assigning, make sure the naming standard you
want to use is in the status you need. Naming standards that are to be applied system wide must be
selected and saved in the Preferences screen. Naming standards cannot be applied to PC domain types,
even if set at the Preferences level.

If you do not select a naming standard, the system default one is used. The default naming standard field
must have an entry.

To clear the field of the current value, click Clear.

r a 5
Preferences
- Settings Work Files Share Folder Location: | |

— U_ser DB Backup Share Folder Location: |C:"\]nsbridge‘.,Backup ® | ~

“~Home Fage Use Insbridge Com+ Admin: m

= --.i‘«sclministramr Enforce Release Packaging: [F=l~]

ZyelEL Batch Package Threads:
= Nigrate Workfiles|
Minimum Login User 1D Length: El
User must change password: (Days)
Show Owverride Date Mask: m
Aliow Data Type Change: m
Inactive Sessicn Time Cut: El (hrs)
Batch Results with MNewiline: I@
Cmnline Help Server: |cha|tht |
My Recent List:
Default Proscy Script Location: |hﬂp:,-',-"-r.'pad,-'wpad.da‘t |
Change Control: ID‘H:_i[
Maximum number of opened tabs: |].5 |
Debug Report Format: [Summary Report| v |
s—
Default Maming Standard: |S\,fstem default | | Select ... | | Clsarl
g;ﬂr:Worssei r Test Case I@
< > =
g Save | @ Close |
h

Figure 12 Naming Standards in Preferences

1. Open the system settings in Tools—> Preferences—>Administrator-> System.

2. Locate Default Naming Standard and click Select. The Naming Standards screen is displayed.
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(& ' =)
N Maming Standards
i [ New | Fz» Edit | 52 Copy | 3€ Delete | @) Refresh | (5 Where Used | 53 Find ...
MName Description Scope Type | Enforce Date Last Modifed
System Default Default Rate Manager Naming selections Systern Prefix  Disabled  Jun 30 2015, 09:24 PM
Records: - Total Records:
& Prev.25 | %  MHext25 | #) Close |

Figure 13 Selecting a Naming Standard at the System Level

3. Select the naming standard you want applied to every program and every element in the system
and click Select. The Naming Standards window closes, returning you to Preferences.

4. Click Save to save your entry in Preferences.

5. Reload the system to apply the updated Preferences.
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Applying Naming Standards to a Product

To apply naming standards to a product, you must have Product Management permissions. If you do not
have the Manage Products option on the Tools menu, you do not have permissions to apply naming
standards to a product. This applies to every place the product is located. For example, if you have a
product called “Auto” and you have this product under more than one project, the naming standard is
applied to every Auto product in every project.

To make a naming standard required it must be enabled. If a naming standard is disabled, the pattern will
be presented but it will not be mandatory to follow. Prior to assigning, make sure the naming standard you
want to use is in the status you need. Naming standards must be selected and saved at the product level.

The default is for no naming standard to be applied to a product. If you do not want a naming standard at
the product level, click clear to clear the field. When the field is clear, no naming standard is applied to the
product.

1. Open the Manage Products screen in Tools.

2. Select the product where you want to apply a naming standard and click Edit. You can also apply
naming standards to a new product.

F |
£ Edit Product Info -~ Webpage Dialog [—
Mame: |J""'J--|'t‘=3l x |
Abbreviation: |F'.-5. |
{two alpha characters)
English {United States) -
Locale:
Date Mask: Y -MM-DD -
Decimal Symbol: .
Digit Grouping Symbol: || -
Product Status: Activated
Maming Standard: | | Select ... | Clear
a4  Save | €) Close |
e

Figure 14 Editing a Product to Add a Naming Standard

3. Locate Naming Standard and click Select. The Naming Standards screen is displayed.
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8 ' =)
N Maming Standards
i [ New | Fz» Edit | 52 Copy | 3€ Delete | @) Refresh | (5 Where Used | 53 Find ...
MName Description Scope Type | Enforce Date Last Modifed
System Default Default Rate Manager Naming selections Systern Prefix  Disabled  Jun 30 2015, 09:24 PM
Records: - Total Records:
& Prev.25 | %  MHext25 | #) Close |

Figure 15 Selecting a Naming Standard at eh Product Level

4. Choose the naming standard you want applied to the product and click Select. You will be
returned to the Edit Product screen.

5. Click Save to save your entry. If you are done editing, close the Manage Products screen.

6. Reload the system to apply the updated settings.

Viewing Naming Standards

If you do not have permissions to create, edit or delete a naming standard, you can view the details. The
options on the screen are limited to refresh, where used and find.
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Naming Standards in Use

When creating a new variable, folder, program or program version, if a naming standard is assigned, a
suggested name populates in the name textbox.

Mew Field Variable 2|

Select the working catagory:
=@
S Policy
Data Type: =
|
XML ID: |
e Save | 3 Close |

Figure 16 Example of Naming Standard

If the naming standard is set to enabled, the system validates the entry. The variable must use the
required naming standard in order to be saved. If it fails, an error message is displayed indicating what
the error is. The error must be corrected before the entry can be saved.

If the naming standard is disabled, no system validation takes place.

Copying or Creating New Revisions or Versions

When copying a program or an element and naming standards are enabled, then the naming standard is
applied to the copied name. If the name does not pass validation, an error message is displayed. The
elements inside the program are not impacted unless edited. When copying a program or an element and
naming standards are disabled, no validation takes place.

If Naming Standard is enabled when editing an existing element, the current naming standard is applied.

Naming Standards are not validated when importing Public XML files.
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SYSTEM LEVEL CONSTANTS

System Level Constants is where pre-defined constants can be viewed and user-defined constants can
be created and managed. There are two types of system level constants:

e Pre-defined — Pre-defined constants are fixed values and system values that are found in every
project. This type of constant is built in to the Insbridge system. Pre-defined constants are locked
and cannot be edited, or deleted. There are two types of pre-defined constants.

- Fixed — These constants have a fixed value. 0, 1, 2, 3, 4,5, 6, 7, 8, 9, 10, 100, 1000,
10000, Y, YES, N, NO, and NULL. The value of these constants cannot be changed. If
you want a different value, you can use a Custom Value, create a field with that value or
create a user-defined constant with that value.

- System Value — A constant value that comes from the system. System values can also
be used as table variable criteria. There are five system values:

Current Category Instance # — This is the instance that the category is currently
on. For example, you may have an auto program where you can enter multiple
vehicles. Each vehicle would have its own instance in the vehicle category. If you
limit personal auto to 9 vehicles, you may want to set a rule or trigger another
action if the vehicle instance is 10.

Current System Date and Time — Current server time and date at the time of
execution.

Current System Date — Current server date at the time of execution.

Current Program Version — The current program version being used at the time
of execution.

Current Rating Environment — The current rating environment being used at
the time of execution.

o User defined: User-defined constants are values that are created by users and consist of
multiple types:

- System Level — These are found in every project and are created in the System Level
Constants area. These are available to every program in the system.

- Project Level — These are found in the project where they were created and can be
viewed in the universals tab of the project. These are available only to programs in this
project and listed under Domain Constants.

- Product Level — These are found in the product where they were created and can be
viewed in the globals tab of the product. These are available only to programs in this
product and listed under Domain Constants.

NOTE: User-defined constants are managed in multiple places, at the system level, or at the
Modules—>Program Explorer->Project->Universals level or at the Modules—>Program
Explorer->Project->Product->Globals level. When working on constants, make sure you are in
the correct location.
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Constant Listing

Constants can be used in table variables, calculated variables, algorithms and drivers assignments.

In the Available Variables, Functions and Constants list, system level constants are listed with pre-defined
constants first, followed by user-defined constants and custom values last. Domain constants, Project
level and Product level, are in a separate list.

Navigating to System Level Constants

There are two ways to access System Level Constants.

e System Level Constants can be accessed by clicking the System Level Constants icon on the

Home tab.

e Tools>Setup—>System Level Constants. This opens the System Level Constants window.

-

5

£ System Level Constants

i [ New | [ Edit | 3€ Delete | ) Refresh | (53 Where Used | 5 Find ... | s Pre-defined ~

|'E| MName Value Data Type Date Last Modifed
0 a Integer
1 1 Integer
2 2 Integer
3 3 Integer
4 4 Integer
5 5 Integer
[ & Integer
7 7 Integer
8 g Integer
9 g Integer
10 10 Integer
100 100 Integer
1000 1000 Integer
10000 10000 Integer
PI 3.141593 Decimal
¥ ¥ String
YES YES String
N N String
NO NO String
NULL String
Current Category Instance # Current Category Instance # Integer
Current System Date and Time Current System Date and Time Date
Current System Date Current System Date Date
Current Program Wersion Current Program Version Decimal
Current Rating Environment Current Rating Environment String

Records: 1-25

Total Records: 25

& Prev.25| Y Next25|

h

& Close |

Figure 17 System Level Constants
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SYSTEM-LEVEL CONSTANTS FUNCTIONALITY

Functions can be accessed from the menu bar located at the top of the screen. The functions you can
perform depend on the type of constant. There are icons that can tell you at a glance what the status of
the constants is.

Icon | What it Indicates

a | Locked Constants. A lock icon indicates that this constant is system generated. System
generated constants are not open for copying, editing, or deleting.

System Level Constants Functions

New: New starts the process of creating a new user-defined constant. See
Mew Creating a New User Defined Constant for more information. Pre-defined
constants cannot be created.

B3 Edt Edit: Opens the Edit User Defined Constant screen for the currently selected user
S defined constant. Pre-defined constants cannot be edited.
x = Delete: Removes the selected user-defined constant from the list. Pre-defined
constants cannot be deleted.
i) Refresh Refresh: Refreshes the list of pre-defined or user-defined constants.
Where Used: Shows a Where Used report indicating where the selected user-
3 Where Used defined constant is used. Pre-defined constants cannot produce a Where Used
p
report.

Find: Searches the Name field in the currently displayed constants for the value
54, Find entered in the search field and returns with a list of matching re_sults. For example,
: a search in User-defined Constants does not return any matching values from the
Pre-defined constants list.

‘s Userdefined =

Pre-defined Pre-defined/User-defined: Selector for User-defined or Pre-defined constants.
The option selected here determines the content displayed.

«  User-defined

System Level Constants Fields

Constants are listed in alphabetical order with the total number of constants displayed on the bottom of
the screen. The total reflects only the constants on the selected list; pre-defined constants are not
included in user-defined constants totals.

o Name — The name of the constant. A user-defined constant allows for a unique identifier to be
assigned to constant. Names cannot be edited on pre-defined constants.

35



Chapter 2 — Setup

e Value — The value used by the constant. Values cannot be edited on pre-defined constants.
o Data Type — Lists the data type of the constant. Data types of constants cannot be edited.
- Integer
- String
- Date
- Decimal

o Date Last Modified — The date the last modification was made to the constant.

System Level Constants Right Click Menu

There are no System Level Constants right click menus.

System Level Constants Functionality

The System Level Constants screen allows you to:

e Create a New User-defined Constant

e Edit a User-defined Constant

e Search for a Constant

e View Where a User-defined Constant is Used
e Delete a User-defined Constant

Creating a New User-defined System Level Constant

User-defined system level constants can be created at any time.

User-defined Constant Descriptors

Name — A user created identifier assigned to the user-defined system level constant. Names can be up to
40 alpha numeric characters and allowed special characters. Names must be unique.

Data Type — Data types cannot be edited once the user-defined system level constant has been saved. If
you have made a mistake with the data type, you must create a new user-define system level constant.
The incorrect user-define system level constant can be deleted if it is not in use.

Value — A user created value for the user-defined system level constant. The value must be compatible
with the data type.
1. From the menu bar, click New to open the New System-level Constants screen. The selection

does not matter. Only User-defined constants can be created.

2. Enter in a Name. Names can be up to 40 alpha numeric characters and allowed special
characters. If a naming standard is in place, a naming pattern is displayed in the name field. If the
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naming standard is mandatory, an error message is presented if your entry does not follow the
pattern. Correct your entry and try again. Names must be unique.

a Mew Constant -- Webpage Dialog ﬁ

Mame: |Expirstion Date |
Data Type: |5tring v
Walue: |Expiraﬂcun Date ><|

w® Save | (%] Clc-sel

Figure 18 New System-level Constant

3. Select a Data Type from the menu. Data type cannot be edited once saved.
4. Enter the Value. The value you can enter depends on the data type.
- Integers — Values can be up to 21 numeric digits.
- String — Values can be up to 50 alpha numeric characters and allowed special characters.
- Decimal — Values can be up to 50 numeric digits with a single decimal point.
- Date — Values can be up to 50 alpha numeric characters and allowed special characters.

5. Enter the details.

6. Click Save to save your entry.

Edit a System Level Constant

User-defined System Level Constants can be edited at any time. The name and value fields are open for
editing. Data type cannot be edited. If you have made a mistake with the data type, you will have to
create a new constant with the correct data type.

&' Edit Constant [Age_Limit] -- Webpag.. [

Name: lsge_Limit |
Data Type: | hd
Value: 21 |

2# Save | (%) Clusel

Figure 19 Editing a System Level Constant
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1. Onthe System Level Constant screen, select User-defined to view the user-defined System Level
Constants.

2. Select the System Level Constant that you want to edit.

3. Click Edit. Make any changes to the Name and Value. If the naming standard is mandatory, an
error message is presented if your entry does not follow the pattern. Correct your entry and try
again.

4. Click Save to save your entry.

NOTE: Please take care when editing or deleting user-defined constants. When values are updated, the

updates will affect every program where that constant is being used. The update happens at the
time of packaging. This action may cause unintended changes in other programs. To see where
the user-defined constant is being used, run a Where Used report.

Search for a System Level Constant

The find option searches the name field for both pre-defined and user-defined system level constants.

You can search for the exact name or for the beginning characters of a system level constant. Results
returned contain the entire search criteria. For example, if you search for ABC, all names that start with
ABC are returned along with the system level constant called ABC. Searches are not case sensitive.

-

2| Search by Name [ﬁJ

Ssarch for: | |

2® Ok &) cancel |

L

Figure 20 Searching for a System Level Constant

1.

From the System Level Constants screen, select the type of system level constant you want to
locate either pre-defined or user-defined.

Click Find to open the search screen.

Enter the name or first few characters of the system level constant you want to search for.
Click Ok.

Results are displayed in the System Level Constant screen.

To clear search results, select the type of system level constant you want to view. This returns all
entries to the screen.
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View Where a System Level Constant is Used

View Where used is helpful when you want to see where a System Level Constant is being used. Pre-
defined System Constants do not have Where Used reports.

1.

On the System Level Constant screen, select User-defined to view the user-defined System Level
Constants.

Select the System Level Constant that you want to see where it is being used.
Click Where Used. Results are displayed in a Where Used Report.

Click Close to close.

Delete a System Level Constant

User-defined system level constants that are not in use can be deleted. If a user-defined system level
constant is being used, you must clear it from being used. Make sure this is the action you want to take.
This action cannot be undone. Pre-defined System Constants cannot be deleted.

2 Confirm -- Webpage Dialog &J

@ This constant is not being used.

Are you sure you want to delete constant
[Age_Limit]?

2 Ok i Ccancel

L

Figure 21 Deleting a User-defined System Level Constant

1.

From the System Level Constants screen, select User-defined to view the user-defined System
Level Constants.

Select the System Level Constant you want to delete and click Delete.

A confirmation screen is displayed. Click Ok to delete the System Level Constant. Click Cancel to
return to the previous screen.

Deleting removes the System Level Constant immediately.
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System Level Constants Rights

Permissions are required to create, edit, or delete system level constants. Users with RateManager
Domain Access rights will have permissions to work on system level constants. Permissions are set at the
group level. If you do not have permission, please contact your system administrator.

Updates to system level constants are logged as audit items if auditing has been enabled for the user
group.

Viewing System Level Constants

If you do not have permissions to create, edit or delete system level constants, you can view the detalils.
The options on the screen are limited to refresh, where used and find.
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MESSAGE TEMPLATES

The Message Templates screen is where message templates can be created and managed. Message
templates are user created messages consisting of fixed values and system values that are defined at the
system level and available to all programs within the system.

Creating message templates at the system level allows for re-usable message definitions with optional
variable substitution that can be used in every program no matter the project or product, and creates a
uniform appearance and message content.

There are two types of message templates:

e Pre-defined — There is one pre-defined message template in RateManager. This is a blank
template that allows for user-created messages to be used. This template message is built in to
the Insbridge system and cannot be edited, or deleted.

e User defined — User-defined message templates are created by system users and are

prefabricated messages with variable placeholders that allow you to create standard messages
using variable information that is generated at the time of execution.

Message Template Structure

Message templates can be simple messages with one or more placeholder values. Or longer messages
with one or more placeholder values. The structure is determined by you.

For example

If you want to output a message “As of December 2017 Alamere no longer insures drivers over
the age of 100 with a coverage limit of $100,000.,” you can begin by typing it in.

Next, replace the items that may change. If one program will change in December but another will
change in January, delete the date and click Insert to put in a placeholder. If the company name
will change, delete the name and click Insert to put in a placeholder.

Continue until you have the template that you want with the placeholders that you need.

“As of [?], [?] no longer insures drivers over the age of [?] with a coverage limit of [?].”

This structure allows you to insert the date field you need, along with the company name, driver

age, and coverage limit that applies. You do not need to create multiple messages. You can
create one message that can be used against multiple programs.

Message Template Listing

Message Templates can be used in calculated variables, algorithms and drivers assignments.

In the Available Variables, Functions and Constants list, message templates are listed first followed by
system level constants, domain constants and variables last.
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Navigating to Message Templates

There are two ways to access Message templates.

o Message templates can be accessed by clicking the Message Templates icon on the Home tab.

e Tools>Setup—>Message Templates. This opens the Message Templates window.

-

£

=] Message Templates

i [ New | [ Edit | 3€ Delete | [} Refresh (5 Where Used | %3 Find by Name = Find by Code

Mame Code Date Last Modifed
End_of_Offer EOO_12.30 Jan 27 2015, 06:09 PM
BLANK MESSAGE TEMPLATE _SYs001 Nowv 19 2014, 09:35 AM

Records: 1-2 Total Records: 2

3 Prev.zsl & Nextl&l

@ Close |

b

Figure 22 Message templates
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MESSAGE TEMPLATES FUNCTIONALITY

New: New starts the process of creating a new user defined message template.

Mew See Creating a New Message Template for more information. Pre-defined
message templates cannot be created.
B Edt Edit: Opens the Edit Message Template screen for the currently selected
- message template. Pre-defined message template cannot be edited.
% Delete: Removes the selected message template from the list. Pre-defined
Delete
message template cannot be deleted.
i) Refresh Refresh: Refreshes the list of message templates.
5 Where Used Where U§ed: Shows a Where Used report indicating where the selected message
template is used.
Find by Name: Searches the Name field in the currently displayed message
3 Find by Name templates for the value entered in the search field and returns with a list of
matching results. Searches are case sensitive.
Find by Code: Searches the Code field in the currently displayed message
<3 Find by Code templates for the value entered in the search field and returns with a list of

matching results. Searches are case sensitive.

Message Templates Fields

Message templates are listed in date last modified order with the total number of message templates
displayed on the bottom of the screen. Paging options are available when the listing exceeds 25.

The listing can be sorted by Name or Code. Click the title that you want to sort on to view message
templates in that order.

o Name — A unique, user defined name for the message templates. Names cannot be duplicated
by any other message template or constant.

e Code — A user-defined value can be assigned as a code.

o Date Last Modified — The date the last modification was made to the message template.

Message Templates Right Click Menu

There are no Message templates right click menus.

Message Templates Functionality

The Message templates screen allows you to:

e Create a New Message Template
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o Edit a Message Template

e Search for a Message Template

o View Where a Message Template is Used
o Delete a Message Template

Creating a New Message Templates

Message templates can be created at any time. All fields are required.

Message Templates Descriptors

Name — A user created identifier assigned to the message template. Names can be up to 40 alpha
numeric characters and allowed special characters. Names must be unique in message templates and
message templates.

Code — A user created identifier assigned to the message template. Codes can be up to 40 alpha
numeric characters and allowed special characters. Codes must be unique in message templates.

Message Text — A user created message that allows for system variables to be inserted. Message text
can be 500 alpha numeric characters and allowed special characters.

r |
2 New Message Template -- Webpage Dialog &J
Name: |End_of offer | Date Last Modified: N/A
Code: [Eco_12.30 |
Insert Place cursor at location in message text to insert "[7]” as placeholder.
Message Text:

[?] iz no longer available.

2 Save I Close

L

Figure 23 New Message Templates
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10.

11.

From the menu bar, click New to open the New Message Templates screen.

Enter in a Name. Names can be up to 40 alpha numeric characters and allowed special
characters. If a naming standard is in place, a naming pattern is displayed in the name field. If the
naming standard is mandatory, an error message is presented if your entry does not follow the
pattern. Correct your entry and try again. Names must be unique to message templates and
constants.

Enter in a Code. Codes can be up to 40 alpha numeric characters and allowed special
characters.

Enter the Message Text. Type the message that you want to output. Where you want to insert
any system variables, click the Insert button. A [?] placeholder is inserted.

Click Save to save your entry. If you close without saving, your entry will not be saved and you
will not receive a warning message.

Edit a Message templates

Message templates can be edited at any time. All fields are open for editing.

L

F b |
a Message Template - [End_of_Offer] -- Webpage Dialog [iE-J
Name: [End_of_Offer | Date Last Modified: Jan 27 2015, 05:08 PM
Code: [Eoo_1z2.30 |
Insert Place cursor at location in message text to insert *[7]" as placeholder.
Message Text:
[?] i=2 no longer available due to expiration date [?].

2  Save | I Close

Figure 24 Editing a Message Template

5.

Select the Message templates that you want to edit.
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6. Click Edit. Make any needed changes. If the naming standard is mandatory, an error message is
presented if your entry does not follow the pattern. Correct your entry and try again.
7. Click Save to save your entry.
NOTE: Please take care when editing or deleting message templates. When values are updated, the

updates will affect every program where that message template is being used. The update
happens at the time of packaging. This action may cause unintended changes in other programs.
To see where the message template is being used, run a Where Used report.

Search for a Message Template

There are two find options. One searches the name field and the other searches the code field for both
pre-defined and user-defined message templates. You can search for the exact name or for the beginning
characters of a message template. Results returned contain the entire search criteria. For example, if you
search for ABC, all names that start with ABC are returned along with the message templates called ABC.
Searches are case sensitive.

-~

2| Search by Mame [iE-J

Search for: | |

2 Ok 3 Ccancel |

L.

Figure 25 Searching for a Message Template by Name

7.

10.

11.

Depending on the type of search you want to perform, click Find by Name or Find by Code to
open the search screen.

Enter the full name or code or just the first few characters for the message templates you want to
locate.

Click Ok.
Results are displayed in the Message Templates screen.

To clear search results, click Refresh to return all entries to the screen.

View Where a Message Template is Used

View Where used is helpful when you want to see where a message template is being used.

1.

Select the message template that you want to see where it is being used.
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2. Click Where Used. Results are displayed in a Where Used Report.

a View Where Used Report: Underwriting_Message_1 -- Webpage Dialcg Iﬁ

View Where Used Report: Underwriting_Message_1

Underwriting Message 1#

BEING USED IN ALGCRITHM
Program Mame: AUTO GLOBAL

Algorithm Name: Flag Driver 11
Algorithm Type: Flag Driver
Algorithm Revisionil

Instruction Mumber: 2

i Print | €) Close |

L.

Figure 26 Message Template Where Used Report

3. Click Close to close.

Delete a Message Template

Message templates that are not in use can be deleted. If a message template is being used, you must
clear it from being used. Make sure this is the action you want to take. This action cannot be undone. Pre-

defined message templates cannot be deleted.
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a Confirm -- Webpage Dialog Iﬁ

Are you sure you want to delete [End-0Of-
Offering]?

2 Ok ik Ccancel

L

Figure 27 Deleting a Message Template

5. From the Message Templates screen, select the message template you want to delete and click
Delete.

6. A confirmation screen is displayed. Click Ok to delete the message template. Click Cancel to
return to the previous screen.

7. Deleting removes the message template immediately.

Message Templates Rights

Permissions are required to create, edit, or delete message templates. Users with RateManager Domain
Access rights will have permissions to work on message templates. Permissions are set at the group
level. If you do not have permission, please contact your system administrator.

Updates to message templates are logged as audit items if auditing has been enabled for the user group.

Viewing Message Templates

If you do not have permissions to create, edit or delete message templates, you can view the details. The
options on the screen are limited to refresh, where used and find.

Message Templates in Use

Message templates are user created messages consisting of fixed values and system values that are
defined at the system level and available to all programs within the system.

Message templates can be used as a step in any calculated variable, algorithm or driver assignment.
Message templates are brought in with text and placeholders where users can assign a variable, function,
result or step or constant to be used at execution.

1. Select the calculated variable, algorithm or driver assignment where you want to use a message
template.
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2. Select Message Templates from the Available Variables, Functions, and Constants.
3. Available message templates are listed.
4. Select the message template you want.

5. The message template is listed as a step.

ORACLE’ Insurance Insbridge RateManager

File  Modules  Tools  Help

| Home " Program Explorer || [T Program 1 - Version (... | *ALG_23B[1] = ..

Auto > Program 1 > Version 3 > ALG_23B > Revision 1

E Save Mew Step ~ @ Delete Term l:_k Delete Step ﬁ Change Step Order Advanced Options
oy

Algorithm Mame: |-°-|-G_BB | Revisd e Templates

- m Leve nstants
Working Category (Loop On): IPOI'W B Damzin Constants

Step Variables
Steps Algorithm Details Policy Inputs

Policy Varizbles =
Gep1 | CurrestStep 3

Step 2 Step Type: Set Message using Template rv BO_PremiumlIndicator
Step 3

CO_Result_1
Hext Step: DOME
GL_BIPremium
System Message Result Varisble

[UC38sA] Underwiriting_Message 1 |

GL_FinalProedCOpsRate

GL_PDPremium

GL_TotalGLPremium

GL_TotalPODBIFremium

GL_UnderwritingFailMessage

HO_UWRuUl=Z

HO UWRuleZ2
Selact an ftem below to highlight, then double-click a —

variable on right to assign it to the placeholder. Result 1

Result 2
Result_3

2 2 2 & ¢ & & 2 3 3 2 & 32

<Mew Result Variable>

Figure 28 Message Templates

6. You must match up the placeholders [1] with available variables, function, results of step or
constants. Select the placeholder and then select the appropriate variables, functions, constants
or fields that you want to use.

7. Continue until all placeholders have a value assigned.

8. When you are finished, click Save to save your entry.
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REPORTING DATA MODEL

The IBRM database is the repository for content created in RateManager. Data is stored in a proprietary
format that cannot easily be extracted and evaluated by a reporting tool. A User Reporting Schema

(design time reporting) has been added that offers a reporting view into the IBRM database, making this
data available to any Microsoft SQL Server database reporting software.

The Reporting Data Model option presents a listing of element views that have been updated. Elements
include table variables, algorithms, calculated variables, and global version reports. The element views
are updated when the element is saved inside RateManager.

The purpose of this screen is to list the updates as they are happening. Tables and other elements are
updated when the element is saved inside RateManager. Once the update happens, it is listed here. The
Update Reporting Views button updates the algorithm step descriptions. This only needs to be run one
time. After it has been run, the updates continue. When the Update Reporting View has been run, the
action is logged as an audit item if auditing has been enabled for the user group.

This is an information only screen. Reports cannot be created from here.

(@ — ~internt Explorer_ v ) |

User Report View Setup

: @ Update Reporting Views G’} Refresh

Views Updated By

Action

Line Program

Program Ve Item

Item Ver Status

Views Updated On

Company Administrator
Company Administrator
Company Administrator
Company Administrator
Raj Patel

Raj Patel

Raj Patel

Raj Patel

Raj Patel

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Mary Elliott

Recomds: 1-25

Update Report Views
Update Table Views
Update Algorithm Views
Update Report Views
Table variable View U...

Table variable View D...

Table Variable View U...

Table variable View D...

Table Variable View U...
Table variable view U...

Table Variable View D...

Table variable View U...

Table Variable View D...

Algorithm View Updated
Algorithm Wiew Updated
Algerithm View Updated
Algorithm View Updated
Algorithm View Updated
Algorithm Wiew Updated
Algorithm View Updated
Algorithm View Updated
Algorithm View Updated
Algorithm Wiew Updated
Algerithm view Updated
Algorithm View Updated

Total Records: 572

CA_Auto_1
CA_Auto_1
CA_Auto_1
CA_Auto_1
CA_Auto_1
CA_Auto_1
CA_Auto_1
CA_Auto_1
CA_Auto_1

[T N B R R A i S SN S =

North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...
North Dakota Univers...

MMM R R R R PR R MR R

Drriver Variable Factor
Drriver Variable Factor
Driver Variable Factor
Driver Variable Factor
Driver Variable Factor
Criminal Count
Criminal Count

Total Criminal Counts L...
Total Criminal Counts L...
Rule 10 ALG

Rule 10 ALG

Rule 10 ALG

Rule 10 ALG

Rule 10

Rule 21

Rule 21

Rule 21

Age of Insured

Age of Insured

Age of Insured

Age of Insured

L R e il o S o T T o S S O S S S S

Completed
Success
Success
Started
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success
Success

Dec 09 2015, 11:07 ...
Dec 09 2015, 11:07 ...
Dec 09 2015, 11:06 ...
Dec 09 2015, 11:06 ...
MNov 25 2015, 03:23 ...
Nov 25 2015, 03:23 ...
Nov 25 2015, 03:23 ...
Nov 25 2015, 03:23 ...
MNov 25 2015, 03:22 ...
Nov 19 2015, 06:33 ...
Nov 10 2015, D6:33 ...
Nov 19 2015, 06:30 ...
Nov 19 2015, 06:30 ...
MNov 05 2015, 03:03 ...
Nov 05 2015, 03:03 ...
MNov 05 2015, 03:03 ...
MNov 05 2015, 03:02 ...
Nov 05 2015, 02:52 ...
Nov 05 2015, 0D2:50 ...
Nov 05 2015, 02:48 ...
Nov 05 2015, 02:47 ...
MNov 05 2015, 02:46 ...
Nov 05 2015, D2:46 ...

Nov 05 2015, 02:46 ... ||

MNov 05 2015, 02:43 ...

Ld Prev.25| > Ne:{EEl

Figure 29 Design Time Report Updates

There are two menu options:

| @ Close

@ |Update Reporing Views

Update Reporting Views: Reconciles the RateManager design time reporting
database.

E’[ﬂ Refresh

Refresh: Refreshes the list of report updates.
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Report Rights

Permissions are required to update RateManager design time reports. Users with Domain Access rights
will have permissions to update reports. Permissions are set at the group level. If you do not have
permission, please contact your system administrator.

Using Reporting Data Model

This feature allows for access to the IBRM data in a relational data structure and format that can be used
for reporting outside of RateManager. The data is available to any standard SQL Server Database
reporting software or third party reporting tool, such as Microsoft Excel.

As part of the Insbridge download, a Design Time Reporting folder has been included in the Insbridge
Documentation. In this folder are the Reporting doc zip file and the Insbridge Design Time Reporting
document.

The Reporting doc zip file contains detailed documentation that describes what data is available, the
relationships of all data elements, how the data should be accessed, and a sample report that can be
created using the available data.

The Insbridge Design Time Reporting doc contains basic setup requirements and an example setup.

Please contact your IT department for your reporting options.
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TABLE JOB MANAGEMENT

Table Job Management allows users to export table variables in to a Microsoft Excel workbook. With this
feature, users create jobs, select one or more table variables, and then submit the job for processing
where the variables are exported in to an Excel workbook.

Any user can select to run a single table variable export or add to an existing table variable export job.
Users with permissions can manage jobs on the Table job Management tab. Jobs can be edited to
include or exclude selected tables, add notes, or change the email notification. Jobs can be submitted for
processing at any time. When finished, an email is sent to the designated contact and the job status is
updated. Excel files are listed on the Library tab. Files on the Library tab can then be downloaded to the
users network or local hard drive. If multiple table variables are in the job, one workbook is returned for
each table. Each table is presented on a separate worksheet.

Requirements

Table export functionality requires that additional Insbridge features be in place. Table exports will fail if a
shared workfile location and other set up requirements are not done.

e Shared Workfiles Location
e A JMS Queue setup on the application server where IBSS resides
e AnIBSS Instance with:
- Same subscriber as RateManager
- Atleast one node
- The same RM environment as RateManager
- A controller environment
- Connector Properties, JMS Queue Setup and email notification
- Connector Properties must be started
e Group rights must be granted in RateManager and the Shared Workfiles location and IBSS
location must be entered in Preferences in RateManager.

NOTE: For release 5.1, JBoss cannot be used. We regret any inconvenience this may cause.

Set Up for Table Exports

Set up a shared Workfile location

Set up a JMS Queue in the application server where IBSS resides
Set up the IBSS instance requirements

Set up access rights in RateManager

Set up Preferences in RateManager

arMwNPE

Workfiles

A shared workfiles location is where table files are parked. This can be on the server where Insbridge is
installed or another server. The Insbridge server and the shared location must be on the same domain.
The location must be accessible to both RateManager and IBSS. The Insbridge user for each instance of
RateManager must be on the domain also. Administrators should be familiar with managing a Windows
server and working with Domains. Server permissions are required for:
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e Access to the server where Insbridge has been installed

e The Insbridge User Account. This is the user used to install Insbridge.

e Access to the server where Workfiles will be moved to
e Access to the server where IBSS has been installed

For more information on Setting Up Workfiles, please see Insbridge Workfiles Installation Guide.

Setting up JMS Queue in Application Server

The steps for setting up the necessary queues are in the Using Batch Rating Guide. You must have
access to the application server.

e WebSphere:
- Setup JMS Queue by creating:
= Bus and Members
= Destination
= Queue Connection Factory

e WebLogic -

- Setup JMS Queue by creating:
JMS Server
JMS Module
Subdeployments
Connection Factory
JMS Queue

You must have permissions to create a batch setup. For more on batch, please see Insbridge Batch.

Subscriber, Node and Environments in IBSS

The steps for adding subscribers, nodes and environments are in the IBSS User Guide. You must have
IBSS permissions. The IBSS set up requires:

e The same RateManager subscriber must be added to IBSS.

e A node must be created. The node can be any name.

e The same RateManager environment also needs to be added to IBSS. This allows for the table
export process to function. The RateManager environment must be identical to the RM

environment where rating is to be done.

e A controller environment must be created. No updates to the Oracle database are required. The
Oracle database does not have to be batch ready for table exports to work.

e Connector Properties including JMS Queue Setup and email notification must be entered and
started. Email must be configured to accept and send success and failure messages.
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In RateManager: Enable Access Rights

You must have admin permissions to perform these tasks.

To set up the group management for access rights, select the user group(s) where you want to add
permissions and allow permissions for RM table job admin.

If table job admin rights are not granted, users can save a job but cannot access the table data
management screen to edit, delete or start jobs.

8= Group Rights

5--& RateManager Tahle Job Admin - Access Denied
[‘f‘] [ ] Export Management

--ﬁ Ratelanager Domain Admin - Access Granted
--ﬁ RateManager Universals - Access Granted
--ﬁ RatelManager Testing - Access Granted

--ﬁ RateManager Package Admin - Access Granted
--ﬁ Database Support - Access Denied

--ﬁ RateManager Auto - Access Granted

--ﬁ RateManager Home - Access Granted

--ﬁ RateManager Life - Access Denied

--ﬁ RateManager BOF - Access Granted

--ﬁ RateManager Fire - Access Granted

--ﬁ RateManager Umbrella - Access Granted

--ﬁ RateManager Valuables - Access Denied

--ﬁ RateManager Farmowners - Access Denied

< >

3 Save @ Close

Figure 30 Allowing for Table Job Management Permissions

Table Management Permissions

You must have table management permissions to view and work on the Table Job Management screen.
If the Tools menu option (Tools—> Setup—>Table Job) or the Table Job Management icon on the Home tab
are not presented, then you do not have table management rights.

Users without table management rights can save or run a table job from the edit table tab, or the right
click menu of any table variable listing on products where they have permissions. Exported tables can be
accessed by any user on the Library tab.
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In RateManager: Setup Preferences

The IBSS instance must be entered in the Table Management Messaging. The port must be included.

The shared Workfiles location must also be entered. The same user with the same password created in
the workfile server must be used. Share the workfile with the user and also give full control.

Reload RateManager after updating Preferences.

el e X
| L] Preferences
Settings
s
= User S Setti
i s ystem Settings
Administrator
Inshridge Configuration File Path: [C:\PROGRAM FILES|ORACLE|INSERIDGE\FRAMEWORK!A. 5.0\ Inshi
Impact Analysis Messagi
Migrate Workfiles oo FUESEIN e[V [locihost | (senure Channel) [
SoftRater Sarver : [ MET v [localhost | (Securs Channal) []
Table Management Messagi
Server (VA Only): - [YOURSERVER:70G1 | (Secure channel) [

WorkFiles Share Folder Location: ||\YOURSERVER) Insbridge!Workfiles |
DB Backup Share Folder

|C:'I,Inﬁ|:|rndge",Badmp |

Location:
Use Insbridge Com+ Admin: ITrue W
Enforce Release Packaging: False| w |

Batch Package Threads:
Minimum Login User ID Length:
User must change password: (Days)

Showe Cvermide Cate Mash: True |«

Allow Data Typa Change: m

Inactive Secsion Time Out: [55 ](ws)

Batch Rasults with NewLine: I@

Online Help Server: [locathost | W

—

o Save | & Close ‘

Figure 31 Entering Table Job Values in Preferences
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TABLE JOB MANAGEMENT TAB

Table Job Management is where table variable export jobs are run and managed. If a job has been
saved, the job can be started, edited or deleted on the table job management tab. You can get to this tab
either from the Tools menu—>Setup—>Table Job or by clicking the Table Job Management icon on the

Home tab. Managing table jobs requires permissions.

,

ORACLE’ Insurance Insbridge RateManager

Fle  Modules Tools  Help
[ Fame | % TableJobMana.. x = @

‘ | %) Table Batch Management
|ﬁ New | [ Edit Job Options & Start | 3§ Delete | ) Refresh | [Z7 Edit Content | View: E,AU M
5]

Name Type System Create Date Last Update Date Last Run Date Tables  Status -
Auto 01-07-2016 10:44:17 System Export Yes Jan 07 2016, 10:44 AM Jan 07 2016, 10:44 AM 1 Submitted

Auto 01-07-2016 11:57:29 System Export Yes Jan 07 2016, 11:57 AM Jan 07 2016, 11:57 AM Jan 07 2016, 12:00 AM 1 Success

Auto 01-07-2016 15:05:17 System Export Yes Jan 07 2016, 03:05 PM Jan 07 2016, 03:05 PM Jan 07 2016, 12:00 AM 1 Success

Auto 11-20-2015 16:13:41 System Export Yes Nowv 20 2015, 04:13 PM Nov 20 2015, 04:13 PM 1 Failed

Export TV GL 2016 Export No Jan 07 2016, 05:18 PM Jan 07 2016, 05:45 PM 1: Saved

Job_2 Export No Jan 07 2016, 11:56 AM Jan 07 2016, 06:20 PM Jan 07 2016, 12:00 AM 4 Success

Rate Analysis 1-2016 Export No Jan 07 2016, 01:47 PM Jan 07 2016, 05:12 PM 2 Saved

Table Expart LV 1-7 Export No Jan 07 2016, 01:11 PM Jan 07 2016, 01:38 PM 2 Saved
Table_Analysis 1 Export No Jan 07 2016, 01:40 PM Jan 07 2016, 01:46 PM 2 Saved -

Number Of Jobs: 3

Figure 32 Table Job Management

Functions

ﬁ Mew

New: Used to create a new table export job. See Creating a Table Export Job for
more information.

£+ Edit Job Options

Edit Job Options: Used to edit table job description, notes and email notification.

o Start

Start: Starts the table export process.

x Delete

Delete: Removes the selected table export job.

E’[ﬂ Refresh

Refresh: Refreshes the listing of table export jobs.

[5# Edit Content

Edit Content: Opens the Edit Job Options screen for the currently selected table
export job.
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View: .-EaUser ' :

|
]

View: Updates the table export jobs listing to display by the selected option:

£ Upd‘: User o User — displays all user created jobs.

—— System e System — displays all system created jobs.
all e All—displays all jobs.

Fields

The Table Export Listing area displays the table export jobs that have been created. The fields are:

Name: The name of the table export job.

Type: The type of table export. There are two types:

System Export — This is a table export that has been run outside of a job. If you select
the “Run Now” option on the table variable, the export happens immediately and is not
part of a user created job. System Exports cannot be started or re-run from Table Job
Management. You must return to the table variable to run the export again. System
Exports can be deleted.

Export — This is a table export run inside of a user created job. If you select the “Save” or
“Save & Run Now” option, you must select the job where you want to save the export.
The job is listed on the Table Job Management tab. Exports can be started, re-run, edited
or deleted.

System: A Yes in this column indicates that this is a system export job. A No indicates that the
job is user created.

Create Date: Time stamp of when the job was created.

Last Update Date: Time stamp of the last time the job was updated. Updates are any changes to

the job.

Last Run Date: Time stamp of when the job was run.

Tables: The number of tables in the job. Click refresh to update the screen if you think the
number of jobs may have changed.

Status: The status of the job. The statuses are:

Saved — The job has been created and is available to any user. This job may or may not
have table exports assigned to it.

Submitted — The job has been submitted for processing. If a job stays in submitted
status for a long period of time, the job may have failed. If you have permissions to IBSS,
you can check the error logs to verify.

Executing — The job is being executed.

Success — The job has been processed successfully. Any exports should be available on
the Library tab.
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Partial Fail — A portion of the job failed for a reason. Click the Failed status to view the
reason. Failed user created jobs can be re-run.

Failed — The job failed for a reason. Click the Failed status to view the reason. Failed

user created jobs can be re-run.

Navigation

The table job export listing can be sorted by columns. Click the column where you want to sort the listing.
There are no right click menus available.

File Location on IBSS

If you have permissions to IBSS, you can view error logs and message process files to get more
information about a table job export.

e To view message process files, select Nodes—> Services. Make sure the Insbridge Connector
Service is started. Under Message Process, select Batch Export Data and the status you need.

DRACLE. Insurance Insbridge SoftRater Server - WebLogic

Insbridge Connector Service | Start | | Stop | Properties

B CJ 1855
3 Config The Insbridge Connector Service is a Database Queue and JMS Listener that will route all batched messages to & java class (process) for
B C3 Nodes execution. Please note, these processes may take resources and time to execute. Consult with your system admin before configuring the
number of jobs and listeners per VM,
1 SoftRater
34 SoftData
@ DBRuntime Batch Export Data R Compieted View Messages | | Edit Process Configuration | Purge.
¢om s
Say Softlibraries Un/Select all e
% LocaLHosT [écvoopT oeo e d - COMPLETED
U_J) Help D #EXPORT REQUEST - 2016-01-11 23:47:29.101 (214) - COMPLETED

[] #exporT REQUEST - 2016-01-11 23:29:51.436 (213) - COMPLETED
[] #exporT REQUEST - 2016-01-11 23:27:19.639 (212) - COMPLETED
[[] #exporT REQUEST - 2016-01-11 23:24:08.454 (211) - COMPLETED
[] #exporT REQUEST - 2016-01-11 23:21:36.279 (210) - COMPLETED
] #exporT REQUEST - 2016-01-11 23:20:07.098 (209) - COMPLETED
] #exporT REQUEST - 2016-01-11 23:18:06.649 (208) - COMPLETED
[] #exporT REQUEST - 2016-01-11 23:16:01.585 (207) - COMPLETED
[] #exporT REQUEST - 2016-01-11 22:13:17.058 (205) - COMPLETED
[] #exporT REQUEST - 2016-01-11 22:11:14.602 (204) - COMPLETED
] # exporT REQUEST - 2016-01-06 03:17:06.15% (202) - COMPLETED
[] #exporT REQUEST - 2016-01-05 10:16:23.817 (201) - COMPLETED
[[] #exporT REQUEST - 2015-12-04 00:29:36.528 (158) - COMPLETED

Insbridge Task Manager | Froperties

The Insbridge Task Manager gives you the ability to execute tasks daily, weskly, hourly, or by the minute.
LOCALHOST | | View Tasks | (This process may take a while to exscuts)
Task Process Time:

Figure 33 IBSS Message Process Files
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e Toview error logs, select the node where you want to view logs and select Logs—>Error. On the
IBSS Error Events page, select to view Batch Export for Log File type. This information may be
helpful if a table job fails.

ORACLE. Insurance Insbridge SoftRater Server - WebLogic

= 3 1855
3 Config
= [ Modes
[ Services
A SoftRater
[ softData
) DBRuntime
iﬁ,‘; Softlibraries
E % LocALHOST
A Reset Environments
[ Cache
[ Services
=l 3 logs
Error

3 Audit

@) Help

Figure 34 IBSS Error Logs

IBS5 Error Events

This will provide you with a listing of event logs that reside in the IBSS log files. Please select the log file and the age to view the
listing of events.

Log File:

Batch Export

Showing 1 to 50 of 774 log entries

L INF 2016-01-12 23:36:35,880

ie Motification Mail- Received jobName 1111

\%) INFO 2016-01-12 23:36:38,830
ie Mofification Mail- Received tableCount - '1"

\i') INFO 2016-01-12 23:36:38,879
ie Motification Mail- Inside Loop Count -1

\i‘) INFO 2016-01-12 23:36:35,863
ie Mofification Mail- inside loop jobMame 1111

i InFo 2018.01-12 23:36:35,793
| ie Notification Mail- subscriber 77

i} INFO 2016-01-12 23:36:35,792

ie Notification Mail- Environment :RM

\i'_,l INFO 2016-01-12 23:36:38, 781
ie Notification Mail- Job Id 43AAT17673

:l,) INFO 2016-01-12 23:36:35, 786

GEMNERAL

GEMERAL

GEMERAL

GEMERAL

GENERAL

GEMERAL

GEMERAL

GEMNERAL

APPLICATION

| <<Prevs0 | | Next50>>

F-

»)

»)

»)

»)

ieError while processing import export Emor, access denied: W10.00 110.00\Program Files\Oracle\insbridge\Webs\RM4

| Workfiles\TableManagementFiles

o ERROR 2016-01-12 23:36:38,785

ieExport Emor :Error, access denied: Wi10.00.110.00\Program Filesh
z i Fil o

WWinrkfiles\Tshlekdananaman

GEMERAL

»)

Oraclg\insbridgetWebs\RM4

n- Errar arcese danied- WO 00 140 (VWP raaram
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Creating a Job

Jobs are containers that can hold one or more tables for export. Prior to any users saving a table for
export, a job must be created on the Table Job Management screen. Jobs created on the Table Job
Management tab are user created and can be edited, deleted, or re-run.

If no user created jobs are available, users can only run a table export immediately from the table
variable. Table export jobs run from the table variable are system export jobs. System exports jobs
cannot be re-run.

To Create a Job

1. Click the New button in the top bar menu to open the New Job screen.

- |
¢ | Table Management Jobs -- Webpage Dialn;l ﬁ
New Job
Hame: Export TV Job 1

escrapiinge Exporting table variables for CA auto

Export on Nov 19

Admin Email: |zdmin@esamplz.com| b 4

| @ Save | ) Close |

Figure 35 Creating a New Table Job

2. Enter the name, description, any notes, and an email address so that you can get an emalil
notification when the job is done. Only the name is a required field. Names cannot be edited. All
other fields are open for editing.

3. Click Save. The job is empty and ready for use.
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Edit Job Options

Job options Description, Notes and Admin Email can be edited at any time. The name of the job cannot

be edited. If you have made a mistake with the name, you must delete and create a new job. Job options

can be edited on any job.

2| Table Manager:r__tenf__' Jobs -- Webpage Dialo ﬁ
Edit Job Options
Hame: ExparE TV EL301E

S GL tables for controller,

Notes: Anahysis on GL content for 2016, Need to validate PremCps
and ProdCps values to current,

Admin Email: |melictt@example.com x

2@ Save @ Close

Figure 36 Edit Table Export Job Options

To Edit Table Export Job Options

1. Select the job where you want to edit the job options.
2. Click the Edit Job Options button in the top bar menu. A separate screen opens.

3. Make your changes and click Save.
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EDIT CONTENT

User created jobs can be edited to include, exclude, or delete a table. If you choose to not include a table,
you can select to include the table at a later time and re-submit the job. System Export jobs cannot have
any content edited. You cannot edit jobs in running status.

To Edit Content

1. Select the job where you want to edit content.

2. Either click Edit Content in the top bar menu or double click the job to open the Edit Content
screen.

ORACLE’ Insurance Insbridge RateManager -

Fle  Modules Tools  Help

Home & Table Job Management 1 Edit Job - Export.. X

Edit Content - Export TV Job 3

7] Indude | ®| Exdude x Delete EE] Refresh _‘

@ Mame Revision Included Domain Project Product

[ Criminal Count 1 Yes Alamere Perzonal Auto

Rate Tier Local 1 Mo Alamere Perzaonal Auto

Term Discount 1 Mo Alamere Personal Errors and Omissicns
Il Total Criminal Counts Local 1 Yes Alamere Perzonal Auto

Figure 37 Include or Excluding Tables from a Job

3. If the job has never been run, then all table variables are included. If you want to exclude a table
variable, select the table variables that you want to exclude and click Exclude. If you want to
include a table, select the table variable that you want to include and click Include.

4. If you want to delete a table variable, select the table variable you want to remove and click
Delete. Click Refresh after you delete to see the updated list.

5. Click OK to verify your selections.

6. Close the tab to return to the Table Job Management screen.

Starting a Job

1. Select the job you want to run.

2. Click Start on the Table Job Management screen to start the job.
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ORACLE’ Insurance Insbridge RateManager

File  Modules  Tools  Help

Version: 05.01.00 Subscriber: alamere User: Mary Elliott

‘ Home | |®) Table Job Mana... X

| (% Table Batch Management
¢ % New | [2 Edit Job options | 4 start | 3 pelete | ) Refresh | [ Edit Content | View: 3 User ~
Name Type System Create Date Last Update Date Last Run Date Tables Status -
Export TV L Export No Dec 08 2015, 12:24 BM Dec 08 2015, 01:05 PM s Success
Expart TV 2 Export No Dec 08 2015, 12:24 BM Dsc 08 2015, 01:06 PM s Success
Export TV 3 Export No Dec 08 2015, 12:24 BM Dec 08 2015, 01:06 PM & Success
Expart TV 4 Export No Dec 08 2015, 12:24 BM Dsc 08 2015, 01:06 PM 7 Executing
Export TV 5 Export No Dec 08 2015, 12:25 BW Dec 08 2015, 01:07 PM 4 Success
Expart TV & Export Ho Dec 05 2015, 04:14 BM Dec 14 2015, 06:22 PM 3 Failed
Export TV 7 Export No Dec 14 2015, 08:32 BW Dec 14 2015, 10:12 PM 1 Saved -
Number Of Jobs: 7

Figure 38 Table Job Status

3. The job is submitted for processing. Refresh the screen to update the status. When the status
changes to Success, the job has been successfully run. Excel files are returned to the Library tab.

4. If an email address has been included, an email is sent for completed jobs. Run now does not get
email.

o

L)
| Message | Adobe POF

GG KNG D | G By ¥ (3 B B

2 Related -
Reply Reply Forward  Delete Mowets Create Other  Blark bt Categore Follow Mark st
1o AS Foloert Fue Aions= | Sender m Up* Unresd | Seledt =
Reipand Ao bunl b Emd Spticns . Findd Berhive
Fram: Mary (matt Sent: Th 17/2016 1550 PM
To: Mary Elott
e
Subject: Otacle Insurance - InBridge SoftRates Senver Q055 - Lxport Request

ORACLE i

Your expon job complaed successiully.

+ Jab Name: Job_2
 Status: Complsied

Total 2 tables exponed successfully

Hardware and Software ORACLE
Enginevred to Work Together INSURANCE
Coprt e, 2015, O Comeaton M. Coniin | s v Tt | s Snma

Figure 39 Table Job Success Email
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Failed Job Messages

When there is a failed job, there is a hyperlink for you to check on why it is failed and will give you a pop
up on why it is failed. For example, if the IBSS instance has not been started, you will receive a failed
message.

= | Status Detail -- Webpage Dialog >

Unzble to submit import table management job to IESS:

3 Close
Figure 40 Failed Job Message

If an email is not received by the designated person, check that email delivery has been setup in RM.

Deleting a Job

Any job can be deleted if it is no longer needed. Files are deleted from the Library listing if the job is
deleted from Table Job Management. Jobs that failed, are in a status other than Success, or are no
longer needed can be deleted to keep the Library listing current.

Make sure this is the action you want to take. Deleted files cannot be restored. You must run the table
export again.

To Delete a Job

1. Select the job you want to delete.
2. Click the Delete button in the top bar menu.
3. Confirm this is the action you want to take.

4. The file is removed immediately. If there’s a corresponding file on the Library Table Export listing
screen, that file is also removed from the listing.
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EXPORTING A TABLE

There are three locations where a table variable can be exported:

e The edit tab of any selected table variable has an Export Data option in the top bar menu that
contains a drop down where you can select to export data to a tab delimited text or to an MS
Excel workbook. This option is open to all users with product permissions and allows to you
export the exact revision you need.

e The program details tab of any selected program version can display the global or local table
variables for the program. All table variables have a right click menu with the Table Management
option. From there, you can select to export data either to a tab delimited text or to an MS Excel
workbook. This option is open to all users with product permissions.

e The universal tab of any project can display the table variables for the project. All table variables
have a right click menu with the Table Management option. From there, you can select to export
data either to a tab delimited text or to an MS Excel workbook. This option is open to all users
with Universal permissions. If you do not have universal permissions, you may receive an error.

r o
/2 Oracle Insurance Insbridge RateManager 05.01 {10.100.10) - Internet Explorer o= e
ORACLE" Insurance Insbridge RateManager
Fle  Modules  Tools  Help
[Fome T & Program Explorer [ mcaAuo_i-Veson. || [ RateTierGlobal . % =@
‘ | Auto > CA_Auto_1 > Version 1 (Jan-Feb) > Rate Tier Global > Revision 1
([ save | 3 pelete | %) ImportData |3 ExportData " EP Editpata | 5 New Linked var | [3} Advanced Options
Tab Delimited Text
Description Revi
Rate Fee Global 1 MS Excel Workbook [t ro= Gobal |
Rate Tier Global 1
Typa: Decimal v
Defatt: [ro J
Werking Categary (Locp Onk: [ Paicy [~] Browse G
Fitter Policy Whare: ¢ Select Fiter Rule 38 Clear
Available Variables Variable Selection Criteria
Policy Fiaids I Criteria Op | Type | Mask |Wildcard| Interpolate
fv Accident Forgiveness Discount - 1] Local Gode |- B | O o
fv Aggregate
fv AM_Option_Type_1
fv BI Class Factor
fv BI Limit
fv BI Limit Ceiling
fv BI Limit Floor
fv Bundle Discount Code
fv Class_Code
fv Combined Single Limit
fv Campany
fv Discount Factor
fv Effective Date
fv Expiration Date
fv Financial Party
fv Homeovmer
fu Tnsurad Age
fv Insured_DOB
fv Local Code
fv Number of Claims
fv Number of Drivars v
fv Number of Incidents
Variable: Rate Tier Global Task: Editing Varisble

Figure 41 Selecting a Table for Export
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If you are exporting a table from the Program Details or Universal tab, the active revision is displayed on
the listing. If you want to export a table variable revision that is not the active revision, you need to
showr/hide revisions and select the revision you want to export.

1. Select to Export a table to MS Excel.

2. The Export Data File screen is displayed. The first step is to specify the Destination Workbook
name and the Worksheet name. Both fields are required. The defaults are the name of the table.
If you want to export a table variable that already has been exported, you can re-name the
workbook. This creates a new file.

3. You can also choose an existing file in your server if you want. Once you set up both fields you
can click on export.

If you have selected a linked variable, they are all included in the export.

Tables can be selected one time for inclusion in the job.

e - We.. X

Export Data File

Please enter or select an Excel file for export

Destination Workbook: |BI Base Rate x| | Ca Fie |

Please enter the name of the worksheat
Worksheet: |EI Base Rate |

Lé Export | l_;’ Close |

Figure 42 Export Data File

Export Data File

The Destination Workbook name is displayed. The default value is the table variable name. You can edit
the name but not the file extension. The default file type extension is .xIsx. If you name a workbook
RateFeeGlobal.xlIs that will be the workbook name: RateFeeGlobal.xls.xIsx. The file will not be saved as
an Excel 93 — 2007 file type.

The Worksheet Name is displayed. The default value is also the table variable name. You can edit the
name. When creating a bulk table export job, each table is returned as a single workbook. One job can
return multiple workbooks.

There is an option to save to an existing file. This saves the job to an existing file on the server. Click the
File button to open the saved files. Using an existing Workbook will overwrite all content.

1. The Export Table Variable Data screen is next. The data can be reviewed but not edited.
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ra Table Variable - Export Data -- Webpage Dial
Export Table Variable Data
[
| Row # Rate Fee Global | Rate Tier Global | Local Code
_— 121 1.28) | 12820
2| 1211 1.27)| 369855]
3 [ 1212 128 326589]
s | 12.13) 129 2582585
| 5 | 1214 1.3)| 3685]
L6 | 12.15]| 131)| 21458 |
. 1218 | 1.32]| 2302]
| & | 12.17}| 1.33|| 12548
| o 12.18])| 1.34]| 325882
10, | 1219 1.35| 22584223 |
| 11 [ 12| 1.38]| 25265823 |
12 | 1221 137 38552 |
| 1z | 12.22)| 1.38]| 88532]
14 [ 1223 1.39)| 538722
| 15 | 12,24 14| 809005|
16 | 12.25} | 141]| 295312
btz 12.26]) 142]| 35320
| 18 | 1277 1.43)| 298320]
I 4 Prev. 50 f Save e |
Save & Fun Now
Run Now
TSmO Concel |
L — — ——

Figure 43 Options for Exporting Table Data

Options for Exporting Data

If this is the data you want to export, click Save Job and select the option you want. The options
presented depend on the permissions you have.

e Save — saves the export to a job listed on the Job Management tab. If no jobs have been created,
the export cannot be saved. You can still run the job with Run Now.

e Save and Run — saves the export to a job listed on the Job Management tab and then runs the
job. If no jobs have been created, the export cannot be saved. If you do not have Job
Management permissions, this option is not displayed.

e Run Now - runs the export job.
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Once the job has been run, the export is displayed the table export page of the Library. This is open to all
users.

2. If you opt to Save, you can select the job where you want to save the export to. A success or fail
message is displayed.

2 Selectlob -- Webpage Dialog >

The list below displays the Jobs that are available for export.

Job Mame Date Medified

Export TV 1 Dec 08 2015, 01:03 PM
Export TV 2 Dec 08 2015, 01:06 PM
Export TV 2 Cec 08 2015, 01:06 PM
Export TV 4 Cec 08 2015, 01:06 PM
Export TV 3 Cec 08 2015, 01:07 PM
Export TV & Dec 14 2015, 06:22 PM
Export TV 7 Diec 14 2015, 08:32 PM

€ € & B Page 1 of 1 (7 items)

w? Select | @ Close |

Figure 44 Selecting a Job

3. After the exports have been saved, users with permissions can view, edit and start the job on the
Table Job Management screen.

ORACLE’ Insurance Insbridge RateManager Version: 05.01.00 Subscriber: alamere User: Mary Elliott

File  Modules  Tools  Help

[ Home | & TableJobMana.. x =M
| & Table Batch Management
{74 new | [Z2 Edit Job Opﬁnnsl « start Ix Delete | [ff) Refresh | 52 Edit Content | View: 3y All = °
Name Type System Create Date Last Update Date Last Run Date Tables  Status -
Auto 01-07-2016 10:44:17 System Export Yes Jan 07 2016, 10:44 AM Jan 07 2016, 10:44 AM 1 Submitted
Auto 01-07-2016 11:57:29 System Export Yes Jan 07 2016, 11:57 AM Jan 07 2016, 11:57 AM Jan 07 2016, 12:00 AM 1 Success
Auto 11-20-2015 16:13:41 System Export Yes Nov 20 2015, 04:13 PM Nov 20 2015, 04:13 PM 1 Failed
Job_2 Export No Jan 07 2016, 11:56 AM Jan 07 2016, 11:57 AM Jan 07 2016, 12:00 AM 2 Success
Rate Analysis 1-2016 Export No Jan 07 2016, 01:47 PM Jan 07 2016, 01:49 PM 2 Saved
Table Export LV 1-7 Export No Jan 07 2016, 01:11 PM Jan 07 2016, 01:38 PM & Saved
Table_Analysis 1 Export Mo Jan 07 2016, 01:40 PM Jan 07 2016, 01:46 PM 2 Saved b
Number OF Jobs: 7

Figure 45 Jobs Listed on Table Job Management
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Overwriting Existing Files

Files are overwritten when the table job export is run again and the previous file is still there. A warning
message is displayed when you select to Save, Save & Run Now or Run Now.

2| Confirm -- Webpage Dialog lﬂ

- Waorkbook name is assodated with another
1 table variable,
-_./I This will result in a potential overwrite,

Do you want to continue?

o Ok & cancel

x

Figure 46 Overwriting a Job

If the file exists, a warning message is displayed to let you know that the file will be overwritten. Click OK
to overwrite the file or Cancel to return to the export screen.

If you want a second copy of this table variable to be exported, change the Workbook Destination name.
This creates a new file using the updated workbook name.

If the first file is no longer needed, delete the job that created the file from the Table Job Management
screen. This removes the file and you can export the table.
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FILES ON THE LIBRARY TAB

Table Export jobs are listed on the Library tab. The Library can be accessed from the library icon or the
library menu option.

To View Table Exports

1. On the Library menu bar, select Table Exports for the view.

ORACLE Iinsurance Insbridge RateManager

File Modules  Tools Help

Home Program Explorer CA_Auto_
| | = | o

Library

‘ View: | iy Export ~ | [ New | #2) Upload from File | 557 Edit Details | [ Save to
Drag a !
Nal Templates

p by it.
cope Available | Effe Dats
Custom XML

Public XML
Product Configuration
Table Exports

Figure 47 Selecting Table Exports on the Library

2. The screen refreshes with a listing of table export jobs. The list consists of Excel files and table
variable names along with additional information to identify the file.

Verson: 05.01.00 Subscriber: alamere  User: Raj Patel

TE o -
oo T Tt vpers o e ol Wl ke o]

Drng @ calumn to this aros to group by . ) R |
s Product bl Varisble Kame LVekce__JOomain___i Project___ Progreen Categay Sl
Criminal Court.xlsx At Ayto 11-20-2...  Criminal Count kS Algmere Personal  CA_Auto t  Criminal Failed
Cirvvnr Vnranble Factor s Aute Auto 11-35-3... Driver Varisble Factor 1 Alamere  Pargonal  CA_futa 1 Driver Subenttad
Total Criminal Counts Localadsx  Aute Ayto 11-20-2... Total Criminal Counts... 1 Alamers Personsl  Ca_auto 1 Criminal Success
AcodentBase wise Autn Aute 11-25-2... AcodertSasefats 3 Alamere  Poesonal  CA_Auta_l  Palicy Subemirted
Comarehensive x5 Ao Auto 11-20-2... Comprehensive 1 Alamers  Personsl  CA_Auta_l  Palicy Sutcess
Deductiblefact. visx Autn Autp 11-25-2... DeductibleFact 3 Alamere Personal  CA_Auta_l  Driver Saved
ThirdamyliaBase. xlsx Aue Auto 11-20-2...  ThirdPartylis 2 Alamere Personal  ©A_puta_l  Policy Success

Totsd Rucorde: 3

Figure 48 Table Exports on the Library Tab
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Files Listed

When multiple tables are submitted in a job, multiple workbooks are returned. Each table is presented on
a separate workbook. The information on the Library listing page can help to identify the file you want.
There are 10 fields:

Name — The name of the Excel file. The default name is the table variable name but can be
changed. This is the Destination Workbook name used when the export was created.

Product — The product LOB where the table variable is located.

Job Name — The job name of the user created job found on the Table Job Management tab or
the name assigned by the system export. System exports are named Auto followed by the date.

Variable Name — The name of the table variable selected.
Version — The version of the table variable selected.
Domain — the domain where the table variable is located.
Project — the project where the table variable is located.
Program — the program where the table variable is located.
Category — the category of the table variable.

Status — the status of the table export job.

File Status

Files listed on the Library tab may or may not be available. The status can help you determine if the file
should be available. There are 5 statuses for Table Exports:

Saved — a new job. This job may or may not have been run. When a table variable is saved to a
job, the file may be listed on the Library tab but is not yet available.

Submitted — a job that has been submitted for processing. The file may be listed on the Library
tab but is not yet available.

Executing — a job that is currently being processed. The file may be listed on the Library tab but
is not yet available.

Success — a completed job. The Excel file can now be downloaded from the Library tab.

Partial Fail — part of the job failed for some reason. The file may be listed on the Library tab but is
not available.

Failed — the job failed for some reason. The file may be listed on the Library tab but is not
available.
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If the status is saved, and you have permissions, you can return to the Table Job Management tab and
start the job. If you do not have permissions, contact your system administrator to start the job.

Files in Success status are the most likely to be available.

Downloading a File

The files listed can be downloaded and saved to your local drive or network or opened in Microsoft Excel
on your computer. You cannot open the file to view or edit inside of RateManager.

1. Select the file you want to view or edit.
2. Right click and select to Save to File or click the Save to File button in the top bar menu.
3. The file can be saved to your local hard drive or network drive or opened in Excel.

4. If you want to download the file, the download displays a success or fail message when
completed.

5. If you want to open the file immediately, the file will open in Excel. The file is not automatically
saved. You must save it in Excel.

File Not Found

When you attempt to Save to File and that file is not available, you will receive a message that the file
cannot be found. You can select to look for a file on the server.

r B
2 | Confirmation -- Webpage Dialog ﬁ—. Lg

0 Export file Properties_T_1.xlsx does not exist on the server,

Do you want to browse export files to locate it? |

2 Yes | % ) Ho |

e
Figure 49 Browse for File

A separate screen lists the files found on the Shared Workfiles location. Look at the Date Modified to
verify this is the file you want. An older version of the file may be on the server.
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-
= | Open Excel File -- Web

Senver Files

The list below displays the Excel Files that are available for import.

File Name Date Modified

Audio 8/20/2015 1:21:44 PM
Codes 10/28/2015 10:45:06 AM
Codes_Global 10/28/2015 10:44:52 AM
Codes_Universal 10/28/2015 10:44:23 AM
Test Codes 10/28/2015 10:37:50 AM
UsageCode B8/12/2015 3:58:29 PM

K € & 2l Page 1 of 1 (6 items)

| Open | | Cancel |

Figure 50 Table Exports Saved on the Server

Select the file you want and click Open. If you do not want any of these files, click cancel.

If the file you want is not found, you can export the file again. If the file still does not present, the system
administrator may need to verify the shared location is available or check the IBSS error logs.

Files are deleted from the listing if the job is deleted from Table Job Management.

Files in saved, submitted, executing and failed status often are not found.
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EDITING A FILE

Excel files that are immediately opened can be viewed and edited but are not automatically saved. If you
want to save the file, you must save it in Excel. The downloaded file may need to have editing enabled.

& 9- |+ ModelVearFactor - Microsoft Excel
Haome Insert Page Layout Formulas Data Review View FDF Acrobat
= X% ) L e o= _ =
j X Arial |3 T A A == = Wrap Text General -
2 e
Pafte 7 | B|7r u- e Merge & Center~ | $ + % 0 | %GB 508
Clipboard Faont u Alignment u Mumber
A2 - fe | BI
A G H 1 ]

2 |8l COLL Model Year Model Yea
3 Mask = false Reserved Reserved Reserved Reserved Reserved

4 Wildcard = false Reserved Reserved Reserved Reserved Reserved

R GG S CER -l Reserved  Reserved Reserved Reserved Reserved

6 Reserved Reserved Reserved Reserved Reserved

7 Vehicle Vehicle Vehicle Vehicle Vehicle

8 Decimal Decimal Decimal Integer Integer

S Operator: = Default: 0 Default:0 Default:0 Default:0 Default:0

10 1 1 1.22 1.24 2014 2014
11 1 1 1.22 1.24 2013 2013
12 0.99 1.03 1.22 1.23 2012 202
13 0.99 1.03 1.22 122 201 201
14 0.98 1.02 1.22 1.18 2010 2010
15 0.98 1.02 1.22 1.1 2009 2009
16 0.97 1.02 1.22 1.05 2008 2008
17 0.96 1.02 1.22 1 2007 2007
18 0.96 1.01 1.22 0.95 2006 2006
19 0.96 1.01 122 0.9 2005 2005
20 0.96 1.01 1.22 0.87 2004 2004
21 0.96 1.01 1.22 0.84 2003 2003
22 08 1.1 1.22 0.81 2002 2002
23 09 1.01 1.22 077 200 200
24 09 1.01 1.22 0.73 2000 2000
25 0.9 1.01 1.22 0.7 1999 1999
26 09 1.01 122 0.66 1993 1993
27 09 1.01 1.22 0.64 18987 1887
28 0.88 0.99 1.22 0.62 1996 15980
29 07 0.79 122 0.62 1989 1980

Figure 51 Exported Table in Excel

Table Composition

When the file is opened, the file can be edited as needed. The light blue columns on the left are the
criteria and the dark blue columns are the table variable and linked table variables, if applicable.

The rows under the criteria and table variables are the current values.
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Criteria Definition

Criteria definitions start in Column A, Row 2 (A2). All criteria are listed. The end of the criteria list
depends on the number of criteria that are defined in the table. The maximum number of criteria
allowed in a table variable is 50.

Row | Contents Notes
2 TableCriteria Name | The name of the variable that defines the criteria values
3 Mask = Masking applies - 'true' or 'false’
4 Wildcard = Wildcarding applies - 'true' or 'false’
4 Interpolate = Interpolation applies - 'true' or ‘false’
6 VarType The type of variable that defines the criteria values
o Fields
e CalcVar
o TableVar
7 Category The category of the variable that defines the criteria values
8 DataType The data type enforced for the values stored
e Integer
e String
e Decimal
o Date
9 Operator The operator used to determine whether the incoming data match

is ‘'true’ or ‘false’
e [=] equals
[<>] not equals
[>] greater than
[<] less than
[>=] greater than or equal to
[<=] less than or equal

Figure 52 Criteria Definitions for Exported Table Variables

True = the option is on the table variable criteria

False = the option is not on the table variable criteria

Table Identifiers & Results (Table) Definition

The table variable definition start column depends on the number of criteria defined in the table.
There is a maximum number of criteria is 50, column AY. The last column used depends on the

number of linked table variables defined.

Row | Contents Notes
2 TableVar The name of the table variable (or linked table variable) that
defines the result values in this column
3 TablelD1 Reserved
4 TablelD2 Reserved
5 TablelD3 Reserved
6 TablelD4 Reserved
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Row [ Contents Notes

7 Category The category of the variable that defines the result and table
values

8 DataType The data type enforced for the values stored

e Integer

e String

e Decimal

o Date

9 Default: n Then default value that is used at runtime if no matching criteria
row is found

Figure 53 Table Identifiers and Results Definitions

Table Data

Table data begins at row 10. The number of rows used depends on the amount of data in the table. All
data is current for the revision selected to be exported.

Row | Column Notes
10 A The beginning of the table data values

Figure 54 Table Data Definitions

All exported tables use a system-defined format with row 1 being used for system defined properties. The
export format cannot be modified and exported tables cannot be imported back in to RateManager at this

time.
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MANAGE PRODUCTS

The Manage Products screen gives you a snapshot of all the products, listed as lines of business,
currently in the system and shows if the product is activated, deactivated or disabled. RateManager

comes with 32 system products.

NOTE: Manage Products is available to users with Product Management permissions. If you do not have
permissions, you will not be able to access the Manage Products screens.

Manage Products Screen

Managing products is done on the Manage Products screen available from the Tools Menu—->Manage

Products.
[ a -- Webpage Dialog lér

§# Manage Products

New @ Edit Eﬁ Refresh ©

Show listing for produl:is:l All ﬂ

1D Dascription Status Type

21 Artizan Deactivated 5Y5

1 Auto Activated SYS ~

1z Automated Undenwriting Deactivated SYS

17 Boiler And Machinery Deactivatad Y3

4 eop Deactivatad SYS

11 Commercial Auto Deactivated SYS

29 Commercial Inland Marine Deactivated 5Y5

20 Commercial Package Deactivatad S5YS

15 Commercial Property Deactivated SYS

31 Crime And Fidelity Deactivated 5YS

1z Diractors And Officars Deactivatad 5YS

10 Disability Deactivatad 5YS

El Farmowners Deactivated SY3

5 Fira Deactivatad 5YS

14 General Liability Deactivatad Y3

24 HIO Deactivatad SYS

2 Home Deactivatad SYS

3 Life Deactivated 5Y5

26 Liquar Liability Deactivatad S5YS

19 Madical Deactivated SYS (W]

s RA-E, 1 i} i bmd

Selected Menu Item: Product Listing Number of Products:
) Close |

L 4

Figure 55 Manage Products Screen

If you do not have the Manage Products option available from the Tools menu, you do not have
permissions. Please contact your system administrator to get access.
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Manage Products Functions

The menu bar at the top of the screen allows you to:

New: New starts the process of creating a new product. See Creating New Products

= for more information.
[=# Edit Edit: Opens the Edit Product Info screen for the currently selected product.
() rRefresh Refresh: Refreshes the list of products.

Show listing for products: Allows you to view Products by activation status. Select
the status you want to view from the drop down menu.

- ALL: Displays all of the products currently in the system.
- Activated: Displays only the currently activated products.
- Deactivated: Displays only the deactivated products.

- Disabled: Displays only the disabled products.

All is the default selection. If you choose another selection, the screen refreshes with
your choice.

Manage Products Fields

Products are listed alphabetically. The total number of products in the system, both activated and
deactivated, is displayed on the bottom of the screen.

ID: The unique identifier assigned to each product. Once assigned, these numbers cannot be
changed.

Description: The name of the product. Names must be unique. Duplicates are not allowed.

Activated: A check in this column indicates that the product has been activated and is ready for
use.

Type: Shows whether the product is:

- System built. System built products are the standard products included in the Insbridge
application. System products cannot be deleted but can be edited.

- Custom built. Custom built products are user created products. Custom products can be
edited and deleted.
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Manage Products Functionality

The Manage Products screen allows you to do the following:

e Create a New Product
e Edita Product

e Activate a Product

e Deactivate a Product

e Disable a Product

e Delete Custom Product

NOTE: System products cannot be deleted. If there is a System product you no longer need, you can
disable it. This stops the product from being listed and being available. Custom products can be
deleted.

LOCALE

Prior to creating a new product or activating a product, you should have the locale you want to use in
mind. Locale is defined as the unique attributes of a location including formatting of dates and numbers.
The default locale, including a date and number format, is the locale used by the server where the
Insbridge system was installed.

The Insbridge server locale is used as the default locale for every product. The product locale can be
changed to another locale. The default locale for the product is the default locale for every program in that

product, regardless of project. The program locale can be updated to another locale. The locale used by
the program, either another local or the default locale, is the locale that will be used in rating.

Selecting a Locale

There are two places where you can select the locale:
e Product level

e Program level: For more on Program Locale, please see the RateManager Modules Volume 1
User Guide.

Creating a New Product

Custom products may be added at any time by any user with Line Management permissions. You cannot
create a system product.

Product Descriptors

ID — A required numeric identifier. Product ID numbers can be entered manually. This allows you to match
any product that may be Custom from the Library. Product ID numbers must be an unused number
between 100 — 250. If the number is out of range or being used, you will receive an error message.
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Product IDs cannot be changed after you save. If you made a mistake with the number, you will have to
delete the entry and re-enter. If you do not enter a value, the next available number is assigned.

Name — A user created identifier assigned to each product. Names can be up to 40 alpha numeric
characters and allowed special characters. Names must be unique. This is a required field.

Abbreviation — A two alpha character identifier code. This optional entry is used with Manage Project
Relationships result variables to identify the source product. System products have a default code that
can be edited.

Locale — The New Product screen and the Edit Products screen contain a drop down of available locales.
The default locale is the locale used by the sever where the Insbridge system is installed. A Locale must
be selected. You can leave the default or select a different locale when you activate a system product,
edit a product, create a new product, create a new program, or edit the program properties.

If you do not select a locale, the default will be used. The Date Mask, the Decimal Symbol, and Digit
Grouping Symbol are automatically filled with the defaults. These values can be updated and you can
type in an alternate value if you choose. You must have a value in the Date Mask, Decimal Symbol, and
Digit Grouping Symbol fields.

The values set at the product level serve as the default locale to every program created in the product
regardless of project. If the program requires a different local, you can change the locale at the program
level.

To verify a locale, open the Edit the Product screen. The selected locale for the product is listed here.

Date Mask — Date formats are displayed as entered and will be executed and evaluated as you expect
during rating. Date formats are carried through to any new versions or revisions.

Dates must contain:
e 2 digit Month entry MM
e 2 digit Day entry DD
e 4 digit Year entry YYYY or a 2 digit Year entry YY

e One of 3 separators minus sign ( - ), period (. ) or slash (/) Special characters are not allowed.
The list of special characters can be found the RateManager Modules Volume 1 User Guide.

Date formats are defined in the product. Any program in the product will initially use the defined format. A
different format can be entered in the program.

o Date formats can be in any combination of the mandatory fields, for example MM/DD/YYYY.
o Date format is case sensitive. You must you capital M, D and Y.

e A separator must be used, i.e. slash (/) MM/DD/YYYY, minus sign ( - ) DD-MM-YYYY, or period
(.)MM.DD.YYYY.

Decimal Symbol and Digit Grouping Symbol — The number formatting is the default number format
from the selected Locale. Number format refers to the decimal and digit separators found in common
number formats, for example, 1,000.00 or 10.000,00.
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Decimal Symbol — The decimal symbol indicates the integral part of a number from the fractional
part. For example, 10.25 (using a period as the decimal symbol) or 8,50 (using a comma as the
decimal symbol).

Digit Grouping Symbol — The digit grouping symbol indicates the symbol that is used to show
the thousands separator. For example, 1,000 (using a comma as the digit grouping symbol) or
1.000 (using a period as the digit grouping symbol).

The digit grouping symbol is used for validation purposes and not for display purposes.

Number formats are defined in the product. Any program in the product will use the defined format. A
different format can be entered in the program.

Most separators, i.e. comma (, ), period ( . ), or space ( ) are allowed. The special characters
apostrophe (*), pound (# ), ampersand ( & ), quote ( “), less than (<), and greater than (>) are
allowed. A complete list of special characters can be found the RateManager Modules Volume 1
User Guide.

You cannot use the same separator for the decimal and digital. The separators must be different.

Only one separator per entry. You cannot enter a space ( ) for the millions separator and then a
comma (, ) for the thousands separator. You have to select either the space or the comma.

Product Activated — A check indicates that the product is active. Active products can have user groups
assigned and will be displayed to users with permissions.

Naming Standard — You can select a naming standard for every product. This optional feature allows
you to enforce a uniform naming structure to system elements and programs. Please see Naming
Standards for more information.

If a naming standard is needed, it can be created prior to the product being created.
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Creating a New Product

When creating a new product, access is denied to all users except administrators. After creating the
product, you need to add user group permissions to the product. If the product does not present to users,
the user group does not have permissions to work in the product.

Step 1 — Creating the Product

1. Navigate to the Product screen from Tools->Manage Products.

2. Click New. A New Product screen is displayed.

a Mew Product -- Webpage Dialog [é]

Id: || |

Name: | |

Abbreviation: | |
{two alpha characters)

English {United States) -
Locale:

Date Mask: MM/ DD/ Y -
Decimal Symbol: o

Digit Grouping Symbol: | =~

Product Activated: []

Maming Standard: | | Select ... | Clear

w® Save | ) Close |

L

Figure 56 Entering a New Product

3. Enter an ID number.

4. Enter a name. The name can be up to 40 characters in length including spaces.
5. Enter a two character abbreviation.

6. Selectthe locale.

7. If needed, select a date mask.

8. Select the Decimal Symbol.

9. Select the Digit Grouping Symbol.

10. By clicking the Activated checkbox, the product will be activated after saving.
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11. If needed, select a Naming Standard.

12. Click Save. All groups except Administrators are denied access to any new product. A
RateManager administrator must allow group access before the product is available to users.

Step 2 — Adding a Product to a Project — OPTIONAL

13. If activating a product did not populate the group rights window with the product where rights
need to be assigned, the product may need to be selected in a project prior to permissions being
assigned.

14. Go to Program Explorer and select a domain type, domain, and project. If there’s only a domain
type, right click to create a domain. If there’s a domain but no project. Select the domain and right
click to create a new project.

15. On the project, right click Select products.

Home Program Explorer b

Program Explorer

MNew - CEE Manage Folders ECreat& Package @. Input XML

Programs
Eﬁ Look for Program:
=& RateManager
s Y
03 Alamere . =rogram Detail
il% Commerdi New Project ..I Mame ID
= Personal Edit Domain
Clear Domain
Delete Domain

16. A RateManager administrator must allow group access before the product is available to users.

Step 3 — Adding User Group Permissions to a New Product

17. Navigate to Tools—=> Security->Group Management to set permissions. This allows groups access
to view or edit variables, algorithms and other program options.

NOTE: Adding a product to group permissions needs to be done for a first time activation only. If you
deactivate and then activate again, you will not need to reset permissions.
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ORACLE’ Insurance Insbridge RateManager

Version: 05.01.00 Subscriber: alamere User: Company Administrator

File  Modules Tools  Help

| Home | & Group Manmagemer X = ¥
|_Group Management — 3 Bk
i [ New | [ Edit | 3¢ Delete | T, Richts | 3 Refresh 7 £l -
|Group |Description &= Group Rights
ADMIN ADMIN (3 Ratellanager Table Job Admin - Access Granted
Create and mage rates for all areas. Product =) Ratellanager Domain Admin - Access Granted | o)
Rateloaders. | ;g:%g:;i' ::‘::f?f g;‘:';aﬁ‘g""";e' Ley &1 ] Product Management
lecking, Aute and Home. NO DE access. f & ¥ Project Management
oA ;'Epsrtofgﬁrt:r: g;‘gzztiolfgzgtf’;ﬁ::;mz ?DhD” tosend ([} .‘-:J.Ral.el'vlanager Universals - Access Granted |
RateAnalysis .4 Analyze the rate created and analyze the data produced. If ol Vana.hles
BAl Business analysts for all program and all areas, +_' v Agoritims
e Recommendations for changes to be sent to rata analysis. -3 [¥] Fields
Testers.J =+ [v] Categories
- RateManager Testing - Access Granted
() RatelManager Package Admin - Access Granted
+-(3 Database Support - Access Denied
- Ratellanager Auto - Access Granted l
E-&|v| Variables
& [v] Algorithms v
- [v] Driver Assignment
o Save | | @ Close |

Selected Menu Item:  Group Management

Figure 57 Setting Security for New Products

18. Select the group that needs access to the new product.

19. Click on Rights. A Group Rights screen is displayed. Expand out the new product.

20. Place a check in all the boxes where the group requires access. Click Save. Users in that group can
now view and use the selected options. For more on user groups and rights, see Group Management.

If the product does not appear, click Reload to apply the updated settings.

For new users, Domain Admin Access, Universal Access, as well as Product Access may be required.
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Editing a Product

Any product may be edited at any time.

1. Navigate to the Product that you want to edit.

fidl Manage Products

E New | [z Edit | () Refresh :

Showy listing fior producls:l All el

1D Description Status Type

21 Artizan Deactivated 5YS

1 Auto = Activated 5¥5
Edit .

12 Automated Unde : Dieactivated 5YS
Deactivate

17 Bailer And Machin ) Deactivated S¥S
Disable

4 BOP Activated 5¥5

Figure 58 Selecting a Product to Edit

2. You can double-click the product you want to edit or select it and click Edit. You also can right
click and select Edit from the menu. The Edit Product Info popup opens, allowing you to edit the

product.
il |
a Edit Product Info  -- Webpage Dialog w
MName: |-""\'-'--|'t‘=3l b4 |
Abbreviation: | PA |
{two alpha characters)
English {United States) -
Locale:
Date Mask: Y -MM-DD -
Decimal Symbol: .
Digit Grouping Symbol: || -
Product Status: | Deactivated
Maming Standard: | | Select ... | Claar
g Save E) Close
"

Figure 59 Editing a Product

3. Make any necessary changes. Every field can be edited.

4. When you are finished, click Save. The product screen refreshes with the changes you made.
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Click Close to go back to the Manage Products screen without saving any changes.

Updating a Locale

Updates to Locale at the product level affect new programs. Existing programs are not affected by
updates. Existing programs already have a locale set at the program level.

WARNING: Changing date and number formats may result in programs not running properly. Global
elements that have been created as one type of date and number format may not function
as expected with another date and number format. Date and number formats should be
consistent through the program.

Updating a Naming Standard

An update to the Naming Standard at the product level applies to all new programs. Existing programs
are not affected by an updated Naming Standard unless edited. When existing programs and elements
are edited, the name entry is validated against the current Naming Standard option. Users may be
required to make changes to the name to meet selected naming standards.

Activating, Deactivating, or Disabling a Product

Any product may be activated, deactivated, or disabled at any time.

Activating a product allows for the product to be selected for use in new and existing projects. There are
two additional ways to activate a product:

o Enter the Edit Product screen and select Activated
e Select a product for use in a project

Disable removes the product from being selected in any new or existing projects.
o Disable also removes the ability to set permissions on the Product.

o Disable does not stop any new development. To stop any further development in the product,
group rights must be edited to view only and the product disabled.

o Disable does not stop the usage of the product in Program Callouts.

Changing a Product Status

1. Navigate to the Product that you want to activate, deactivate, or disabled.

2. Right click to get the menu. A System product has three right click menu options. A Custom
product has four right click menu options.

86



Chapter 3 — Manage Products

fi# Manage Products

{3 New | [22 Edit | &) Refresh

Show listing for producls:l All
|ID | Deascription | Status Type
21 Artisan Dizactivated SYS
1 Auto Deactivated =4 g=1
12 Automated Underwriting Edit Eivated SYS
17 Baoiler And Machinery AF:[WEtE ivated SY5S

Disable

4 BOP vated 5YS

Figure 60 Selecting a Product to Activate

To activate: Click Activate. The product that you activated is now available for selection in new or
existing products.

i@ Manage Products
| (3 New | 22 Edit | &) Refresh
Show listing for producls:l All
1D | Dascription | Status Type
21 Artizan Deactivated 5YS
i Auto Activated SYS
Edit i
1z Automated Unde - Dieactivated 5YS
Deactivate
17 Bailer And Machir — Deactivated S¥S
Disable
4 BOR Activated 5Y¥S
Figure 61 Selecting a Product to Deactivate
To deactivate: Click Deactivate.
fid Manage Products
: [ New | 22 Edit | B} Refresh
Show listing for producls:l All
1D | Dascription | Status Type
21 Artizan Deactivated 5YS
i Auto Activated SYS
Edit )
12 Automated Unde . Dieactivated 5YS
Deactivate
17 Bailer And Machi Deactivated S¥S
4 BOR Activated 5Y¥S

Figure 62 Disabling a Product

To Disable: Click Disable. The product that you disabled is no longer available for selection in
new or existing projects.
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Products in Projects

The advantage to disabling a product is to remove the product from selection by any new or existing
project. This prevents from selecting products that should not be used.

For Example: In Manage Products, the first three products each have a different status:

i# Manage Products
{3 New | [22 Edit | &) Refresh
Show listing for producls:l All hd
1D Description Status Type
21 Artizan Disabled SYS I
1 Auto Activated 5¥S
12 Automated Underwriting Deactivated SYS
17 Rniler &nd Machinerv Naartivatard SYSs

Figure 63 Product Status in Manage Products

e Artisan is Disabled
e Auto is Activated
e Automated Underwriting is Deactivated

a Select Products -- Webpage Dialog

Name: |Per5u::\na|
Data Model External: Fals=
Driver Assignment Module: Enabled
Notes:

Products:

(7] Auto ActivaltEd
(7] Automated Underwriting Deactlvated

Ell [ Dailar fnd 8achiman.
Figure 64 Products Available for Selection in a Project

When products are listed for selection in a new or existing project, only the products in Activated or
Deactivated status are presented. The product, Artisan, is not displayed and not available for selection.

A deactivated product can be selected for inclusion in a project. If a deactivated product is selected, the
status changes to active. Administrators may have to update group permissions to allow access to the
product.

Products that are activated should have group permissions already assigned and will be available to
users with the group permissions to work in the product.
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| Home | Program Explorer X
Program Explorer
Mew - ?;3 Manage Folders E Create Package @. Input XML -
Programs
g EB Look for Program:
=3 & RateManager
:l% Alamere Program Detail
:I@ Personal a Mame ID | We
= §@ Auto
= §@ Automated Undenwriting
& universals

Figure 65 Administrator View of All Products

Products that are deactivated and have never been activated will not have permissions assigned. Only
administrators will be able to see them.

| Home | Prngram Explorer ®

Program Explorer
Mew - CEE Manage Folders ﬁ Create Package @. Input XML ~

S EE} Look for Program:
= {‘3 RateManager
:l% Alamere Program Detail
:IE Personal [a Mame ID | We
= §@ Auto
& universals

Figure 66 Non-Administrator View of Products

Non- admin users will not be able to see or utilize the product until permissions have been granted.

Reactivating a Disabled or Deactivated Product

Reactivating a product allows for the product and all associated programs to be displayed on the Program
Explore for users with group permissions to work in the product.

If a product was previously activated and had permissions assigned, the previous permissions will be
used and the previous content will be displayed when reactivated.

You can activate, deactivate, or disable a product as many times as you need. Permissions and contents
are not removed when a product is deactivated or disabled. If you reactivate, the permissions and
contents are the same.
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Deleting a Custom Product

Custom products can be deleted at any time. All associated contents for the product are deleted as well.
Please verify this is the action you want to take. This action cannot be undone. Two warnings are given.

You will need to refresh the screen to see that the product has been deleted.
1.
2.

3.

Navigate to the custom Product you want to remove.

Right click to get the menu.

Click Delete. A warning message is displayed. Click OK to remove the product. Click Cancel to
cancel the action. A second warning message is displayed. Click OK to remove the product.

a -- Webpage Dialog

o

f# Manage Products
New @ Edit Ela Refresh ©
Show listing for produl:is:l All ﬂ
1D Dascription Status Type
21 Artisan Deactivated 5YS
1 Auto Activated sYS ~
12 Automated Underwriting Deactivated S¥S
17 Boiler And Machinery Deactivated S¥S
4 BOP Activated 5YS
11 Commercial Auto Deactivatad SYS
29 Commercial Inland Marine Disabled S5YS
30 Commercial Package Deactivated SYS
15 Commercial Property Deactivatad SYS
31 Crima And Fidelity Deactivatad SYS
102 Cyber - Deactivatad CUSTOM
13 Diractors And Ofi Edl'.t Deactivated 5YS
10 Drisability AF‘II‘UETE Dieactivatad sYS
Disable
101 Errars and Omig Activated CUSTOM
=l Farmowners Dieactivatad 5Ys
5 Fira Dieactivatad sYS
14 General Liability Deactivated S¥S
24 HIO Deactivated 5YS
2 Home Deactivatad S5YS
3 Life Deactivatad SYS [
n Li Linkilis Pummmbivsmind
Selected Menu Item: Product Listing Mumber of Products:
E) Close |

Figure 67 Removing All Programs from a Product

Deleting a custom product does not remove any programs from callouts. A program containing a deleted

custom product program cannot be packaged until the program callout is edited.
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AUDIT

RateManager can keep an audit log of user activity. Audit logs contain information such as the action
performed, user ID, date and time stamp. Audits set to high will also track adding a user, editing a user
and deleting a user. Audit logs also can include program information such as program ID, program
version and product as well as element information.

The Audit tab contains a list of audits logs. The audit log feature has to be enabled at the group level. On
the Group Management tab, Tools-> Security->Group Management, select the group where you want to
apply auditing. There are three options for auditing the group:

e None — No auditing is done.
¢ Normal — All saves and deletes are logged.
e High — All new, creates, changes, saves, and deletes for the group are logged.

If the group(s) has high auditing, more audit logs are created and you will have more types of actions you
can filter on.

& hitp://10.100.10.100/?page=default - Oracle Insurance Insbridge RateManager 05.01 - E =)
ORACLE’ Insurance Insbridge RateManager
Fle  Modules Tools  Help
[ Home 1 & Audie x =
<1 Audit
Il|: = Filter | #2 Audit Report | &k Purge All | &) Refresh
]

Action Product Program Version Version Mame Date Control Number
Save Program Version 1 Auto Lab 6 Total Prem Jun 05 2015, ...
Edit Program Version Data 1 Auto Lab 5 Jun 05 2015, ...
Save Program Version 1 Auto Lab 5 Coll Prem Jun 05 2015, ..
Edit Program Version Data 1 Auto Lab 4 Jun 05 2015, ...
Save Program Version 1 Auto Lab 4 Comp Prem Jun 05 2015, ...
Edit Program Wersion Data 1 Auto Lab 3 Jun 05 2015, ..
Save Program Version 1 Auto Lab 3 Total Jun 05 2015, ...
New Program Version 1 Auto Lab 7 Jun 05 2015, ... Version 7
New Program Version 1 Auto Lab [ Jun 05 2015, ... Version &
New Program Version 1 Auto Lab 5 Jun 05 2015, ... Version 5
New Program Version 1 Auto Lab 4 Jun 05 2015, ... Version 4
New Program Version 1 Auto Lab 3 Jun 05 2015, ... Version 3
Edit Program Version Data 1 Auto Lab 2 Jun 05 2015, ... [
Save Program Version 1 Auto Lab 2 BI and PD Premium Jun 05 2015, ...
Edit Program Wersion Data 1 Auto Lab ) BI Premium Jun 05 2015, ...
Save Program Version 1 Auto Lab 1 BI Premium Jun 05 2015, ...
Save Program Version 1 Auto Lab T BI Premium Jun 05 2015, ...
New Program Version 1 Auto Lab 2 Jun 05 2015, ... Version 2
Save Program 1 Auto Lab Jun 05 2015, ...
Save Program 1 Auto Lab Jun 05 2015, ...
Edit Program Version Data 1 CA_Auto_2 1 Jun 05 2015, ...
Save Program Version 1 CA_Auto_2 1 Jun 05 2015, ... -
Diage s-m‘_ 1€ € 9 3 Page 1 of 1 (Total Records:614)

' ~

v
< >

Figure 68 Audit Tab
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Audit Functions

Filter: Opens up the filter option. You can select fields to filter on. The entries you
make in the filter option will be the results returned. The results are displayed in the
main body of the tab. Any field that does not match is not displayed. Filters are removed
when you exit the tab or re-enter the filter option and remove the filter.

= Filter

#=1 Audit Report

Audit Report: Opens up a full Audit Report for the audits currently being displayed.
Audits that have been filtered out are not displayed.

% Purge Al

Purge All: Purges all audits currently displayed. Results can be filtered for purging. If
you filter audits, only the audits that meet the filter criteria are displayed. These audits
will be removed if you select to Purge All. If you select to purge all without a filter, every
audit is deleted.

i) Refresh | Refresh: Refreshes the list of audits.

Audit Fields

The main body of the tab displays the logs that have been created since the last purge. There are five
fields in the main body of the Audit tab.

Action — The action performed.

Product — The product. No Product means that this was a system action, for example, logging in
or out of the system.

Program — The name of the program where the action took place. No Program name means that
this was a system action.

Version — The program version number where the action took place. No Program Version
number means that this was a system action.

Version Name — The program version name assigned to the program. This is an optional field
and may not have an entry.

Date: The time stamp of when the action tool place.

Control Number — Displays any Change Control information. Change Control is optional and
may not have an entry.

NOTE:

If you have Auditing on and no results are being displayed, verify that the Insbridge Message
Service is running. Audit logs may not be displayed if the Message Service is not running.

Right Click Menu

There is a right click menu available on every audit log.
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Program Information:

<

2 http://10.100.10.100/?page=default - Oracle Insurance Insbridge RateManager 05.01
ORACLE" Insurance Insbridge RateManager
File  Modules Tools  Help
| Home | & Audit =@
i+ Filter | @) Audit Report | & Purge All | B} Refresh i
Action Product Program Version Version Name Date Control Number
Save Program Version 1 Auto Lab [ Total Prem Jun 05 2015, ..
Edit Program Version Data 1 Auto Lab 5 Jun 05 2015, ...
Save Program Version 1 Auto Lab 5 Coll Prem Jun 05 2015, ...
Edit Program Wersion Data 1 Auto Lab 4 Jun 05 2015, ...
Save Program Version 1 Auto Lab 4 Comp Prem Jun 05 2015, ...
Edit Program Version Data 1 Auto Lab 3 Jun 05 2015, ...
Save Program Version 1 A : 3 Total Jun 05 2015, ...
New Program Version 1 Ad View AuditRepart | 5 Jun 05 2015, ... Version 7
New Program Version 1 | Ay Deletz Audit [ Jun 05 2015, ... Version 6
New Program Version 1 AutoTab 5 Jun 05 2015, ... Version 5
New Program Version 1 Auto Lab 4 Jun 05 2015, ... Version 4
New Program Version 1 Auto Lab 3 Jun 05 2015, ... Version 3
Edit Program Wersion Data 1 Auto Lab 2 Jun 05 2015, ... E |
Save Program Version 1 Auto Lab 2 B1 and PD Premium Jun 05 2015, ...
Edit Program Version Data 1 Auto Lab i BI Premium Jun 05 2015, ... ”
Save Program Wersion 1 Auto Lab 1 BI Premium Jun 05 2015, ...
Save Program Version 1 Auto Lab 1 BI Premium Jun 05 2015, ...
New Program Version 1 Auto Lab 2 Jun 05 2015, ... Version 2
Save Program 1 Auto Lab Jun 05 2015, ...
Save Program 1 Auto Lab Jun 05 2015, ...
Edit Program Version Data 1 CA_Auto_2 1 Jun 05 2015, ...
Save Program Wersion 1 CA_Auto_2 1 Jun 05 2015, ... b 1
Page size: [ 1000 perpage v| 1§ & 9 Page 1 of 1 (Total Recardsis14)
Audit Report A
Action Information:
Action : Save Program Version
User: Mary Elliott
Date: Jun 5 2015 2:02PM
W

Figure 69 Audit Listing Right Click Menu

The right click menu contains two options:

e View Audit Report — Displays the audit report for this audit log only, in a printable form. If you do
not need to print out an audit report, double click the log and view the audit details at the bottom
of the screen.

o Delete Audit — Deletes the selected audit log only. Use this feature to delete logs that are not

removed in a purge, such as purge logs and audits with Change Control entries.

93




Chapter 4 — Audit

FILTERING

Filtering allows you to filter audit logs by specific criteria. When you select a filter, any audit logs with that
criteria are returned to the report. Results are listed newest to oldest. The results can then be used to

create an Audit Report or be purged.

-

L™

o]

—l

- Filter Audit Results

Action:

Line Desc:
Program ID:
Version Name:
Program Ver:
User FirstMame:
User LastName:
From Date:

To Date:

Control Humber:

-- Mo Filter -- + Custom
| |
| |
| |
| |
| |
| | Grvyy-mon-dd)
| | Grvyy-mon-dd)
| |
¥ Ok | Q, Clear | ) Close |

Figure 70 Filter Selection

Action - You can filter by words found in the action description. For example, Login, Save, Delete, or
Control. You do not have to enter the entire phrase. For example, you can enter “New” and any action
description with the word “New” in it will be returned. Your filter options depend upon the level of auditing
the group has. If your group(s) has high auditing, more audit logs are created and you will have more
types of actions you can filter on.

Line Desc — You can select an active product from the drop down menu or you can click the Custom link
to enter in your own description.

Program ID — You can enter in the exact program ID. Only exact matches will be returned.

Version Name — You can enter in the exact program version name. Be aware that program version
names are not required and are not unique. If you enter in 1, you may get many results for program
version 1 from multiple products and multiple programs. Only exact matches will be returned.

Program Ver — You can enter in the exact program version. Be aware that program versions are not
unique. If you enter in 1, you may get many results for program version 1 from multiple products and
multiple programs. Only exact matches will be returned.
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User FirstName — You can enter in a user first name up to 20 characters. Only exact matches will be
returned.

User LastName — You can enter in a user last name up to 20 characters. Only exact matches will be
returned.

From Date — Dates must be entered in yyyy-mm-dd format. Only entering in a From Date will return audit
logs from that date until current. Date ranges can be returned by entering in both and from and to dates.

To Date — Dates must be entered in yyyy-mm-dd format. Only entering in a To Date will return all audit
logs from the beginning of the audit log until that date. Date ranges can be returned by entering in both
and from and to dates.

Control Number — You can enter in the exact Change Control number or tag used when creating the
new revision. This is helpful if you want to make sure all changes were done against a particular change
order. You do not have to go into each element to search. You can come here, enter in the change
control identifier and view the list here. You can also do an action filter by the word Control to get a listing
of all change controls.

To Set Filtering

1. On the Audit tab, click Filter. This pulls up a filter screen where you can enter criteria that will
narrow your audit results.

e You can choose one or more filters.

o Filters remain in place until your remove them or leave the tab.

e To clear afilter, click the Clear button. After you clear a filter, all Audit Logs will be
returned.

2. After you have entered your filters, click OK to view your results.

| 5 Audit
~ Filter | #2) Audit Report | % Purge All ) Refresh

Achion Product Program \ersion Version Name Date Control Number

[

Mew Result Group 1 CA_AU_189_A 2 Jun 04 2015, 03:11 PM
New Algorithm 1 CA_AU_189_A 1 Jun 04 2015, 03:09 PM
Mew Algorithm 1 GLOBALS Jun 04 2015, 03:06 PM
Mew Result Variable 1 Jun 04 2015, 03:06 PM
Mew Input 1 GLOBALS Jun 04 2015, 03:05 PM
Mew Input 1 GLOBALS Jun 04 2015, 03:05 PM
Mew Table Variable 1 GLOBALS Apr 09 2015, 06:08 PM
Mew Input 1 GLOBALS Apr 09 2015, 06:07 PM
Mew Table Variable 1 GLOBALS Apr 09 2015, 05:59 PM
Mew Input 1 GLOBALS Apr 09 2015, 05:58 PM
Mew Input 1 GLOBALS Apr 09 2015, 05:58 PM
Mew Input 1 GLOBALS Apr 09 2015, 05:58 PM
Mew Input 1 GLOBALS Apr 09 2015, 05:55 PM
Mew Table Variable 14 GLOBALS Apr 09 2015, 05:25 PM
Mew Input 14 GLOBALS Apr 09 2015, 05:24 PM
Mew Table Variable Data 14 CA_882 D Apr 09 2015, 04:54 PM
Mew Table Variable Data 14 CA_882_D Apr 09 2015, 04:54 PM
Mew Table Variable 1 GLOBALS Mar 06 2015, 06:24 PM
Mew Table Variable 1 GLOBALS Mar 06 2015, 06:22 PM
Mew Input 1 GLOBALS Mar 06 2015, 06:21 PM =
Page Sizes 1€ € » 3l Page 1 of 1 (Total Records:260)

Figure 71 Filtered Audit Listing Results
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AUDIT REPORT

An audit report for all audit logs currently displayed on all pages by filter criteria can be produced. If you
want an Audit Report for all audit logs, make sure the filter has been cleared. If you want an audit report
for a specific type of audit log, make sure to filter by those criteria. For Example, if you want the audit logs
from a particular day forward, then enter that day in the From Date on the Filter. All the audits from that
day and forward will be listed. The audit report is a maximum of 15 pages.

a Oracle Insurance Insbridge Document Viewer -- Webpage Dialog l (S | S
ORACLE Audit Report 7/17/2015 09:32 PM
INSURANCE

ACTION: Save Program Version

Action Information:

Action Save Program Version
User Mary Elliott e
Date Jun 52015 2:02PM

Control Number

Control Note

Program Information:

Line Auto
Program Auto Lab
Version -
3] P RPN ,, Fpp— j

@ Close |

Figure 72 Audit Report

Creating an Audit Report

To create an Audit Report, enter in the criteria you want to filter by and click Audit Report. Reports are
displayed in the Insbridge Document Viewer. These reports are read-only. Reports can be saved to your
local hard drive or network or printed. No editing can be done on the Insbridge Document Viewer.

NOTE: When you do a “Save As” from the Insbridge Document Viewer, you should rename the file. By
default, when you go to save a file in the Insbridge Document Viewer, everything is named
“InsbridgeDocument”. It is recommended that you re-name the file.
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Report Details

The report contains details for each of the audit logs included, starting with the newest. Each log has
action information, defining the action taken, the user, and the date. Program information, such as
product, program, program version, and program ID, may be included. If applicable, element/item
information including description, revision and ID may be included.

NOTE: OBI Publisher must be installed and running in order for Program and Program Version Reports
to be displayed. If you receive an OBI Publisher error, please contact your system administrator.

Audit Preview

To view a specific audit, double click the product. The audit report details are displayed in Preview
Window located in the lower portion of the tab.

/Audit Report ~

Action Information:

Action:  %ave Program Version
User: Mary Elliott
Date : Jun 52015 2:02PM

Program Information:

Line: Auto
Program : Auto Lab
Version : 4
Version Name: Comp Prem
ID: 9

Element/item Information:
< >

Figure 73 Audit Log Preview Screen

The preview window can be sized by dragging the separation bar between the audit list and the preview
window. The preview window will update to show the currently selected audit log.

NOTE: If logs are not displayed, please verify that the Insbridge Messaging Service is on. If the Insbridge
Messaging Service is off, logs will not be displayed.

Individual logs can be viewed or deleted.

PURGING AUDIT LOGS

Audit logs that do not have a change control can be purged at any time. Purge All removes all audit logs
currently displayed on all pages by filter criteria. For example, if you have run a filter for all logs created
on May 23, 2014, the screen displays all logs created on that day only. The logs may consist of one page
or many pages. If you click Purge, all logs for May 23, 2014 without change controls will be purged. No
other logs will be purged. To view remaining logs, clear the filter.
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If you want to purge all audit logs without change control, do not place a filter on the list. If you only want
to purge selected items, place a filter on the list. Purge will only remove the audit logs that are displayed
on the Audit Listing screen. If you want to remove one audit, use the right click menu to delete.

To Purge Bulk Audits

1. If you have a specific audit type or group of actions you want to remove, set a filter for the bulk
audits you want to remove.

2.  When the audits you want to remove are displayed, click Purge All.

£ | Confirm -- Webpage Dialog [ﬁj

™ Purging the audit listing removes the listing
from disk permanently! Are you sure you

J want to do this?

2 Ok | & cancel |

M

Figure 74 Purging an Audit List

3. Click OK to remove the all audits without change control currently displayed. Click Cancel to
return to the previous screen.

NOTE: Purge Logs and Change Control Audit logs are not purged in bulk. These logs must be deleted
one at a time using the right click menu.

To Delete One Audit

1. Toremove one single audit that is no longer required, highlight the audit. Audits with change
control can be deleted using Delete Audit.

2. Right click and select Delete Audit from the menu.
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& | Confirm -- Webpage Dialog ﬁ

™ You are about to delete this audit log. Are
y you sure you want to do this?

g Ok | & cancel |

b

Figure 75 Purging an Audit List

Click OK to remove the log. Click Cancel to return to the previous screen.
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Any administrator may configure RateManager security settings. Usernames and groups can be created
and system rights assigned. Groups can be created to grant users access to specific products and
specific screens within that product (variables, algorithms, etc.), with or without write access. Groups also
can be given access to specific modules, Testing or Impact Analysis.

Security can be found on the Tools menu. There are three options you can select:
e User Management

e Group Management
e Session Management

USER MANAGEMENT

The user management tab allows an administrator to add, edit and delete users. This portion of
RateManager is only available to users who are members of the Administrator group.

| & hetpy/10.100.10.1007page=defauit - Oracle Insurance Insbriige RateManager 05.01

ORACLE" Insurance Insbridge RateManager

File  Modules Tools  Help

i- Home -; & User Management X =¥

User Management
(% new | [ edit 3 Delete | ) refresh ¢

|Name | Contact Info |Last Login

Company Administrator Jul 28 2015 B:38AM

Selected Menu Ttem:  User Management

Figure 76 User Management Screen
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From here, you can:

Add a User

Edit a User

Delete a User

Reset a User Password

Company Administrator is the only user in a new system. All other users must be created. The Company
Administrator cannot be deleted nor have their rights edited.

User Management Functions

Mew | New: Opens up the Create User tab where new users can be added to the system.
B} Edit Edit: Opens up the Edit User tab where user information can be updated and user
password reset.
2€ Delet= | Delete: Deletes the selected user.
iifi) refresh | Refresh: Refreshes the list of users.

User Management Fields

The main body of the tab displays the users that have been created. There are three fields in the main
body of the User Management tab.

Name — The first and last name of the user.

Contact Info — The phone number and email address of the user. The email address will be
hyperlinked, allowing you to create an email for this user.

Last Login — The time stamp for the last date and time the user logged into the system.

ADDING A USER

New users can be added from the Add User tab. All new users will be assigned the default password,
password. New users should log in as soon as possible and change their password.

There are two icons and two buttons located on the tab.

Required: A red asterisk indicates that this field is required. You cannot save your
entry unless all the required fields are complete.

Information: Click the information icon to see more information about the entry.

Select Arrow Move Left: The column on the right lists the available groups. The Select
Arrow Move Left moves the selected group over to the left side column. Upon saving,
the user will belong to that group.
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Select Arrow Move Right: The column on the left lists the group(s) the user is currently
. | a member of. The Select Arrow Move Right removes the selected group over to the right
side column. The user will no longer belong to that group.

@ Save | Save: Saves your entry. The Save option is located in the lower right hand corner of the
- tab.
@ cancel Cancel: Cancels any changes and returns you to the User Management tab. The

Cancel option is located in the lower right hand corner of the tab.

Adding a New User

NOTE: Prior to creating a user, make sure you have your user groups created.

10.

11.

12.

Navigate to Tools->Security>User Management tab.
Click New to open the Add User tab.

Select the Group(s) the new user will belong to by selecting a group or groups from the Select
Groups list and then clicking Select Arrow — Move Left. Upon saving, the user will belong to that

group.
Select the Company the user belongs to from the drop down listing.

Subscriber information may be needed by users when logging into the system. If more than one
subscriber was created, users must be directed to the subscriber where their logins were created.
Subscriber information is necessary for custom XML creation and testing and is also needed for
Libraries.

If you have not created subscribers in IBFA, you will not be able to assign users to a company.

Enter a First and Last name for the user in the appropriate text boxes.

Enter a Username for the new user. The username must be at least six, but fewer than twelve,
alphanumeric characters and can include an underscore () or period (.).

Enter a Department for the user.
Select whether the new user is a Network User by selecting True or False from the drop down.
Optionally, enter a Phone Number and Email Address for the new user.

If you want the user's password to expire, click the box next to Password Expires. The
Preferences screen contains the number of days required for a password change.

When you are finished, click Save. The user is added to the system and the user list is updated.
The new user can now log in using the username you assigned them and the default password,
password.

The user should change their password the first time they log in. See Changing Your Password
for more information.
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! http://10.100.10.100/?page=default - Oracle Insurance Insbridge RateManager 05.01 | B
ORACLE Insurance Insbridge RateManager
File  Modules Tools  Help
Home & User Management X =N
| [ Add User
|| You have selected to add/edit an user that will belong to a ‘Group’ that will control his/her rights for all Insbridge applications and a ‘Company’ that offers high level grouping for security. All new users will have a default password that should be changed ana
successful login for security reasons. The required information i noted with an asterizk.
Groups
Member Of: Select Groups:
ADMIN Rateloaders
QA
Ratefnalysis
=1
>
| Company alamere =
Firstname %
Lastname
Username @)
|| Department =
|| Metwork User
Phone
Email
Password Expires L7)] O
I & save il @ Cancel

Figure 77 Adding a New User

Network Users

The network user option (if set to true) is to be used in conjunction with the Insbridge portal.

If set to True, network user’s credentials (username and password) are validated using Windows
Authentication Tokens. The username in RateManager must match the network user ID. Users can
access RateManager using the Insbridge portal. Users will need the Insbridge URL to access
RateManager via the portal. They may not be required to enter login information at the RateManager
login screen, depending on the server setup.

Please see the Insbridge Portal Configuration Guide for instructions on setting up a portal.
If set to False, users must enter a valid username and password via the RateManager login screen.
Users will need their username and password along with the RateManager URL to access RateManager.

Users set up with a False Network User can still access the Insbridge portal. They will be required to
enter their login information when accessing RateManager.

Removing a User Group

To remove a user from a group, select the Group(s) the user will be removed from and click Select
Arrow Move Right. Upon saving, the user will no longer belong to that group.
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EDITING A USER

This section allows an administrator to change a user's information such as their email address or phone
number. It also allows for a user’s password to be reset.

To Edit a User
1. Navigate to the User Management tab.

ORACLE" Insurance Insbridge RateManager

File  Modules  Tools Help

Home Program Explorer a User Management x

User Management

Mew E‘? Edit x Delste EE! Refresh

MName Contact Info Last Login
Company Administrator Jul 28 201!

i A mellicttZexample.com !
Mary Elliott R Jul 23 201*

Figure 78 User Management for Editing a User

2. Select the user you want to edit and click Edit. You also can edit a user by double-clicking their
name.

3. This opens the Edit User tab. This screen is similar to the Add User tab and all information can
be edited, with the following exception: the reset password option.

4. When you have finished making changes, click Save to update the user's information and refresh
the user listing. If you do not want to save your changes, click Cancel.

Resetting User Passwords

You have the option to reset a user's password. If a user forgets their password, you can reset it on the
Edit User tab.

1. Navigate to the User Management tab
2. Select the user whose password you want to reset and click Edit. This opens the Edit User tab.

3. Scroll to the bottom of the tab and check the reset password box. The user's password is reset to
the default password, password.

104



Chapter 5 — Security

2 hitp://10.100.10.100/7page=default - Oracle Insurance Insbridge RateManager 05.01 _ [E=SEEl™ )
ORACLE" insurance Insbridge RateManager
File  Modules Tools Help
| Home " & Group Management | & UserManagement X =
I_ Edit User
You have selectad to 3dd/edit an user that wil belang o a ‘Group that will control his/her rights for all Insbridge applications and 3 Company’ that offers high level grouping far securty. Al new users wil have 3 default password that should be changed on @
succassful login for sacurity reasons, The raquirad information is notad with an astarisk.
Groups
Member OF: Select Groups:
Rateloaders. ADMIN
— |oa
RateAnalysis
= 1™
>
Company alamers bl o
Firstname Mary -
Lastname Ellott *
Username ) MElliott -
Department Rate Loading =
Network User
Phone 312-555-0010
Email melliott@example.com
Password Expires @) O
Reset Password I

- [EE e
Figure 79 Resetting a Password

4. Click Save to save your entry.

The user should change their password the next time they log in but will not be required to do so.
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DELETING A USER

If a user is no longer needed, they can be deleted. Any user at any time can be deleted. Only the Admin
user cannot be deleted.

To Delete a User

1. Navigate to the User Management tab.

2. Select the user you want to delete and click Delete.

ORACLE’ Insurance Insbridge RateManager

File  Maodules Tools Help

Home Program Explorer a User Management x

User Management

MNew F_g Ed'rtl R Delete Ej[ﬂ Refresh

MName Contact Info Last Login
Company Administratar Jul 28 201!

: o~ melliottEexample.com ]
Mary Elliott BT Jul 23 201!

Figure 80 User Management for Deleting a User

3. You will be asked to confirm deletion of the user.

& | Confirm Delete -- Webpage Dialog @

Are you sure you would like to delete the

[ ]
\!/l selected user?

o Ok | & cancel |

L

Figure 81 Confirmation Message for Deleting a User

4. Click OK to delete the user and refresh the user listing. Click Cancel to return to the user listing
without deleting the user.
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GROUP MANAGEMENT

The group management tab allows an administrator to add, edit, and delete user groups. RateManager
groups are used to assign rights to a set of users. You must create groups prior to creating users.

For example, you may have one group called Testers that can only access the Testing module and
another group called AutoLoaders that only has access to the auto product.

The Admin group is a default group and will be the only group in a new system. This group cannot be
deleted or edited or have their rights edited. All other groups must be created. The Admin group is the
only group that has access to the Security module of RateManager.

& hitp://10.100.10.100/7page=default - Oracle Insurance Insbridge RateManager 05.01

‘ ORACLE insurance Insbridge RateManager

Fle  Modules Tools  Help

[ Home | @ GroupManagemen X =

Group Management

P New [22 Edit| 3§ Delete | T Rights | ) refresh

|Group | Description |Lacation |users |

ADMIN ADMIN 1

Selected Menu Ttem:  Group Management

Figure 82 Group Management
From here, you can:

e Add a Group

e Edita Group

e Edit a Group's Rights
e Delete a Group
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Group Management Functions

Mew

New: Opens up the Add Group tab where new groups can be added to the system and
auditing levels can be set.

[z Edit | Edit: Opens up the Edit Group tab where group information can be updated.
3¢ Delete Delete: Deletes the selected group. Before deleting a group, you must remove all
members from the group.
% Rights | Rights: Opens the Rights screen where you can manage group’s rights. .
i} refresh | Refresh: Refreshes the list of groups.
group

Group Management Fields

The main body of the tab displays the groups that have been created. There are four fields in the main
body of the Group Management tab.

Group —

The name of the group.

Description — A description of the group.

Location — The location entered for the group.

Users — The number of users in this group.

ADDING A GROUP

New groups can be added from the Add Group tab at any time. There are two steps to creating a group:

e Step 1: Add the Group This step creates the group and allows you to add information about the
group. The step is performed on the Add Group tab.

e Step 2: Assigning Group Rights This step defines the permissions this group will have. This
step is performed on the Group Management tab—> Rights screen.

On the Add Group tab, there are two icons and two buttons located on the tab.

%

Required: A red asterisk indicates that this field is required. You will not be allowed to
save your entry unless all the required fields are complete.

)

Information: Click the information icon to see more information about the entry.

% save |

Save: Saves your entry. The Save option is located in the lower right hand corner of
the tab.

i -
@ Cancel

Cancel: Cancels any changes and returns you to the User Management tab. The
Cancel option is located in the lower right hand corner of the tab.
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Adding a Group

1. Navigate to Tools=>Security=>Group Management.

2. Click New to open the Add Group screen.

= — —
2 httpy//10.100.10.100/?page=default - Oracle Insurance Insbridge RateManager 05.01 I = ‘ El
ORACLE" Insurance Insbridge RateManager
Fle Modules Tools  Help
Home | 6 Group Managemen X =
| [# add Group
You have selectad to add/edit a group. This group will serve as a high level grouping for users. A particular user's rights are determined by the group(s) that they are assoristed with, The description of the group will help give clarification though it is nok required.
The required information is noted with an asterisk,
Name =
Description
Location
Email
Audit @)
|
|
—  ———

Figure 83 Adding a Group

3. Enter a Name for the new group. The name can be any combination of alphanumeric characters,
with one to fifty characters. Blanks, periods, underscores, etc. are not allowed.

4. Optionally, enter a Description, Location and Email address for the new group.

5. Check if you want Auditing for this group.

6. When you are finished, click Save. The group is added and the group list is updated. Users can
now be assigned to the group through User Management.

Auditing

Auditing is set at the group level and applies to all members of the group. If a user is assigned to more
than one group, auditing will apply to the group(s) that has it activated.
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There are three levels of auditing:
1. None - Auditing is not tracked for the group.
2. Normal — All saves, and deletes for the group are tracked.
3. High — All new items, saves, and deletes for the group are tracked.

If auditing is set to normal or high, a log is kept for changes and actions done by each member of the
group. If auditing is set to none, no logs are kept. Audit logs are displayed in the Audit tab.

Auditing is also displayed in the View History report. The View History report contains audit logs for the
users who have auditing in place. For example, if your RateLoading group has auditing set to high and
your BA group has no auditing, the View History report will only contain the actions done by the
RateLoading group. Since the BA group did not have any auditing turned on, none of their changes or
actions will be listed in either the Audit Module or the View History report. The level of auditing will
determine the detail of the View History report.

Auditing can be set for any group, including admins. If auditing is set to high for the admin group, logs are
created for adding, editing, and deleting users. Logs are also kept for adding, editing, and deleting user
groups.

Session logs are kept for all users and record when users log in and log out.
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Group Rights

Group Rights are broken into areas and products. You can allow users access to the entire system or just
certain modules. You also can restrict users from performing certain actions, such as packaging or
creating folders.

L
O]
<
%
@)
<
o

Permissions to Grant

RateManager Table Job Admin

Export Management — Allows users full access to the Table Job Management X X
tab.

RateManager Domain Admin

Product Management — Allows users full access to manage products. X X
Project Management — Allows users full access to manage projects. X X
Setup Options — Allows users to create, edit, and delete elements in
Setup Options. Users with any Domain Admin rights can perform Setup X X
Options. Users without Domains Admin rights can view only.
RateManager Universals
Variables — X
Write Access — X
Algorithms — X
Write Access — X
Fields — X
Write Access — X
Categories — X
Write Access — X
RateManager Testing
Testing Module — Allows users full access to the testing module. | X [ x| |
RateManager Package Admin
Program Export — Allows users to export programs in the Library. X X
Program Import — Allows users to import programs in the Library. X X
Release Management — Allows users to access the Releases Module. X X
NOTE: Product rights are required as well.
Database Support
Backups — Allows users to create database backups within RateManager. X X
Restores — Allows users to restore databases within RateManager. X X
Product
Variables — [ X | | |
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Write Access — X
Algorithms — X

Write Access — X
Driver Assignment — AUTO Product ONLY X

Write Access — X
Sequencing — X

Write Access — X
Output Mapping — X

Write Access — X
Fields — X

Write Access — X
Categories — X

Write Access — X
Program Management — X

Write Access — X X

Lock Admin — X

Permission to Grant Definitions

There are seven areas:

1. RateManager Table Job Admin — Allows users access to the Table Job management tab. Here
users can create, edit, delete and start table export jobs.

a.

Export Management

2. RateManager Domain Access — Allows users to manage products and projects.

a.

b.

Product Management — Users will be able to create, edit, activate, deactivate, disable,
and delete products.

Project Management — Users will be able to create, edit and delete Other domain types.
Create, edit, clear, and delete domains. Create, edit, clear, and delete projects.

Select Products — Users can select products in a project only if both Product
Management rights and Project Management rights are granted.

Setup Options — Setup options can be viewed by all users. Permissions are required to
create, edit, and delete Setup Options. Any Domain Access permission grants
permissions to work in Setup Options. The permission may be needed by users who set
naming standards, create variable messages, or manage system level constants.

3. RateManager Universals — Allows users to work in the domain type universal elements.

a.
b.

Read permissions are granted to all areas within the product by checking any element.
Write permissions are granted per element. Checking a write permission will also grant
read permission to all areas in the product.

4. RateManager Testing — Allows users to work in the Testing Module. Users are granted full
access when the element is checked.

5. RateManager Package Admin — Allows users to work with packages in the system and allows
user to input mappings. Users are granted full access when the element is checked.
a. Program Export — Allows users to create export programs on the Library tab. The

b.

permission may be needed by users who work with templates.

Program Import — Allows users to apply exported programs and templates on the
Library tab. The permission is needed by users who work with templates.

Release Management — Allows users to work in the Releases Module. Users are
granted full access when the element is checked. Users with releases rights now require
product rights as well. Programs cannot be selected for a release unless the user has
rights to the product where the program resides.
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6. Database Support — Allows users to work on Database Backups and Database Restores. Users
are granted full access when the element is checked.

7. Product — Each product will have rights separate from the other products.

a. Read permissions are granted to all areas within the product by checking any element.

b. Write permissions are granted per element. Checking a write permission will also grant
read permission to all areas in the product.

c. Package permissions are in the Program Management section. Checking a write
permission grants package permissions as well as grant read permission to all areas in
the product. Package permissions also allows for users to manage folders, move, copy,
and create revisions.

User Actions Definitions

Write Access allows users to create and edit entries. Users who do not have write access have Read-
Only access unless access to the entire module has not been granted.

o View — Allows users to view the elements that have been created.
o Write — Allows users to create, edit, copy, and delete elements.
e Package — Allows users to create RateManager, SoftRater and Global Versioning packages.

e Lock — Allows users to lock programs.

Assigning Group Rights

Edit group's rights when you want to change the applications and products users of that group have
access to.

1. Navigate to the Tools-> Security=> Group Management tab and select the group whose rights you
want to edit. Click Rights. If an email address has been entered for the group, the group's name
is hyperlinked and underlined (such as Admin). For these groups, click to the right of the name to
select.

2. This opens the Groups Rights window.
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-

3

8= Group Rights

#-& RateManager Table Job Admin - Access Granted
-8 RateManager Domain Admin - Access Granted

- RateManager Universals - Access Granted

-3 RateManager Testing - Access Granted

- RateManager Package Admin - Access Granted

-8 Database Support - Access Denied

- RateManager Auto - Access Granted

- RateManager BOP - Access Granted

- RateManager Umbrella - Access Denied

- RateManager Valuables - Access Denied

#-(3 RateManager Commercial Auto - Access Granted
-3 RateManager Automated Underwriting - Access Denied
#-(3 RateManager Directors And Officers - Access Denied
- RateManager General Liability - Access Granted
.'.-:-‘---f] RateManager Commercial Property - Access Granted
+f] RateManager Boiler And Machinery - Access Denied

¥ Save | @ Close |

Figure 84 Expanded Group Rights Management Screen

3. From here, you can assign rights to the group for the various modules of RateManager. Expand
the appropriate section and place a check next to an item to give the group access to that

section.

For example, if you wanted to allow this group to access and change sections of the Auto
product, you would expand RateManager Auto by clicking the [+] (plus box). You would then
expand each section of Auto (Variables, Algorithms, etc.) and place a check in the Write Access
box for each section where you wanted users to have access. If you only wanted to allow a group
to view a section, but not make any changes, you would only place a check next to that item and

not the Write Access box.

4. When you are finished making changes, click Save. To cancel your changes, click Close.

No Permissions to Work in Products

After a group has been added, you must assign group permissions. If you do not, users will not have

access to products.

If a user does not have access to products, they are not assigned to a group that has the proper
permissions. Have the user close out of their session prior to changing their group or group permissions.
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=45 Test LOB
S Test
L':ﬁ, Access Denied to all Products

& Universals
Figure 85 Users Denied Access to Products

EDITING A GROUP

Edit a group when you want to change the group's name, description, location or email address. Any
changes will apply to all members of the group.

Editing a Group

1. Navigate to the Group Management tab.

2. Select the group you would like to edit and click Edit. You also can edit a group by double-
clicking it. If an email address has been entered for the group, the group's name will be
underlined (such as Administrator). For these groups, click to the right of the group name to
select it or click the underlined name to send the group an email.

3. This opens the Edit Group tab.
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4 httpy//10.100.10.100/7page - default - Oracle Insurance Insbridge RateManager 05.01

| ORACLE" Insurance Insbridge RateManager

File  Modules  Tools  Help
[ Home | & Group Managemen X =

|@Edit6mup

You have selected to add/edit 2 group. This group will serve as = high level grauping for users. A parficular user's rights are determined by the group(s) that they are associated with. The description of the group will help give clarification though it s not required.
The required information is noted with an asterisk,

Mame RateLoaders x|*

Description

Create and mage rates for all areas. Product Mgmt, Testing, Package Admin,
Auto, Home, Life, BOP, Package, E and O, Cyber, Sample. Mo locking, Auto
and Home. NO DB access.

Location Chicago
Email rateloaders@example.com
Audit @)

| @ Cancel

Figure 86 Editing a Group
4. All fields can be edited. Make your changes.

5. When you have finished making changes, click Save to update the group's information and
refresh the group listing. If you do not want to save your changes, click Cancel.

DELETING A GROUP

If a group is no longer needed, it can be deleted. Only groups that currently have no users assigned to
them can be deleted.

Deleting a Group

1. Navigate to the Group Management tab.

2. Select the group you want to delete and click Delete.

3. If the group currently has users assigned to it, you will receive an error.
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IUnable ko delete group with users, Remaove the users from the group and by
YOUrF request again,

@ Ok

Figure 87 Error Message for Deleting a Group

4. Remove all users from the group by either deleting the users or assigning the users to another
group (see Editing a User) and then try your delete request again.

a Confirm Delete -- Webpage Dialog Iﬁ

Are you sure you would like to delete the

[ ]
J,/j selected group?

o Ok | 8 cancel |

e

Figure 88 Deleting Group Confirmation Message

5. If the group does not have any users assigned to it, you will be asked to confirm deletion of the
group.

6. Click OK to delete the group and refresh the group listing. Click Cancel to return to the group
listing without deleting the group.

Group Management Tab

A completed Group Management tab lists the groups, the location of the group and the total number of
members in each group.

The number of users may be greater than the total number of users. Users may be assigned to more than
one group.
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& hitp://10.100.10.100/?page=default - Oracle Insurance Insbridge RateManager 05.01
piatsne o il

ORACLE’ Insurance Insbridge RateManager

Fle  Modules Tools Help

| Home | G, Group Managemen X = @
i[9 New | [ Edait| 3 pelete | ) rights | B8 Refresh /)

|Group |Description |Location Users

ADMIN ADMIN 1

(Create and mage rates for all areas. Product Mgmt,
Testing, Package Admin, Auto, Home, Life, BOP, Package,

Rateloaders. E and O, Cyber, Sample. No locking, Auto and Home. NO Chicao z
DB access.
Test rates for all areas. This group has the option to send &

o2 a program back to rateloaders for retooling. Wasianntan D =

RateAnalysis..| Analyze the rate created and analyze the data produced.  Miami Z
Business analysts for all program and all areas.

EARS Recommendations for changes to be sent to rata analysis. New York 2

Salected Menu Ttem:  Group Management

Figure 89 Completed Group Management Tab

Viewing Group Contact Information

If you have entered any contact information for the group, you can view that information by holding your
cursor over the group name.

BA Ba group handles rate mappings.

BA@example, com
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SESSION MANAGEMENT

The Session Management tab allows an administrator to view users who currently have a RateManager

session open and

disconnect them to free up a locked element.

2 hitpy/10.100.10.100/7page=default - Oracle Insurance Insbridge RateManager 05.01
P Pag a jacj

Fle Modules Tooks  Help

|- Home _|

ORACLE" Insurance Insbridge RateManager

ﬁ Session Manageme X

 Session Management

I i %< Deactivate License | (3 License

Locks | ) Refresh

| |user

|1ssu= Date |Comments

[] Raj Patel
[[] Liesl Hovind
8 [ Mary Elliott

[] company Administrator

Jun 17 2015 1:420M 10.100,100.100-10.100.10.10-

Apr 22 2015 12:53AM 10.100.100.100-10.100.10.10-
Jul 17 2015 5:05PM 127.0.0.1-127.0.0.1-
Jul 17 2015 4:46PM 10.100,100.100-10.100.10.10-

Selected Menu Ttem:  Session Managsment

Figure 90 Session

Management

From this tab you can:

o Deactivate a License
o Display the users who have an Element or Program Lock

Session Management Functions

. Deactivate License

Deactivate License: Deactivates the license of the selected user. This will
immediately end their session.

License Locks

Edit: Unlocks a locked element by forcing an edit tab to close. Any changes made
on a forced close tab will not be saved.
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iifi) refresh | Refresh: Refreshes the list of open sessions.

Session Management Fields

The main body of the tab displays the sessions that are currently open. There are four fields in the main
body of the Session Management tab.

Checkbox — Check this box to perform an action on this session.

User — The name of the user who has a session open.

Issue Date — The time stamp that the session began.

Comments — The IP or URL of the open session.

8 — Indicates that this user has an element open. Open elements are locked to prevent users

from overwriting each other’s work. If a user has had an element locked for an extended period of
time, the session can be ended. This frees the element to be worked on by other users.

DEACTIVATING A SESSION

If a user quits RateManager without first logging out, their session may remain open. In this event, you
need to deactivate the session. Deactivating a session will also release any locked elements that this
user may have outstanding.

Deactivating a Session

1. Navigate to the Tools—> Security=>Session Management tab.

2. Place a checkmark next to each session you want to deactivate (free up) and then click
Deactivate License.

3. You must confirm the deactivation.

2 Confirm -- Webpage Dialeg Iﬁ

™ Are you sure you want to disconnect each

!‘_,/ selected session?

g Ok 3 Ccancel

M

Figure 91 Confirming a Deactivation
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4. Click OK to deactivate the session or Cancel to return to the Session Management tab.

UNLOCKING ELEMENT LOCKS

If you want information about a session lock, you can view information about who has an element locked
by holding your cursor over the In-Use icon found on the Program Details tab.

ORACLE" Insurance Insbridge RateManager -

File Maodules Tools Help

Harme Program Explarer 4 Globals - Alamere x
[ Globals - Alamere
E Mew - | || Notes @[ﬂ Refresh
Program Detail Folders -
& h: A - ilter: | Al
@ Globals eare : 13 Search Current Folder Category Filter
Field Variables Folder Detail
[ Table Variables Ef@ '5.:,5 Mame Revision  Element Type Data T
G"I—r Calcaaled Varisblen %) A BI_Pase_Rate 1 Table {4} Integer
@ Result Variables . Table (43 -
g i able nteget
Algorithms Locked By fMary Elliokt
Lock Date: Jul 17 2015 5:10PM 1 Table {13 Diecim:
fil+ Driver Assignment ) )
) Lock Dur ation;: ZZ minutels) 1 Table {4 Decim:
Constants able {4} BCiMmE
W Fltar Dulac FA rT PD PAints 1 Tahle 111 Strinn

Figure 92 User Session with Extended Locked Element

If you want the element to be released, the system administrator can end the session of the user who is
locking the element. This frees the element up, allowing other users to access the element.

NOTE: Prior to ending a user session, verify that the element has been locked for an extended period of
time. Ending a user session prior to the element being saved may result in the user’s updates not
being implemented.

Deactivating a User Session

The License Lock option displays the details of the element lock in Session Management.
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ORACLE" Insurance Insbridge RateManager

File Modules  Tools Help

Home 35 Session Managem X

Session Management

: < Deactivate License License Locks E’[ﬂ Refresh :

Usear Issue Date Comments

|:| Raj Patel Jul 17 2015 4:46PM 10.100,100.100-10.100.10.10-

|:| Lies| Howvind Apr 23 2015 12:53AM 10.100,100.100-10.100.10.10-
8 Mary Elliott Jul 17 2015 5:05FPM 127.0.0.1-127.0.0.1-

|:| Company Administrator  Jul 17 2015 4:46PM 10.100,100.100-10.100.10.10-

Figure 93 Ending a User Session with a Locked Element

1. To view how long this user has had a lock on the element, place a check mark in the box next the
user.

2. Click License Locks. A popup window is displayed indicating which element the user has locked
and for how long.

. T
@ Locked Items by User — Webpage Dialog ﬂ
MName: Example Local Table Variable
Type: Table Variable
Line: Auto
Folder: Texas
Lock Date: Sep 28 2015 4:22:49:497PM
Lock Duration: 574 minutes
3% Close
L ,

Figure 94 Locked Items by User

3. The Locked Items by User box is for information only. No action can be performed here. If you
need free this element and end this user’s session, you can deactivate the session.

4. Close out the Locked Items by User popup.
5. To deactivate the session, place a check mark in the box next to the user.
6. Click deactivate license.

7. Click OK to confirm to disconnect, click Cancel if you do not want to disconnect the user session.
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The Database Module can be found on the Tools menu. The Database module is where you manage
database functions from within RateManager. There are two options you can select:

e Backups — used for creating and restoring database backups.

e Updates — a listing of available updates for this version of RateManager.

BACKUPS

The backup tab located in the Database option of RateManager allows an administrator to create and
restore backups of the RateManager database. You must be a Disk Admin to perform backups or
restores.

2 hitpy//10.100.10.100/?page=default - Oradle Insurance Insbridge RateManager 05.01

ORACLE" Insurance Insbridge RateManager
Fle  Modules Tools  Help

[ Home | & o8 Backups x =
| ¥ DB Backups

: [ Create Backup | [ Restore Backup | & Delete Backup(s) | @3 Refresh :

| BifType |Mame |Location |Date [size |

Selected Menu Item: Datzbase Management

Figure 95 Database Backups
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DB Backups Functions

[ Create Backup | Create Backup: Creates a backup of the currently selected database.

(M Restore Backup | Restore Backup: Restores the currently selected database.

3 Delete Backup(s) | Delete Backup: Deletes the currently selected database.

i) refresh | Refresh: Refreshes the list of backups.

DB Backups Fields

The main body of the tab displays a list of the current backups. There are six fields in the main body of
the DB Backups tab.

Checkbox — Check this box to perform an action on this backup.
Type — The type of backup performed, either Maintenance or Error.
Name — The name of the database being backed up.

Location — The location of the backup.

Date — The time stamp of the backup.

Size — The size of the backup.

CREATING A BACKUP

If you need assistance implementing logic or an error is found in the system, a backup or snapshot can
be made of the database. That snapshot can then be sent to Oracle Insurance Support, where it will be
restored. Our support personnel and analysts can then work from the snapshot to determine the best way
to implement logic or diagnose a problem.

e The default db backup location should be set on the Preferences screen prior to creating a
backup.

e The backup location has to be a share. The database instance should not be on the same
machine where RateManager was installed.

e The SQL Server Windows service needs to be running as a user that can access the share.

e The database user needs to be in the diskadmin fixed server role.

Creating a Database Snapshot

1. Navigate to the Tools—=> Security>Backups tab.
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2. Click Create Backup. This opens the RateManager Backup window.

& S
RateManager Backup

DataBase:

Backup Reasom: | Maint V|

Backup Location: | C:\Insbridge\Backup

Drescription:

agf Backupl € Close |

b

Figure 96 Creating a Backup

3. Select the database you want to backup, either security or rm (RateManager). When creating a
backup to send to Oracle Insurance, select your rm database. The Name on the screen defaults
to the actual name of the database in SQL Server.

4. Select a reason for the backup, either Maint (maintenance) or Error.

5. Enter alocation where the backup should be stored. This location should be a network share. If a
backup location has been entered in Preferences that location is displayed. Verify the value
entered is a valid value.

6. Click Backup to start the backup process.
7. You will be informed when the backup operation is complete.

& e

v’ Backing Up Database..... Start{6:21:48 P.M.) Stop(6:31:50 P.M.)

The database backup has successfully been created. To view a listing of backups
created, please browse to the location using your file explorer.

€ Close |

L.

Figure 97 Successful Backup Message

8. Your backup should be listed on the backups tab. If your backup is not listed, click Refresh to
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refresh the screen.

Sending to Oracle Insurance

If necessary, you may need to send it to Oracle Insurance Support for assistance.

1. Once the backup is complete, you can browse to the backup location you entered in Step 5. Sort
the listing by Date Modified to quickly find the backup you just created.

2. If necessary, Oracle Insurance Support will instruct you how to handle the database handoff.

RESTORING A BACKUP

1. If there’s a backup that needs to be restored, highlight the backup you want to restore and click
Restore Backup. A warning message is displayed.

NOTE: If you require assistance or are unsure of whether or not to restore a backup, please log a
Service Request using My Oracle Support at https://support.oracle.com/.

B 3]

RateManager Restore

Are you sure you want to replace the current database’s contents with the selected
backup on disk? {The current database's name will not change)

TBRM_A1" database from "1 /162014 3:54:26 PM'.

q? F'.estu:rrel 3 Close |

L

Figure 98 Restore Warning Message

2. Click Restore to restore the backup or Close to return to the previous screen.
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DELETING A BACKUP

If there’s a backup that you no longer need, you can delete it. Make sure this is the action you want to
take.

1. Highlight the backup(s) you want to remove. More than one backup can be deleted.
2. Click Delete Backup(s) from the top bar menu. A warning message will be displayed.

3. Click OK to remove the backup(s) or Cancel to return to the previous screen.

a Confirm Delete -- Webpage Dialog Iﬁ

Are you sure you would like to delete the
selected backup(s)?

w? Ok | # cancel |

L

Figure 99 Deleting a Backup
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Permissions Error

If you do not have the proper permissions to run database backups or restores, you will receive an error
message.

Error executing script! The configured IBRLU database user must have
dbowwner rights to the IBRM, ISR, and IE_CLIEMT database to execute the
scripts via the interface, Please conkact your database adminiskratar, Error
Details: Cannot Execute Slebb Command: Invalid column name 'DEPEN',

Figure 100 Permissions Error Message

Database Backup Location Error

If you do not have a proper backup location set up, either on the server where your databases are located
or a network share, you will receive an error message.

B =)

y’ Backing Up Database..... Start(2:02:24 P.M.) Stop(2:02:25 P.M.)

Unable to backup database. If the database that you are backing up is not located on
the RateManager server, please contact your system admin for network share to use
for backup purposes. : Cannot Execute SQL Command: Canmot open backup device
'IBRM_AI 07282015 120226

(C:\Insbridge\Backup\IBRM_AI_07282015_ 120226.dat)’. Operating system error 3
(The system cannot find the path specified.). BACKUP DATABASE is terminating
abnormally. Changed database context to 'TBRM_AI'. If the problem continues to
occur, please contact your system admin for assistance.

E) Close |

Figure 101 Backup Location Error Message — Location Not Found or Shared

In Figure 71, a backup location was entered (C:\Insbridge\DB_Backup...), but the location was not found.
Entering a location in the Preferences area of RateManager does not create the location. The location
must be in place prior to the backup and permission given to the Insbridge user to access.

If the backup location is outside of the SQL Server backup location, that location must be created prior to
the backup being performed.
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When a shared location on the server where the RateManager databases are located is entered, the
backup request can be performed.

This error may also be a result of a typo. Locations must match exactly.

B =)

V’ Backing Up Database..... Start(1:58:11 P.M.) Stop(1:58:11 P.M.)

Unable to backup database. If the database that you are backing up is not located on
the RateManager server, please contact your system admin for network share to use
for backup purposes. : Cannot Execute SQL Command: Cannot open backup device
'IBRM_Alamere 07282015 _125814(C:\PROGRAM
FILES|ORACLE\INSBRIDGE|Wehs|RM4

\Workfiles\ Mappings\IBRM_Alamere_07282015_125814.dat)’. Operating system
error 3{The system cannot find the path specified.}). BACKUP DATABASE is
terminating abnormally. Changed database context to "IBRM_Alamere’. If the
problem continues to occur, please contact your system admin for assistance.

€) Close |

Figure 102 Backup Location Error Message — Location Not Valid

Check the location where the backup is attempting to place the file. Any location within the Insbridge
application should not be used. The location must be shared and access must be given to the Insbridge
user.
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DB UPDATES

The database module also contains an update tab that lists the available updates for this version of
RateManager.

From this tab you can view the update script or execute the update. Updates cannot be deleted.

NOTE: Only a database owner (db_owner) can perform updates. If the Updates tab or any execute
buttons are not visible, you do not have access to the database.

ORACLE" Insurance Insbridge RateManager

Fle Took  Help

? Home DB Updates ®

3 DB Updates

Jg, Execute Update Script Q Cpen Update Script EI Save Update Script to File Eﬁ Refresh _
Show updates for:] IBRM [ ]

Senpt Release Date Database Status
wiD5.00.01.00 12/15/2015 IBRM
w05.00.00.00 4/1/2015 IBRM
w04.05.00.00 11/1/2014 IBRM
wO4.08.00.00 4/1/2014 IBRM
wi4.07.00.00 3/1/2013 IBR.M

w4 . 06.00.00 3/1/2012 IBEM
vO4.05.01.00 11/1/2011 IBRM
w04.01.00.00 11/15/2010 IBRM

wi4.00.0.00 3/10/2010 IBEM

w3.13.0.00 12/15/2009 IBRM

w03.12.0.00 4/20/2009 IBRM

w3.11.0.00 11/30/2008 IBRM

w(13.10.0.00 8/31/z008 IBR.M

w032.9.0.00 5/19/2008 IBRM

vil3.8.0.00 6/7/2007 IBRM

Figure 103 DB Updates
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DB Updates Functions

L& Execute Update Script | Execute Update Script: Runs the selected update script.

Open Update Script: Opens the selected update script in a

- .
<83 Open Update Seript window where it can be viewed or copied.

Save Update Script to File: Allows you to save the update script

(5 Save Update Seriptto File to your local hard drive or network.

iifi) refresh | Refresh: Refreshes the list of updates scripts.

Show Updates for: Allows you to select the update scripts you

Showr updates for:| IBRM b .
want to view, IBRM, IB_CLIENT, or Reports.

DB Updates Fields

The main body of the tab displays a list of database updates. There are four fields in the main body of the
DB Updates tab.

Script — The name and version of the script.
Release Date — The date of the release for the script.
Database — The type of database the script is for, IB_CLIENT or IBRM.

Status — The status of the update. Current will be on the line of the most current database.

EXECUTING UPDATE SCRIPT

Database updates can be done on the IBRM, IB_CLIENT and Reporting databases. If you log into
RateManager and Tools is the only option, you must perform a database update.

On the Updates tab, the current version will be highlighted and the status will be Current. The updates
below the current version will be grayed out. These updates cannot be run again. You will receive an
error message if you attempt to run a lower version update. Any version update above the current version
will also be grayed out but will be available for executing after the preceding update has been run.

Updates have to be installed sequentially, meaning if you are on Version 4.0, you must run the 04.05
update, the 04.06 update, the 04.07 update and finally the 05.00 update. If you attempt to run an update
that is more than one level above the current version, you will receive an error message.

NOTE: Itis strongly recommended that database updates be performed in RateManager.

1. Navigate to Tools>Database—>Updates.
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2. The DB Updates tab is displayed. Select the database you want to view from the Show updates
for drop down. The database updates for your selection will be listed. The last column, the
Status column, shows you which update is the Current one installed.

ORACLE" Insurance Insbridge RateManager

Fle Tooks  Help

| Home - DB Updates ®

(7} DB Updates
J:.". Execute Update Script g Cpen Update Script El Save Lpdate Script to File E}ﬂ Refresh
Show updates for:| IBRM |
Scnpt Release Date Database Status
v05.00.01.00 12/15/2015 IBRM
w05.00.00.00 4/1/2015 IBERM
wO4.05.00.00 11/1/2014 IBRM
wi4.08.00.00 4/1/2014 IBRM

w407 .00.00 3/1/2013 IBR.M

w4 06.00.00 3/1/2012 IBRM
vD4.05.01.00 11/1/2011 IBRM
wi4.01.00.00 11/15/2010 IBRM

w04.00.0.00 2/10/2010 IBR.M

wi33.13.0.00 12/15/2009 IBRM

w03.12.0.00 4/30/20039 IBRM

w3.11.0.00 i1/30/2008 IBRM

v12.10.0.00 8/31/2008 IBR.M

02.9.0.00 5/19/2008 IBRM

vil3.8.0.00 6&/7/2007 IERM

Figure 104 Available Updates

3. There are two ways to execute an update:
a. Directly in RateManager
b. In SQL Server

Directly in RateManager

This is recommended way to update a database. It is recommended that you start by selecting the update
showing Current. This will assure that the database showing as Current will have all possible updates.

4. Highlight the update you want to run.

5. Click Execute Update Script. A warning message is displayed.
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6. Click OK to run the update or Cancel to return to the previous screen.

7. Do this for the IBRM, IB_CLIENT, and Reporting database. The Reporting database must be run
last.

8. After the scripts have been run, reload the session. Click File>Reload. The status should show
current and the full RateManager menu should be displayed.

& Confirm Update -- Webpage Dialog lﬁj

. Are you sure you want to replace the
current database's contents with the
= selected release script on disk?

2@ Ok | & cancel |

Figure 105 Updating Scripts in RateManager

In SQL Server Using Query Analyzer

This method should be performed by a database administrator. You must have access to the SQL
Server instance where the RateManager databases are located. No warning message is displayed if
you execute scripts in the wrong order. You must know the name of the databases you are updating. If
you are unsure, do not use this method.

WARNING: Running updates in a non-sequential order may result in severe database errors. No error
messages will be displayed if you run updates in an incorrect order.

1. In RateManager, highlight the update you want to run. If you are going from a much lower version
of RateManager, you may have to save multiple files for each database.

2. Click Save To File. Your computers dialogue box will be displayed. Save the file to a location of
your choice. For IBRM scripts, it is recommended that you rename the file to
usp_IBRM_RO(version number).sql. For example the V5.01.00 update would be:
usp_IBRM_R50.01.00.00.sql. For IB_CLIENT scripts, it is recommended that you rename the file
to usp_IB_CLIENT_RO(version number).sql. For example the V5.01.00 update would be:
usp_IB_CLIENT_RO05.01.00.00sq|.

3. Open Query Analyzer in SQL Server.

4. Open up the DB script updates from the download file. You can open in any program you want,
such as Notepad.

5. Select the IB_CLIENT database. Create a new query.
6. Copy the DB script you opened to the query screen.

7. Execute the script. Any messages will be displayed in the lower portion of the screen. Fix any
errors before you continue.
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8. Updates must be run in sequential order.
9. Do the same for the RM database.
10. The Reporting database must be run last. Run the update for Reporting.

11. After the scripts have been run, return to RateManager. Click File>Reload. The status should
show current and the full RateManager menu should be displayed.

Open Update Script

To view the update script prior to execution, highlight the update you want to view. Click Open Update
Script. The update script is displayed in a separate screen.

5]

RateManager

if not exists (SELECT 1 FROM INFORMATION SCHEMA.TABLES WHERE TABLE SCHEMA="dbo' AND
TAELE WAME = 'TAELE MANAGEMENT JOES')
begin

CREATE TAEBLE [dbo].[TAELE MAWAGEMENT JOES] (
[ID] [nchar] (10) HOT NULL,
[HAME] [nvarchar] (50) HULL,
[TYPE] [int] HOT NULL,
[ADTO] [int] NOT HULL
[ISHE nra h = =

Figure 106 Script Viewer

e

134



Chapter 6 — Database

REQUIRED UPDATES

If you log into RateManager and Tools is the only option, you must perform a database update.

Please navigate to Tools—>Database—>Updates (Tab) and run the necessary updates. You will not be
able to continue until you run the updates.

e@|@ http://win1100000/RM/Main/MainPage.aspxpage=defailt p-c ” [ Oracle Insurance Insbridge ... ok Lt
ORACLE’ Insurance Insbridge RateManager R £15 0100 Subsciber: alnmere User: €ompany Administrator
e | Toos | Help
|8 Database » 5P Backups =1t

% Updates

7| DB Update =

o Please run the update scripts on the database.

Figure 107 Please Run Update Scripts
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CHANGING YOUR PASSWORD

You can change your password at any time. RateManager does not prompt users to change their
passwords.

It is recommended that you change your password periodically to prevent other users from logging in and
making changes using your user ID.

1. From the top bar menu, select Tools and then click Change Password.

ORACLE’ Insurance Insbridge RateManager
File Modules | Tools Help

Home Change Password

5] Preferences

2. This opens the Change Password window.

[ a Security Iﬁ1

Change Password

Old Password TYTIII T
Mew Password T TTTIT

Confirm Password seeseses)

w# Update | & Close |

b

Figure 108 Change Password Screen

3. Enter your current password in the Old Password text box and enter your new password in the
New Password and Confirm Password text boxes.

Your password must be at least six, but fewer than twelve, alphanumeric characters.

4. When you are finished, click Update to update your password. The next time you log into
RateManager, you will need to use your new password.
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PREFERENCES

Users with Administration rights can access all the options found on the Preferences screen. The
Preferences screen allows administrators to manage settings, and set Home Page options.

Non-administrators only have the option to set their Home Page Snaps. Please see the RateManager

User Guide.

SYSTEM SETTINGS

Administrators can edit system settings at any time from the Preferences screen. Changes will take place
after the user sessions have been ended.

Changing System Settings

1. Select Tools>Preferences. This opens the Preferences window.

2. Select System. This option is displayed only if you are an administrator.

el

|‘
.‘,_V P
|

- Settings
- User

System Settings

~Home Page
E-Administrator

- System "
| Impact A is Messagi
- Migrate Worlfiles 5]::;&,, iz A

SoftRater Server :

Tzblz Mznagemeant Masszging
Server {JAVA Only):

WarkFiles Share Folder Location:

DB Backup Sharz Folder
Location:

Use Insbridge Com+ Admin:
Enforce Relesss Packaging:
Batch Package Thresds:
Minimum Login User ID Length:
User must change password:
Show Qverride Date Mask:
Allow Datz Type Change:

Inactive Session Time Oub:

Batch Results with NewLine:

Online Help Sarver:

Insbridge Configuration File Path: |C:\F'ROGRJ\M FILES‘\ORACLE‘JNSBRIDGERFRAMEWORK‘H.S.O‘JrI

w

7]
<]
[&]
i
g

| {Sacure Channel) D

W
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| {Secure Channel) D

J___E-
<]
H
B

True | ¥

ol
o
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FICI]

o
:
o)

True :ﬂ
Trua ﬂ

False| v

e

o Save | @ Cclose |

Figure 109 Preferences Settings
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3. Make any necessary changes.

4. When you are finished, click Save to update your settings. If you want to changes to take place
immediately, you may have to end all user sessions.

System Setting Options

From the Preferences screen, you can set pathways, define servers, and set preferences for a variety of
options in RateManager. Most of these options are set at installation but can be updated at any time.

Insbridge Configuration File Path

The path of the configuration file found in IBFA. This pathway must match the IBFA path. You may need
to change this path if you have changed the path in IBFA. Please contact Insbridge support for further
information.

It is strongly recommended that you leave the default.

Impact Analysis Messaging Server

Impact Analysis is set up to run on the same server where RateManager is located. The Impact Analysis
Messaging Server setting allows for select SoftRater instances to be used when running scenarios
through Impact Analysis. Only an Insbridge SoftRater Server (IBSS) utilizing an Oracle database can be
entered. When an IBSS instance utilizing an Oracle database is entered, the environments on the
instance will populate Impact Analysis and Impact Analysis will query against the Oracle database. If an
IBSS utilizing another database type is entered, no environments will be populated.

If localhost is used, Impact Analysis runs queries against the disk where batch files are stored.
Select the SoftRater, .NET (SoftRater for Windows) or Java (SoftRater for WebLogic, WebSphere or

JBoss) and enter the IBSS URL. The default value is to remain on the RateManager server.

SoftRater Server

If you need to rate on another server, you will have to change server locations here. It is strongly
recommended that you leave the default.

Table Management Messaging Server (JAVA ONLY):

Table exports require a Java instance. If you want to use the Table Management feature, you must enter
an Insbridge Java server location. Format requires the port number being used but does not require
preceding slashes. DNSname:port or IPAddress:port For example, if you wanted to use a WebLogic
IBSS instance the format would be: 10.100.10.100:7001.

If you do not enter a valid Insbridge Java server location, table exports will not work.
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Work Files Share Folder Location

A shared WorkFiles location allows for multiple instances of RateManager to share the same WorkFiles.
The Insbridge server and the shared location must be on the same domain. The Insbridge user must be
on the domain also. If the field is blank, the default WorkFile location is used.

For instructions on setting up a WorkFiles Share Location, please see the Insbridge WorkFiles Installation
Guide on the http://www.oracle.com/technetwork/documentation/insurance-097481.html

DB Backup Share Folder Location

When you make backups of the RateManager database, you can specify the location of the backup file. If
the location is local, use a local path. If the location is not local, you must be a disk admin to change.

If the database is on a remote server, a share is needed for the backup location. The Insbridge user must
have write access to this location as well.

Use Insbridge Com + Admin

This setting must always be true. If there is a conflict, please contact Oracle Insurance support.

Enforce Release Packaging

When set to False, a release is not required in order for users to create a SoftRater (full) package. False
is the default setting.

If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to
create a SoftRater (full) package in the Program Explorer module, a release must be created in the
Releases area first. This release must have the program added to it and be unlocked. When the user
creates the SoftRater package in Program Explorer, they will have the option to select the Release they
want this package to be placed into. If there is no release, or no release that contains that program and is
unlocked, then the user will be able to do RateManager (local) packages only.

Batch Package Threads

RateManager allows you to change how many threads are used. Threading enables a process to finish
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor
systems, using multiple threads enables the operating system to assign the threads to different
processors.

In addition, the Framework Administrator also enables you to change the administrator email address for
each client. When a process fails, an email will be sent to the person who initiated the process, as well as
to the administrator email addresses listed for the client of that process.

NOTE: Before changing the number of threads, you should consult with your system
administrator. Setting the number too high can result in poor performance or even a
system crash. If you are unsure of how many threads to use, set the number to 1. For
single processor systems, Oracle Insurance recommends a maximum of 2 threads.
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Minimum Login User ID Length

This is the minimum number of characters required for a user ID.

User must change password

This where you set the number of days before a user is required to change his/her password. This setting
will only be active when you elect to have users change their password on the user setup screen.

Show Override Date Mask

If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this
field will not be visible.

Allow Data Type Change

The type of data associated with a parameter. RateManager supports three (decimal, integer and string)
data types for variables and fields and a fourth (date) for fields and result variables only.

Setting this option to True allows RateManager users change the data type of a variable or field. Setting
this option to False does not allow users to change data types.

Inactive Session Time Out

This is the amount of time that a user sits inactive before being automatically logged out of the system.

Batch Results with New Line

Allows batch results to go to a new line instead of forming one continuous string. A True setting places a
carriage return between result files. A False setting results in one continuous string without a break.

Online Help Server

Online help is installed with RateManager. This setting is the default server name where RateManager
currently resides. Either a server name or an IP address can be entered here. If needed, you can change
the name of the server. For example, if the machine name is not the same as the host name, you may
need to change the name in order for online help to function.

My Recent List

My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the
user recently worked on. You can set the maximum number of elements to display in a snap. The default
is for the snap list to be limited to 10.
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Default Proxy Script Location

The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog
Feed snap. This setting can be used for RSS feeds.

Change Control

If change control is on, it is mandatory for users to enter a change control entry and justification to any
element or program when it is revisioned. If change control is off, the option is not presented.

Maximum Amount of Simultaneously Opened Tabs

Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you
allow users to have opened in RateManager. The default is 15.

Debug Report Format

Select the debug report format to be used in the Test Program section of RateManager. Debug reports
can be a single report format, where the entire report is listed out or in a summary report format where
information is contained in sections that can be expanded and collapsed. Summary report format may be
useful if large programs are to be run. This setting can be updated at a later time.

Default Naming Standard

Select the Naming Standard to be applied system. If a Naming Standard is not needed system wide, clear
the field. The default is for the system default to be used. Please see Naming Standards for more
information.

Enable Worksheet for Test Case Editor

Select true to have the option to create a rating or calculations worksheets in Test Case Editor. Select
false and the option to create a worksheet in Test Case Editor is not presented. Please see Worksheets
for more information.

Product Configuration Server

Enter in the location of Product Configuration. Product Configuration (PC) is a business modeling tool that
allows you to create a reusable hierarchical schema that defines your insurance products. An entry in this
field enables the PC domain type and allows for updates to be brought in to RateManager. Leaving the
field blank disables the PC domain type.

Enforce Product Configuration
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Select true to have the product configuration domain type be the only option in Program Explorer. Setting
to true removes the RateManager domain type and all content from being displayed.

Reporting Threads

Enter the number of threads to be used for reporting. The field is initially blank and the system will default
to a single thread. Entering a value higher than the default may result in better system performance.
Reports may run faster as you approach an optimal thread count. The thread count is based on the
hardware capabilities (number of CPU cores and memory) of the server. A high thread number does not
necessarily warrant a faster performance. You should analyze how much data you need to process and
the capabilities of your server to get to an optimal number. A value does not have to be set.

Global Versions Report Threads

Enter the number of threads to be used for global version reports. The field is initially blank and the
system will default to a single thread. Entering a value higher than the default may result in better system
performance. Reports may run faster as you approach an optimal thread count. The thread count is
based on the hardware capabilities (humber of CPU cores and memory) of the server. A high thread
number does not necessarily warrant a faster performance. You should analyze how much data you need
to process and the capabilities of your server to get to an optimal number. A value does not have to be
set.
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MIGRATING FILES

This feature migrates work files from a previous version of RateManager to the current release. Work files
are rating, pricing, mapping, and template files used in various areas of RateManager such as Impact
Analysis, Library, and Testing. Migrating files allows users to access work files that were available in a
previous release of RateManager. If you do not migrate work files from previous versions, users will not
have access to them.

Work files should be migrated after the upgrade has been run.

Prior to migrating files, please create backup copies of the files to be migrated. This requires access to
the server were RateManager has been installed.
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Figure 110 Location of WorkFiles

NOTE: Prior to migrating files, you may want to create backup copies of the files to be migrated. This
requires access to the server were RateManager has been installed.
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Manual Migration

A manual migration must be performed under select circumstances. All versions must be on the same
server. If you are working with two separate machines, you must perform the migration manually. A
RateManager migration will perform a copy and paste of the WorkFiles on the server then the previous
versions WorkFiles will be deleted. This means that the version you select to be migrated will have the
WorkFiles deleted from the server. This cannot be reversed. Make sure this is the action you want to take.
If you have more than one version where you want to migrate files, you will have to perform the migration
on the server. DO NOT USE RATEMANAGER TO MIGRATE MULTIPLE VERSIONS. Only one version
can be migrated. If you attempt to migrate more than one version, you will write over any data with the
version that you are migrating. For example, if you migrate version 4.0 and then migrate 4.01, any
information from 4.0 will be written over with the information from 4.01. If you have more than one version
to migrate, you must perform the migration directly on the server.

Migrating files is a two-step process.

Step 1: Locate the previous workfiles to be migrated.

The location of the files to be migrated and the exact file name will depend upon what version of
RateManager you want to migrate. There are four possible locations.

For Release 3.12 and earlier:

e File Name: WorkFiles
e Location: \Program Files\InsBridge\Webs\RMxxx\WorkFiles

Where xxx is the version number, i.e. 310, 311, 312
For Release 3.13:
o File Name: Workfiles
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM313\W orkfiles
For Release 4.0 To 4.8:

e File Name: Workfiles
e Location: \Program Files\Oracle\IGBU\Insbridge\Webs\RM4\W orkfiles

For Release 4.9 or later: Use only if moving to new server.

e File Name: Workfiles
e Location: \Program Files\Oracle\Insbridge\Webs\RM4\W orkfiles

Copy all work files for every version to be migrated and store in a safe location. In the unlikely
event that an error with the migration occurs, you will have backup files that you can place directly
in the RateManager (RM4) Workfiles location or restore to the previous version.

Step 2: Place in the new workfiles location.

New File Location:

e File Name: Workfiles
e Location: \Program Files\Oracle\Insbridge\Webs\RM4\W orkfiles
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WARNING: Workfiles should be migrated after the initial upgrade has been run. Running the Migrate
function after users have accessed the system may result in newer Workfiles being

overwritten.

Performing the Migration in RateManager

This migration process moves rating, pricing, mapping, and template files from a previous version of

RateManager to the current RateManager version. You can select one version that you want to migrate. If
you have more than one version to migrate, you must perform the migration manually. Please refer to the
Installation and Upgrading Guide for instructions.

1. Select Tools>Preferences>Administrator>Migrate Workfiles.

5 . )
Preferences
-I-Settings . . ; .
b User This option is used to transition test-case work files from the
previous Rate Manager installation to the current
¢ =Home Fage
i--.i\_dministratur | Select to start migration ... |
- System
----- Migrate Workfile
£ >
o Save | @ Close |

Figure 111 Migrating Work Files

2. Click the Select to start migration button. A separate screen is displayed.

3. RateManager determines the possible version to migrate. Select the version you want to migrate.
Only work files from the selected version will be migrated.
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[ a -- Webpage Dialeg ﬁ1

. Migrate Work Files
Migrate files from:

This migration process will move Rating, Pricing, Mappings and Templates from a previous version of
RateManager that you selected to current RateManager. This process could take 2 few minutes to
complete, An alert box will zppear when the process has completed.

Miglﬂtel @ Close |

L

Figure 112 Selecting Workfiles to Migrate

4. Click Migrate.
a -- Webpage Dialeg Iﬁ

- Migrate Work Files

. Al current Rating, Pricing, Mapping and Template files wil be deleted in order
!_-/l to migrate the files from the previous RateManager. Do you want to
. continue?

2’ Yes |@ Ho |

L

Figure 113 Confirming a Migration

5. Click Yes to migrate. If you are unsure about the action you want to take, click No to stop the
migration process.

6. The migration will begin. This process could take a few minutes to complete. When all files have
been migrated, an information notice will be displayed.
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The process has campleted,

Ly,

Figure 114 Successful Migration

7. Click OK to close the screen.

Verifying Migrated Files in RateManager

Migrated files are available in the same areas.

To verify that work files from a previous version have been migrated, enter an area where these files

would be used, such as the Library tab.

The tab refreshes with all available files. Your files from previous versions will be listed.

NOTE: Previous export files will not be migrated. Previous export files are not recognized in current

releases of RateManager.

Verifying the File Migration in the Server

Migrated files will be moved from previous releases into the updated RM4 Workfiles location.

B custom

G( )v| ~ 10101010400 ~ Program Files ~ racle ~ Insbridge = Webs = RM4 ~ Workfles ~ Mappings = Input = Cuskom

> |i83 [ search custom

Organize v  Includeinlbrary =  Sharewith *  New Folder

Controls Al Name - Date modified Type |S|ze

Css
__| Auto Training Manual Tables xslt 1§9/2011 10:13 PM XSLT File 1KB
Images

Includes

Licenses

#

Logindpps
Main

#

Modules

#H

Script
Utils
videos

S New Workfile Location

al

Exports
a Mappings
= Input

. Custom

Library
Output
Pricing
Rating
Reports
Templates

= v'm\_ ﬂ

litem

Figure 115 Verifying File Migration at Server Level
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You can verify that files have been moved by looking in the
\Program Files\Oracle\lnsbridge\Webs\RM4\W orkfiles folder.

Migration Messages

If the migration has already been done, a message is displayed.

A -- Webpage Dialog

™ The files don't exist any mare, You may have
already run the migration process. Unable ko
move directories, Thread was being aborted,

o Ok

Figure 116 Migration Already Performed

If the migrating tool does not find any files to migrate, a message is displayed.

2 -- Webpage Dialog

™ Could naot find a part of the path ' PROGRAM
FILES|ORACLEYIGEL INSERIDGE Webs\RM313
VwhorkfilesiRating'. The process has completed,

o Ok

Figure 117 No Files to Migrate
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VIEWING VERSIONS

The Version option in the Tools section of RateManager allows an administrator to view the version

information for the current system.

To View a Version

1. From the Home tab, select Help>RateManager Version.

ORACLE" Insurance Insbridge RateManager

File Modules  Toals Help |

Home

RateManager Help

RateManager Yersion

2. This opens the Version Listing window.

About RateManager X

'IBRE 05.01.00 m]wmﬂIS_ﬂadEMfghﬁm-VEﬁm Listing

IBERM

IB_CLIENT

RM.CLL

IBFA

Insbaidge ERC Accelarator

v05.01.00.09
v05.01.00.00
05.01.00 {x64)
05.01.00 {x64)
1000

Ok

|

Figure 118 Version Listing

3. The latest version information including RateManager release number, IB Client schemas and

build is displayed.

149



Support

CONTACTING SUPPORT

If you need assistance with an Oracle Insurance Inshridge Enterprise Rating System product, please log
a Service Request using My Oracle Support at https://support.oracle.com/.

Oracle customers have access to electronic support through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Address any additional inquiries to:

Oracle Corporation

World Headquarters

500 Oracle Parkway
Redwood Shores, CA 94065
U.S.A.

Worldwide Inquiries:
Phone: +1.650.506.7000
Fax: +1.650.506.7200

oracle.com
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Appendix

COUNTRY CODES

NAME ABBR
AFGHANISTAN AFG
ALBANIA ALB
ALGERIA DZA
AMERICAN SAMOA ASM
ANDORRA AND
ANGOLA AGO
ANGUILLA AlA
ANTARCTICA ATA
ANTIGUA AND BARBUDA ATG
ARGENTINA ARG
ARMENIA ARM
ARUBA ABW
AUSTRALIA AUS
AUSTRIA AUT
AZERBAIJAN AZE
BAHAMAS BHS
BAHRAIN BHR
BANGLADESH BGD
BARBADOS BRB
BELARUS BLR
BELGIUM BEL
BELIZE BLZ
BENIN BEN
BERMUDA BMU
BHUTAN BTN
BOLIVIA BOL
BOSNIA AND HERZEGOWINA BIH
BOTSWANA BWA
BOUVET ISLAND BVT
BRAZIL BRA
BRITISH INDIAN OCEAN TERRITORY 10T
BRUNEI DARUSSALAM BRN
BULGARIA BGR
BURKINA FASO BFA
BURUNDI BDI
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NAME ABBR
CAMBODIA KHM
CAMEROON CMR
CANADA CAN
CAPE VERDE CpPVv
CAYMAN ISLANDS CYM
CENTRAL AFRICAN REPUBLIC CAF
CHAD TCD
CHILE CHL
CHINA CHN
CHRISTMAS ISLAND CXR
COCOS (KEELING) ISLANDS CCK
COLOMBIA CcoL
COMOROS COM
CONGO COG
COOK ISLANDS COK
COSTARICA CRI
COTE D'IVOIRE CIvV
CROATIA (local name: Hrvatska) HRV
CUBA CUB
CYPRUS CYpP
CZECH REPUBLIC CZE
DENMARK DNK
DJIBOUTI DJI
DOMINICA DMA
DOMINICAN REPUBLIC DOM
EAST TIMOR TMP
ECUADOR ECU
EGYPT EGY
EL SALVADOR SLV
EQUATORIAL GUINEA GNQ
ERITREA ERI
ESTONIA EST
ETHIOPIA ETH
FALKLAND ISLANDS (MALVINAS) FLK
FAROE ISLANDS FRO
FlJI FJI
FINLAND FIN
FRANCE FRA
FRANCE, METROPOLITAN FXX
FRENCH GUIANA GUF
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NAME ABBR
FRENCH POLYNESIA PYF
FRENCH SOUTHERN TERRITORIES ATF
GABON GAB
GAMBIA GMB
GEORGIA GEO
GERMANY DEU
GHANA GHA
GIBRALTAR GIB
GREECE GRC
GREENLAND GRL
GRENADA GRD
GUADELOUPE GLP
GUAM GUM
GUATEMALA GTM
GUINEA GIN
GUINEA-BISSAU GNB
GUYANA GUY
HAITI HTI
HEARD AND MC DONALD ISLANDS HMD
HONDURAS HND
HONG KONG HKG
HUNGARY HUN
ICELAND ISL
INDIA IND
INDONESIA IDN
IRAN (ISLAMIC REPUBLIC OF) IRN
IRAQ IRQ
IRELAND IRL
ISRAEL ISR
ITALY ITA
JAMAICA JAM
JAPAN JPN
JORDAN JOR
KAZAKHSTAN KAZ
KENYA KEN
KIRIBATI KIR
KOREA, DEMOCRATIC PEOPLE'S REPUBLIC OF PRK
KOREA, REPUBLIC OF KOR
KUWAIT KWT
KYRGYZSTAN KGz
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NAME ABBR
LAO PEOPLE'S DEMOCRATIC REPUBLIC LAO
LATVIA LVA
LEBANON LBN
LESOTHO LSO
LIBERIA LBR
LIBYAN ARAB JAMAHIRIYA LBY
LIECHTENSTEIN LIE
LITHUANIA LTU
LUXEMBOURG LUX
MACAU MAC
MACEDONIA, THE FORMER YUGOSLAV REPUBLIC OF MKD
MADAGASCAR MDG
MALAWI MWI
MALAYSIA MYS
MALDIVES MDV
MALI MLI
MALTA MLT
MARSHALL ISLANDS MHL
MARTINIQUE MTQ
MAURITANIA MRT
MAURITIUS MUS
MAYOTTE MYT
MEXICO MEX
MICRONESIA, FEDERATED STATES OF FSM
MOLDOVA, REPUBLIC OF MDA
MONACO MCO
MONGOLIA MNG
MONTSERRAT MSR
MOROCCO MAR
MOZAMBIQUE MOZ
MYANMAR MMR
NAMIBIA NAM
NAURU NRU
NEPAL NPL
NETHERLANDS NLD
NETHERLANDS ANTILLES ANT
NEW CALEDONIA NCL
NEW ZEALAND NZL
NICARAGUA NIC
NIGER NER
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NAME ABBR
NIGERIA NGA
NIUE NIU
NORFOLK ISLAND NFK
NORTHERN MARIANA ISLANDS MNP
NORWAY NOR
OMAN OMN
PAKISTAN PAK
PALAU PLW
PANAMA PAN
PAPUA NEW GUINEA PNG
PARAGUAY PRY
PERU PER
PHILIPPINES PHL
PITCAIRN PCN
POLAND POL
PORTUGAL PRT
PUERTO RICO PRI
QATAR QAT
REUNION REU
ROMANIA ROM
RUSSIAN FEDERATION RUS
RWANDA RWA
SAINT KITTS AND NEVIS KNA
SAINT LUCIA LCA
SAINT VINCENT AND THE GRENADINES VCT
SAMOA WSM
SAN MARINO SMR
SAO TOME AND PRINCIPE STP
SAUDI ARABIA SAU
SENEGAL SEN
SEYCHELLES SYC
SIERRA LEONE SLE
SINGAPORE SGP
SLOVAKIA (Slovak Republic) SVK
SLOVENIA SVN
SOLOMON ISLANDS SLB
SOMALIA SOM
SOUTH AFRICA ZAF
SOUTH GEORGIA AND THE SOUTH SANDWICH

ISLANDS SGS
SPAIN ESP
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NAME ABBR
SRI LANKA LKA
ST. HELENA SHN
ST. PIERRE AND MIQUELON SPM
SUDAN SDN
SURINAME SUR
SVALBARD AND JAN MAYEN ISLANDS SIM
SWAZILAND SWz
SWEDEN SWE
SWITZERLAND CHE
SYRIAN ARAB REPUBLIC SYR
TAIWAN, PROVINCE OF CHINA TWN
TAJIKISTAN TIK
TANZANIA, UNITED REPUBLIC OF TZA
THAILAND THA
TOGO TGO
TOKELAU TKL
TONGA TON
TRINIDAD AND TOBAGO TTO
TUNISIA TUN
TURKEY TUR
TURKMENISTAN TKM
TURKS AND CAICOS ISLANDS TCA
TUVALU TUV
UGANDA UGA
UKRAINE UKR
UNITED ARAB EMIRATES ARE
UNITED KINGDOM GBR
UNITED STATES USA
UNITED STATES MINOR OUTLYING ISLANDS UMl
URUGUAY URY
UZBEKISTAN UZB
VANUATU VUT
VATICAN CITY STATE (HOLY SEE) VAT
VENEZUELA VEN
VIET NAM VNM
VIRGIN ISLANDS (BRITISH) VGB
VIRGIN ISLANDS (U.S.) VIR
WALLIS AND FUTUNA ISLANDS WLF
WESTERN SAHARA ESH
YEMEN YEM
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NAME ABBR
YUGOSLAVIA YUG
ZAIRE ZAR
ZAMBIA ZMB
ZIMBABWE ZWE
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GLOSSARY TERMS

A

Administrator:

The person designated by your company who has the authority to
create and change groups, usernames, passwords and restrictions.

Algorithm:

A sequence of steps used to perform a calculation.

Assigned Driver:

A driver who has been assigned to a vehicle.

Assigned Vehicle:

A vehicle that has been assigned a driver.

Authoring
Environment

The physical machine where RateManager is installed.

C

Calculated Variable:

Calculated Variables are used when a result cannot best be derived
from simple data mapping in a table. For example, if age is not passed
as an input, but is a criteria needed in determining other factors, you
would use a Calculated Variable to calculate driver age from the fields
of effective date and driver date of birth. Calculated Variables look at
every node (driver, vehicle, location, etc.) independently and create a
result for each. Once a calculated variable is created, the result can be
used in any other variable.

Callouts A set of a single or multiple programs and/or SoftLibraries that allows
users to call needed operations at a specific time from either inside the
system or outside the system.

Category: A user defined group of information that defines fields, variables,
algorithms and the overall structure of the program.

Criteria: A field or variable used in a mapped variable to determine which value
to return. Any field or variable can be used as criteria.

D

Data Type: The type of data associated with a parameter. RateManager supports
three (decimal, integer and string) data types for variables and fields
and a fourth (date) for fields and result variables only.

Date: A data type supported for fields and result variables only.

Date Mask: Specifies how SoftRater interprets dates being passed into an input
file.

Decimal: A data type supported for all types of variables and fields. Examples of

decimal values are 3.1415, 18 and 0.995.

Default Value:

Used by a mapped variable if no match is found based on the criteria.

Dependency:

When copying a variable, algorithm or driver assignment, any element
that requires another element to be present or defined will be listed. All
dependencies must be resolved.

Driver Assignment:

Driver assignment is an auto insurance specific method of assigning a
particular driver to a particular vehicle on a policy, based on certain
criteria. Criteria often differ on a carrier basis, and sometimes even on
a program level.

158




Glossary

Driver Assignment A driver assignment scenario is a list of instructions that define the
Scenario: main sequence of operations to properly define the driver assignment
logic for a carrier. A scenario is based upon the same algorithm
principle used throughout the RateManager software.

E

Export: Exports allow users to export all elements of a program from one
database to another database or within the same database. Or to
export data in tab-delimited form, from a RateManager table to an
outside location.

F

Flag: A variable that holds a 1 for true and a O for false.

Flag Driver Algorithm: | An algorithm used by a Flag Driver Function to flag drivers based on
certain criteria.

Flag Driver Function: | A built-in function used in the main driver assignment that defines the
scope of the flagging operation. Most require an association with a
predefined Flag Driver Algorithm.

Flag Vehicle An algorithm used by a Flag Vehicle Function to flag vehicles based on
Algorithm: certain criteria.

Flag Vehicle Function: | A built-in function used in the main driver assignment that defines the
scope of the flagging operation. Most require an association with a
predefined Flag Vehicle Algorithm.

G
Global: A field or variable that is available to all programs under a specific
product.
Group: A set of users that have the same access rights.
I
IBER: Insbridge Enterprise Rating System. This is the entire system.
IBFA Insbridge Framework Administrator. IBFA is an administrative tool

used to configure Insbridge applications and setup RateManager
database connections. IBFA will be located on a Windows Server
machine. IBFA/SR-WIN is an Insbridge Framework
Administrator/SoftRater for Windows.

IBSS Insbridge SoftRater Server. IBSS is the administrative tool for the
SoftRater engine. The SoftRater engine is a multi-platform component
within Insbridge that executes the rules, rating and underwriting
instructions as defined by the user in RateManager. IBSS is usually
located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater
Server/SoftRater for Java.

IBRU The previous acronym used by the Insbridge system. The IBRU
acronym may still be used in some areas of the system.

If: A step type available for use in calculated variables and algorithms.

Import: Import allows users to bring in programs from an outside location into

RateManager. Or to import data in tab-delimited form, into a
RateManager table.

Field: A value that is passed into the rating system.

Integer: A data type supported for all types of variables and fields. Examples of
integer values are 3, 1859865 and -47.
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Interpolation:

An estimated value derived from two known values.

L

Library:

The Library is where templates are stored and managed.

Linked Variables:

Two or more mapped variables that have been associated with one
another because they use the same criteria.

Lock:

A lock will close all associated Variables, Algorithms, Driver
Assignments, Sequencing and Result Mappings in a program version
from deletions and edits.

Logical Environment

An environment created for a subscriber in IBFA. It defines package
location, engine location and database location in addition to several
other supporting data items. This environment is used for rating and/or
SRP management. Each database connection will have a logical
environment.

M

Mask:

A feature that allows the customer to determine how data should be
interpreted.

N

Naming Standards:

A uniform naming structure applied to elements and programs either
system wide or per product.

Normal Rating

The most common type of algorithm. Examples of what it can be used

Algorithm: for are:
e Determine premiums
e Calculate differences in limits being passed into the system vs.
limits being rated by the system
e Assign tiers
@)
Operator: A built-in mathematical function used in calculations and comparisons.
P
Package: A small file that holds all the RateManager logic for a specific program

and version.

Package Location:

A pointer to a location where SoftRater Packages (SRP's) are stored.

Physical
Environment:

A physical environment is generally referred to as a physical machine.

Program:

A planned group of procedures executed in a specific order to return a
rating. Programs in RateManager typically correspond to rate manuals.
Programs can be either created by the users or imported.

Program Date Mask:

Specifies how SoftRater interprets dates being passed in to an input
file.

Program Folders:

A RateManager file management system that functions in much the
same way as Microsoft Windows Explorer. This multi-level setup
allows for an unlimited number of program folders and subfolders to be
placed underneath a product.

R

Rank Driver
Algorithm:

An algorithm used by a Rank Driver Function to rate drivers based on
certain criteria.
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Rank Driver Function:

A built-in function used in the main driver assignment that defines the
scope and sorting order of the ranking operation. Most require an
association with a predefined Rank Driver Algorithm.

Rank Vehicle An algorithm used by a Rank Vehicle Function to rate vehicles based
Algorithm: on certain criteria.

Rank Vehicle A built-in function used in the main driver assignment that defines the
Function: scope and sorting order of the ranking operation. Most require an

association with a predefined Rate Vehicle Algorithm.

Rating Environment

The physical machine(s) where SoftRater is installed. This is typically
the same as a SoftRater node.

Reconcile

A comparison feature that compares one program version against
another version in the same program and generate a report of the
differences.

Restrictions:

Limitations on viewing and editing pages and fields in the system.
Restrictions are assigned and changed by the Administrator.

Result:

A value that is passed out of the system after rating.

Result Mapping:

A defined set of results, fields and variables displayed in the output file.

Revision: A variable specific type of versioning.

RM RateManager. RateManager is a component within Insbridge that
enables users to manage the product definition and modification
process, including rating and underwriting logic.

S

Sequence: The order in which algorithms run.

SoftLibrary:

A SoftLibrary is a specially developed program that performs a specific
task. SoftLibraries may run their own code or call upon other systems
to obtain information outside of RateManager, for example, obtaining a
credit score.

SoftRater Node

A SoftRater node is either an IBFA (without RateManager) or IBSS
instance on a physical environment.

Source: The source is the creator of a template.

SR: SoftRater. The engine that executes the rating, rules and underwriting
instructions defined within RateManager. The rating environment for
runtime execution and processing of business content. SoftRater can
be further defined by the operating system where it has been loaded.

SRP: SoftRater Packages. A package that holds all the RateManager logic
for a specific program and version.

SR-JAVA: SoftRater for Java. This is also another name for IBSS.

SR-WIN: — SoftRater for Windows. This is also another name for IBFA.

String: A data type supported for all types of variables and fields. Examples of
string values are "2.718", "The quick brown fox jumps over the lazy
dog." and "001".

T
Tab-delimited: A type of text file in which columns are separated by tabs. This is the

required format for importing tables into RateManager.

Table Variable:

A variable that uses other variables and fields as criteria in determining
the appropriate value.
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Template: Templates are exact copies of existing programs within a product that
can be from within your own user group, any other user group within
the company or even from an outside company.

U

Unassigned Driver: A driver who has not been assigned to a vehicle.

Unassigned Vehicle: A vehicle that has not been assigned a driver.

Underwriting A type of algorithm used to determine if a policy meets the

Algorithm: requirements of the company.

\%

Variable: A name used to represent a value that can change. See Variables in
the Contents section for more information.

Version: One of a sequence of copies of a program, each incorporating new
modifications.

VFS Virtual File Servers. Virtual file server management allows you to set
up servers that are in different locations where packages can be
downloaded.

W

Wildcard: An option available for mapped variables that tells RateManager that
one or more rows ignore the value passed in for the criteria.

Working Category: A classification used to define how elements should run.

Worksheet: Rating Worksheet / Premium Calculation Worksheet a document

generated for each policy to convey basic information used to establish
individual rates and premiums.

X

XML ID: A number automatically assigned by RateManager to identify fields
and categories.

162




Index

INDEX
A B
Accessing Backup
Manage Products, 77 Deleting, 127
Message Templates, 18 Restoring, 126
Naming Standards, 18 Storing, 125
System Level Constants, 18 Success Message, 125
Activated Backup Share Folder Location
Product Listing Screen, 78 Preferences, 139
Activating Batch Package Threads
Product Listing Screen, 89 Preferences, 139
Active Revision Batch Results with New Line
Exporting a Table, 66 Preferences, 140
Adding Blank
Group, 109 Naming Standards, 22
New Group in User Management, 108 Browser
New User in User Management, 101 Compatibility, x
Admin Rights
Preferences, 137 C
Administrator
User Management, 100 Cancel

Group Management, 108
User Management, 102

Case
Naming Standards, 20, 21, 22

Change Control
Audits, 95
Preferences, 141

Administrator Group, 107
Security Access, 107

Allow Data Type Change
Preferences, 140

Assigning
Group Rights, 114

ASS|_gn|ng Group Rights, 113 Change Password, 136
Audit Logs, 91

Purging, 97 Change Password Window, 136

Viewing, 91 Changing _
Audit Report, 96 Administrator Email, 139

Audits, 92 Character Validation
Creating, 96 Naming Standards, 21
Details, 97 Company
Auditing Selecting for New User, 102
Group Management, 109 Constants, 34
Groups, 109 Functions, 35
Audits Menu Bar, 35
Audit Report, 92 Contact Information
Change Control, 95 Group Management, 118
Polde 92 copy
Filter, 92 Narmng Standards, 19, 24
Filtering, 94 Copying Text, 16
Purge All, 92, 98 Create
Refresh, 78, 92 Message Templates, 44
Right Click Menu, 92 User-define System Level Constant, 36
Authoring Environment Definition, 158 Create Backup, 125

DB Backups, 124
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Create Date
Table Job Listing, 57

Creating
Audit Report, 96
Backups of Database, 123
Database Snapshot, 124

Creating a Job
Table Job Management, 60

Current Category Instance #, 33
Current System Date and Time, 33

Custom
Filter, 94
Naming Standards, 20

Custom Products
Creating, 79

Custom Type
Product Listing Screen, 78

Cutting Text, 16

D

Data Type
Message Templates, 44
User-define System Level Constant, 36

Database
Tools, 124

DataBase
Tools, 123

Database Error Messages, 128

Database Snapshot
Creating, 124

Database Tab, 123

Database Updates, 130
Running, 131
Tools, 133
Viewing, 131

Date Formats, 80

Date Last Modified
Message Templates, 43
Naming Standards, 20
Naming Standards, 21
User-define System Level Constant, 36

DB Backups
Create Backup, 124
Delete Backup, 124
Fields, 124
Menu Bar, 123
Refresh, 124
Restore Backup, 124

DB Updates
Execute Update Script, 131
Fields, 131
Menu Bar, 130
Open Update Script, 131
Refresh, 131
Save Update Script to File, 131
Show Updates for, 131

Deactivate License

Session Mangement, 119

Deactivating

License, 120
Product Listing Screen, 89

Deactivating User Session

Session Management, 121

Debug Report Format

Preferences, 141

Decimal Symbol, 81
Default

Groups, 107
Locale, 79

Default Naming Standard

Preferences, 141

Default Proxy Script Location

Preferences, 141

Delete

Group Management, 108

Message Templates, 43, 47

Naming Standards, 19, 26

Table Job, 56

User Management, 101

User-define System Level Constant, 35, 39

Delete Audit, 93
Delete Backup, 127

DB Backups, 124

Deleting

Audits, 98

Database Backup, 127

Errors for a Group Delete, 116
Group, 116

Products, 79

User in User Management, 106

Deleting a Job

Table Job Management, 64

Description

Message Templates, 43

Naming Standards, 20, 21

Product Listing Screen, 78

User-define System Level Constant, 36

Details

Audit Report, 97

Digit Grouping Symbol, 81
Disabled

Naming Standards, 21

Domain Constants, 33
Downloading

E

Exported Tables, 72

Edit

Group Management, 108
Message Templates, 43, 45
Naming Standards, 19, 24
Product Listing Screen, 78
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User Management, 101

User-define System Level Constant, 35, 37
Edit Content

Table Job, 56

Edit Group Screen, 115

Edit Job Options
Table Job, 56
Edit User
User Management, 104
Editing
Group, 115
Product Listing Screen, 85
System Settings, 137
User in User Management, 104
Editing a Downloaded File
Exported Tables, 74
Editing a Job
Table Job Management, 61
Editing Group Rights
Example, 114
Editing Job Content
Table Job Management, 62

Edition Notice, 2

Email
Changing Administrator, 139

Enable Worksheets for Test Case Editor
Preferences, 141

Enabled
Naming Standards, 21

Enforce
Naming Standards, 21
Naming Standards, 20

Enforce Product Configuration
Preferences, 142

Enforce Release Packaging
Preferences, 139

Error Messages
Database Backup, 128

Errors
Creating Backups, 125
Deleting a Group, 116

Example

Editing Group Rights, 114
Excel Files

Exported Tables, 74
Excluding

Job Content, 62
Execute Update Script, 132

DB Updates, 131
Executing Status

Table Job Listing, 57
Export

Type, 57

Exported Tables, 70
Downloading, 72

Editing a Downloaded File, 74

Excel Files, 74

File Not Found, 72

File Status, 71

Files, 71

Files on Server, 73

Re-importing, 76
Exporting a Table, 65

Library, 70

Overwriting a File, 69

Run, 67

Save, 67

Save and Run, 67

Saved Files, 70

Workbook Name, 66

Worksheet Name, 66

F

Failed Job
Table Job Management, 64

Failed Status
Table Job Listing, 58

False
New Users, 103

Fields
Audits, 92
DB Backups, 124
DB Updates, 131
Group Management, 108
Session Management, 120
User Management, 101

File Not Found

Exported Tables, 72
File Status

Exported Tables, 71
Files

Exported Tables, 71
Files on Server

Exported Tables, 73
Filter

Audits, 92
Filtering

Audits, 94
Find

Message Templates, 43

Naming Standards, 20

User-define System Level Constant, 35
Fixed Constant, 33
Framework Administrator

Administrator Email, 139
Full Access, 13

Group Rights, 114

Functions
Constants, 35
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G Table Job Management, 53
IBSS Definition, 159

ID
Product Listing Screen, 78

Impact Analysis Messaging Server
Preferences, 138

Global
Navigating to Constants, 34
Navigating to Message Templates, 42

Global Versions Report Thread

Preferences, 142

Group
Administrator, 107
Default, 107
Full Access Rights, 114
Name when Adding, 109
Removing User, 103

Rights Assigned to Users, 107

Security, 100

Selecting for New User, 102

Settings for Audit Logs, 109

Group Management
Adding a Group, 109
Auditing, 109
Cancel, 108
Delete, 108
Deleting a Group, 116
Edit, 108
Editing a Group, 115
Fields, 108
Group Rights, 111
Information, 108
Menu Bar, 107
New, 108
Overview, 107
Permissions, 114
Refresh, 108
Required, 108
Rights, 108
Save, 108

Group Rights, 111
Write Access, 113

Groups
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